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Chapter 1: Administering Enterprise 
HelpDesk

Creating Projects and 
Generating Web Views
An Enterprise HelpDesk project includes:

• A database of issues (and their revision 
histories). 

• A database of definitions, which includes the 
queries, sorts, layouts, reports, notifications, 
fields, and tabs available in the project. 

Each project can have multiple Web-based views.

Each Web view is customized to meet the specific 
needs of a class of users. For example, employees 
don't need to see all the issues in the project 
database, just the issues they submitted. And they 
don't need to see notes and comments entered by 
help desk staff. The help desk staff, on the other 
hand, needs access to all the issue information in 
the project database. 

With Enterprise HelpDesk, you can provide 
separate views for employees and for help desk 
staff. Each view is accessed through the same 
Web-based interface. 

Views are easy to define using the Web view 
Editor. Just choose the queries and fields that you 
want to expose in the view. 

• Queries determine which issues users can 
retrieve from the project database. 

• Fields determine what information users can 
view and modify for each issue. 

To create projects and edit definitions (of fields, 
queries, reports, sorts, layouts, and notifications), 
you use HelpDesk Admin, a Windows program. 

HelpDesk Web Admin is a Web-based tool that 
allows you to remotely edit some of the project 
definitions (such as tabs and choice lists).

Administering Projects and Web Views

Managing Users, 
Contacts, and Groups
Users All Enterprise HelpDesk users must have 
an Enterprise HelpDesk user account, which 
consists of a user name and an optional password. 
You use HelpDesk Web Admin to create and 
manage Enterprise HelpDesk user accounts.

Groups By assigning users to groups, you can 
control:

• Access to features in HelpDesk Admin, 
HelpDesk Web Admin, and Web views.

• Access to projects. 

• Access to Web views.

• Workflow permissions.
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You use HelpDesk Web Admin to create groups, 
edit group privileges, and assign users to groups.

Contacts A contact is a person who is not an 
Enterprise HelpDesk user, but who reports an 
issue. For example, a guest from another 
company may report an issue with a computer 
while they are working on-site. In this case, the 
guest is the contact, and the help desk analyst who 
actually enters the report is the submitter. 

To create and manage a list of contacts, you use 
HelpDesk Web Admin. Web views can also 
include a Contact button that opens the Users and 
Contacts dialog box. Access to this dialog box 
from a Web view is controlled by group 
permissions, which are defined in HelpDesk Web 
Admin.

Tools for Enterprise 
HelpDesk Administrators
Enterprise HelpDesk provides a set of tools for 
administering projects and Web views:

• HelpDesk Admin for administering projects.

• Web View Editor for defining and generating 
Web views for projects.

• HelpDesk Web Admin for administering 
projects and users through the Web. 

HelpDesk Admin
HelpDesk Admin is a Microsoft Windows 
application for administering Enterprise HelpDesk 
projects. For example, you use HelpDesk Admin 
to:

• Create projects.

• Customize fields.

• Define queries, sorts, and layouts.

• Define reports.

• Define and set up e-mail notifications.

To start HelpDesk Admin:

• On the Start menu, point to Programs and then 
click PC-Duo Enterprise. Point to HelpDesk and 
then click HelpDesk Admin.

Web View Editor
Web View Editor is a Microsoft Windows 
application that you use to create Web views for 
your Enterprise HelpDesk projects. Web views are 
Web-based applications that provide access to 
Enterprise HelpDesk projects through a Web 
browser.

HelpDesk Admin and Web View Editor are installed 
on the Web server. For convenience, you can 
install additional copies of these tools on other 
computers. For example, you can install copies of 
HelpDesk Admin and the Web View Editor on your 
own workstation, so you can perform many 
administration tasks from your desk.

Note, however, that you cannot create new Web 
views from your desk; to create new Web views, 
you have to use the Web View Editor on the Web 
server.

To start the Web View Editor from HelpDesk 
Admin:

• On the Tools menu, click Web and then click 
Web View Editor.

The Tools > Web > Web View Editor command 
is available only if Web View Editor is installed 
on the same computer where you are running 
HelpDesk Admin.



3

To start the Web View Editor from the Start 
menu:

• On the Start menu, point to Programs and then 
click PC-Duo Enterprise. Point to HelpDesk and 
then click Web View Editor.

HelpDesk Web Admin
HelpDesk Web Admin is a Web-based 
administration tool. It allows you to perform 
additional administrative tasks over the Web:

• Manager users and user groups, and define 
group privileges (access to features and 
projects).

• Add and edit contacts.

• Define workflow rules.

• Create new tabs.

• Set up choice fields.

• Enable e-mail notifications.

• Migrate projects to SQL Server and move 
projects to different SQL Server computers.

• Move attachments to a different computer.

To log on to HelpDesk Web Admin

Do one of the following:

• In your Web browser, go to 
//server/helpdeskadmin, where server is the 
name of your Web server.

• In HelpDesk Admin, click Tools > Web > Web 
Admin.

• If you are sitting at the Web server, click Start > 
Programs > PC-Duo Enterprise > HelpDesk > 
HelpDesk Web Admin.

Troubleshooting HelpDesk 
Web Admin
If users cannot successfully relocate databases or 
perform other tasks with HelpDesk Web Admin, 
check if there is a global group named 
YOURDOMAIN\CensusAdminsGroup, and that 
the user (especially if the user is a domain user, 
not a domain administrator) is a member of this 
group.

When you log on to HelpDesk Web Admin, 
HelpDesk Web Admin uses your Windows 
credentials to run tasks if you are a member of the 
CensusAdminsGroup group or the local 
Administrators group on the HelpDesk Server 
computer. Otherwise, HelpDesk Web Admin runs 
tasks as CensusUser.

Members of the CensusAdminsGroup group (or of 
the local Administrators group on the HelpDesk 
Server computer) have the required permissions 
to perform any task with HelpDesk Web Admin. 
The CensusUser account, on the other hand, 
cannot perform IIS-related tasks such as 
unloading virtual directories (when logging off 
users), and may not be able to relocate databases 
to other computers.

During installation, the Setup program creates the 
CensusAdminsGroup group and adds all 
members of the domain Administrators group to 
the CensusAdminsGroup group. Setup also adds 
the CensusAdminsGroup to the local 
Administrators group on the HelpDesk Server 
computer. The purpose of the 
CensusAdminsGroup is to control access to Web 
Admin.

If Setup was unable to create the 
CensusAdminsGroup, you can create it manually.
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For example, if you want to allow a domain user 
that is not a domain administrator (because 
domain administrators already belong to the local 
Admins group by default) to use the Relocation 
tab, you can create the CensusAdminsGroup and 
add the domain user to the group. This will allow 
the domain user to perform tasks that are typically 
only available to local admins:

• Managing SQL Server databases and physical 
files.

• Logging off Enterprise HelpDesk users (which 
requires permissions to control IIS).

To manually create the CensusAdminsGroup 
after Enterprise HelpDesk 5.0 is installed:

1 Create a global group named in 
“CensusAdminsGroup“ the domain.

2 Add CensusAdminsGroup as a member of the 
local Administrators group of the Web server.

3 On the Start menu, click All Programs > 
PC-Duo Enterprise > HelpDesk > HelpDesk 
Tools > Set Up Global Group.
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Chapter 2: Planning and Deploying a Help 
Desk System

Planning
To set up a help desk system that reflects your 
help desk structure and process, you need a good 
understanding of that structure and process. 

Information Recording and Tracking
• What information do you want to record and 

track for each issue?

• How do you categorize issues?

• Do you want to provide different views of the 
issue data? 

For example, do you want a summary view 
optimized for logging issues and categorizing 
problems, and a detailed view for recording 
things such as how the issue was resolved, and 
how long it took?

• Do you want to be able to link issues? 
Enterprise HelpDesk supports parent-child 
relationships between issues. 

Workflow
• What is your help desk process?

Can you represent the path of an issue through 
the process as a sequence of steps, or 
decisions, such as New, Assigned, Verified, 
Resolved?

• Do you want to enforce this “workflow” 
process?

• Who should have permission to make each 
decision? Who will be responsible for carrying 
out each step in the process?

• Do you need e-mail notifications to enforce 
ownership and accountability? When issues are 
submitted or resolved, who needs to be 
alerted?

Roles and Responsibilities

• What are the different roles and responsibilities 
of your help desk staff? Can you divide users 
into groups (such as help desk analysts and 
group leaders)?

• Do different groups have different requirements 
of the issue tracking system? Do you need to 
restrict access to the system based on group 
membership?

For example, you probably want to give 
employees only limited access to the system so 
they can submit new issues and track the status 
of submitted issues. Help desk staff, on the 
other hand, will require greater access to the 
system. 

• Do need to manage and coordinate work 
teams? Enterprise HelpDesk allows you to 
define work teams and the assign issues based 
on work teams.
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Implementation Roadmap
This roadmap outlines the major steps in 
implementing an issue tracking system. 
Performing the steps in the sequence 
recommended here will save you time and simplify 
the process.

Step 1. Create a project

A project defines the fields, queries, sorts, layouts, 
and reports that you see in a Web view.

1 Create a new project.

2 Customize the fields in the project.

3 Edit and define the queries, reports, sorts, and 
layouts to match the set of fields defined in the 
project.

Step 2. Define user groups and create user 
accounts

1 Define user groups and set group permissions 
to control access to data and administrative 
features.

2 Create user accounts so people can log on. 
You can either import user accounts from Active 
Directory (or from a Windows domain), or 
create user accounts in Enterprise HelpDesk.

3 Assign users to groups.

4 Define work teams and assign users to work 
teams.

Step 3. Define and generate Web views

After you generate and test your Web views, you 
can perform more advanced customizations, such 
as defining workflow and notifications.

Step 4. Define field dependencies (optional)

Use the workflow editor in HelpDesk Web Admin 
to make the possible values in one choice list 
depend on the choice selected from another list.

You can apply changes made in the workflow 
editor without regenerating the Web view.

Step 5. Define a workflow (optional)

Use the workflow editor in HelpDesk Web Admin 
to define workflow rules to emulate your process. 
For example, you can enforce a sequence of steps 
by controlling the possible values of the Progress 
field.

You can also define rules that set the value of a 
field when another field changes. For example, 
you can define rules that assign an owner based 
on the problem area:

When (Problem Area = Outlook), then set this 
value: (Owner = Resident Outlook Wiz).

Step 6. Define Service Level Agreements

A service agreement is an agreement between the 
help desk and users. The service agreement 
defines a required level of service for the users.

A service agreements can be with individual users 
(contacts), with all users in a department, or all 
users in a company.

A service level is a guarantee of a certain level of 
service. For example, a basic service level may 
provide 9-to-5 service during the regular working 
week, while a more comprehensive service level 
might provide 24 hour service, 7 days a week.

Each service level has its own hours of service, 
target response and closure times for issues, and 
escalation rules.
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Step 7. Import existing data (optional)

After you finalize the set of fields in a project, you 
can import trouble tickets and call data from 
existing databases.

Step 8. Define and set up notifications

You can define and set up notifications after you 
generate your Web views, but you should do this 
before people start using the Web views to submit 
issues.

Step 9. Go live

Make your Web views available to help desk staff 
and employees.

Step 10. System maintenance (ongoing)

You should regularly backup your projects, 
databases, Web views, and other system files.

You should also run the Repair and Compact utility 
(Tools menu, HelpDesk Admin) on a regular basis. 
Compacting Microsoft Access databases and files 
often is the best preventive maintenance.

Creating a New Project

About Projects
A project defines everything that you see in a Web 
view: the fields, queries, reports, sorts, and 
layouts. 

Do not edit the default HelpDesk project shipped 
with Enterprise HelpDesk. Instead, create a new 
project based on HelpDesk, and use this new 
project as your starting point.

Only members of the Admins group should be 
allowed to open projects in HelpDesk Admin.

How Many Projects Do You Need?
Each Enterprise HelpDesk project has its own 
issue database. Projects can share the definitions 
of things like reports and queries, but the issues 
recorded in each project database are completely 
separate.

For example, if you want to record software, 
hardware, and support issues in separate 
databases, you can create three separate projects. 
Separate projects mean smaller databases and 
better performance. It also means you can 
customize fields, queries, sorts, layouts, and 
reports on a project-by-project basis. For example, 
you don’t need a field to specify the issue type 
(software, hardware, or support), and you don’t 
need separate queries for each issue type.

However, tracking issues in separate projects has 
some disadvantages:

• You cannot generate reports across all projects.

• You cannot create a single view that covers all 
projects.

• If a help desk analyst works on all three types of 
issues, separate projects may be inefficient and 
time-consuming.

Choosing a Base Project
A base project serves as a starting point for a new 
project. The new project inherits the fields defined 
in the base project, and can optionally inherit the 
styles (queries, reports, sorts, layouts, and 
notifications) and Web views as well.
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Enterprise HelpDesk includes a default HelpDesk 
project you can use as the base project. Before 
you create a new project based on HelpDesk, you 
should familiarize yourself with the fields included 
in HelpDesk, and understand what you can and 
cannot do when customizing fields.

Designed for use in development projects, 
HelpDesk allows you to record and track project-
related tasks, feature and enhancement requests, 
user suggestions, and change notices.

HelpDesk includes over 60 fields, along with a 
complete set of reports, queries, sorts, layouts, 
and notifications based on those fields. A number 
of the default fields cannot be deleted. So even if 
you don’t use these fields, they will take up extra 
space in your database. 

When you do delete a field, you must first remove 
it from any report, query, sort, layout, or notification 
that references the field. Deleting unused fields 
helps minimize the size of your database.

Customizing Fields

About Customizing Fields

In general, if an existing field does not meet your 
requirements, you can either delete it or edit it.

For example, if a field is the right data type and 
size, but has the wrong caption, you can change 
the caption. In the case of choice lists, you can 
replace the table of choices completely.

Before you start customizing the fields, you should 
familiarize yourself with the fields in the base 
project, and determine:

• Which of the existing fields can you can reuse 
as is? Or reuse by changing the label, choice 
table, or tab?

• What new fields do you need to add?

• Which of the existing fields do you want to 
delete?

You should also familiarize yourself with what you 
can and cannot do when editing fields.

What You Can Do
You can:

• Add new fields.

• Change field labels.

• Change the list of choices for a choice list.

However, you must update the queries that test 
the choice values.

If you change the Progress choice list, you 
should either disable or update the default 
workflow rules. The default workflow is based 
on the Progress choice list. 

• Delete most fields.

To delete a field, you must first remove it from 
any queries, sorts, layouts, reports, and notifi-
cation that use the field. 

Before you try to delete a field, go through the 
different queries, sorts, layouts, reports, and 
notification conditions and either remove the 
field or delete the style.

• Create choice lists where the contents of one 
list depends on the choice selected from the 
other list.
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For example, Problem Type could be one of 
Software, Hardware, and System. Problem 
Area could then be a type-specific list that 
displays either a list of software applications, 
hardware components, or system components.

• Move fields between tabs.

• Change tab names, and reorder the tabs.

• Disable fields (make read-only) either for all 
users or for specific user groups.

• Hide fields. Note that when you hide a field, it is 
hidden in all Web views.

What You Cannot Do
You cannot:

• Change field types.

For example, you cannot change a single 
choice field into a multi-choice field, or a 
Number field into a Text field.

• Change the field size.

For example, you cannot change the size of a 
text box from 20 to 30.

• Delete certain fields. Some fields, such as 
Owner, State, and Progress, cannot be deleted.

When you generate a Web view, you can 
choose not to include specific fields. So even if 
you cannot delete them, you can remove them 
from all views. Of course, the fields will still take 
up space in your database.

• Use multi-choice lists in workflow rules.

• Use multi-choice lists in formulas, charts, or 
cross-tabs when building custom reports with 
Crystal Reports.

If you need to change the type or the size of a field, 
the best thing to do is to copy the field and delete 
the original. When you copy a field, you can edit its 
type and size. Note that copying a field does not 
copy the stored data, and deleting a field destroys 
any stored data.

What Happens to Styles
Styles such as queries and reports are based on 
fields. For the most part, HelpDesk Admin 
automatically updates styles when you customize 
the fields, but there are some exceptions.

When you add a new field You need to add the 
new field to the following reports:

• Current Issue - Detailed

Used to print the current issue in a Web view.

• Notification - Detailed Record, 
Notification - Summary

Used to format the contents or attachments to 
e-mail notification messages.

In a Web view, these reports show only the fields 
exported to the view.

When you rename a field When you change the 
label appearing on choice lists, HelpDesk Admin 
automatically updates any reports and layouts that 
use the field name as a title.

If you change just the Field Caption label, 
HelpDesk Admin does not update any reports and 
layouts that use the field name as a title.

If you rename a field such as the Progress field, 
you may want to rename any sorts, queries, and 
layouts whose names are based on the name of 
the field.
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When you edit a choice list If you delete a 
choice from a choice table (for example, Assigned 
from tblSubstate, the Progress choice table), then 
you have to update any queries that test the 
choice value. The same is true if you change the 
choice text (for example, from “Assigned” to 
“Started“).

You may also have to update custom reports that 
use the choice list. For example, when you change 
the choice text, custom reports that use a specified 
sort order will lump the new choice into the Others 
category.

You should also check the workflow rules if you 
edit the Progress choice list.

When you delete a field Custom reports that 
use the deleted field will not display properly. For 
example, if a custom report uses the field for 
calculations, or as a chart axis, then deleting the 
field invalidates the report. In many cases the 
report will still work, but the data it displays won’t 
make sense.

Creating Groups and 
Granting Permissions

Overview

If you want to restrict access to Web views or to 
administrative features, you use groups. Typically, 
you create groups that match the different roles in 
your help desk process. For example, if you have 
separate groups for employees and for help desk 
staff, you can prevent employees from opening the 
same Web views used by the help desk staff. 

Enterprise HelpDesk includes several built-in 
groups that cannot be deleted: Users, Admins, and 
Guests. It also includes several sample groups 
that reflect basic help desk roles: Employees, 
HelpDesk-Analysts, and HelpDesk-GroupLeads.

If a help desk analyst is responsible for 
administering the Enterprise HelpDesk system, 
you can make the analyst a member of both 
HelpDesk-Analysts and Admins. As a member of 
Admins, the analyst has full access to all 
administrative features. 

You could have several different admin-type 
groups, with each group providing a different level 
of access to administrative capabilities. For 
example, you might want a basic-level admin 
group that allows members to create new user 
accounts and update contact information. Other 
admin groups could provide the ability to:

• Create fields, edit choice lists, rename tabs, 
change workflow.

• Create reports, queries, sorts, and layouts, 
define notifications.

• Create projects, delete records, perform 
database maintenance, set up notifications.

About the Built-in Groups
Users By default, all users are members of the 
Users group. You cannot remove users from the 
Users group, or delete the Users group.

You use the Users group to set permissions that 
you want to apply to all users.

Permissions granted to the Users group are 
inherited by all users, and cannot be overridden. 
For example, if a feature is enabled for the Users 
group and disabled for Employees group, then 
members of the Employees group can still use the 
feature.
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The reverse is not true, however. If a feature (or 
project or view) is disabled for the Users group, 
members of other groups can still access the 
feature (or project or view)—if you enable the 
feature (or project or view) for the other groups.

Admins Members of the Admin group have 
complete access to all projects and administrative 
features. You cannot disable features or projects 
for the Admins group.

Guests Intended for users who are not full-time 
employees, such as customers or visitors from 
other companies.

Features
Features allow you to control:

• Who can use the Ad-hoc Query Editor, 
generate reports, update contact information, 
view revision histories, or change their 
password in a Web view.

• Who can log on to HelpDesk Admin, HelpDesk 
Web Admin, and the Web View Editor.

• Who can use certain tools in HelpDesk Admin 
and HelpDesk Web Admin. For example, who 
can edit workflow rules in HelpDesk Web 
Admin, and who can create reports or edit fields 
in HelpDesk Admin.

Projects
When you create a project, you specify which 
groups can open the project. Groups allowed to 
open a project can:

• Log on to Web views of the project (if they also 
have permission to open the view).

• Edit the project in HelpDesk Admin.

• Edit views of that project in Web View Editor, or 
generate new views of that project.

Admins can always open a project. Instead of 
allowing Users to open a project, you should allow 
specific groups. That way you can grant access 
permissions to views on a group-by-group basis in 
the Web View Editor.

Views

Groups allowed to open a view can log on to the 
view. A group must be allowed to open the project 
before it can be allowed to open a view.

Remember that if members of the Users group are 
allowed to open the view, then any user can open 
the view.

Creating User Accounts

About User Accounts

User accounts provide basic logon security. Users 
can log on to Enterprise HelpDesk with the 
following logon accounts:

• Enterprise HelpDesk user accounts, which exist 
only in Enterprise HelpDesk.

• Active Directory user acounts.

• Windows user accounts (for Windows NT 
users, such as in Windows NT 4.0 and 
Windows 2000 without Active Directory).
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The authentication method used by Enterprise 
HelpDesk for each user is specified in HelpDesk 
Web Admin.

You need to create a user account for each person 
who needs to log on to a Web view or to one of the 
administrative tools: HelpDesk Admin, HelpDesk 
Web Admin, and the Web View Editor.

You don’t necessarily have to create user accounts 
for every employee in your company. If you 
provide a submit-only Web view for employees to 
use when submitting issues, employees don’t 
need their own user account.

Importing User Accounts from Windows

You can import user accounts from an Active 
Directory domain or from a Windows NT domain. 
Enterprise HelpDesk includes a User Account 
Manager wizard to help you import user accounts.

You can also schedule imports to keep Enterprise 
HelpDesk synchronized with Active Directory (or 
Windows domains).

Submit-only Views

A submit-only view allows an unlimited number of 
users to submit issues. All you need is a single 
user account. All users will automatically log on to 
the view with this account (in fact, the users never 
see the logon window, they go straight to the 
view).

This user account must belong to a group that has 
permission to open the Web view, and to add and 
update contacts. The account will be used to set 
the Submitter field.

The user submitting the issue is considered the 
contact, and must enter their contact information 
(name, e-mail, and so on) the first time they submit 
an issue. 

Predefined User Accounts
Enterprise HelpDesk includes several built-in 
users: demo, guest, and admin. It also includes 
several sample users that reflect basic help desk 
roles: employee, analyst, and group leader.

You can disable most of these accounts in 
HelpDesk Web Admin. The admin account cannot 
be disabled, so you should change the admin 
password.

Disabled user accounts are still listed in the 
Contact, Owner, and Submitter lists. Deleting the 
users from the database (or removing them from 
the choice lists) requires editing the project 
database files.

Generating Web Views

Parent-child relationships between 
issues?
You can add a Child Issues tab to a Web view to 
allow users to link one or more child issues to a 
parent issue. For example:

• If you have several bugs that are all symptoms 
of the same problem, you can make those bugs 
the children of the main, parent bug for the 
problem.

• If a task consists of a number of sub-tasks, the 
sub-task issues can be children of the main 
task. 
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• If a bug is present in multiple branches of your 
code, then you could create a child issue for 
each code branch, 

By default, the parent issue controls the substate 
of the child issues. For example, when a user 
changes the substate of the parent to Fixed, all the 
children are also marked Fixed. If you want the 
substate of a child issue to be independent from 
the substate of the parent issue, you need to 
export the Substate controlled by parent field. 

Customized files from the base project?
New projects automatically inherit the customized 
Web view files of the base project. For example, all 
projects based on the HelpDesk project inherit the 
HelpDesk custom reports.

When you create a new project, Enterprise 
HelpDesk copies everything in:

CUSTOMIZEDFILES\#Project#<base-project>\
to

CUSTOMIZEDFILES\#Project#<your-project>\

What if you don’t export a field?
Queries If you don’t export a field, then don’t 
export queries that reference the field. The query 
won’t work.

For example, suppose you don’t export the Owner 
field, but you do export a query like My Open 
Issues, which tests the value of the Owner field. 
When a user tries to run the query, the user gets a 
message saying that the query could not be 
completed and the view is rolling back to the 
previous query.

If the query is the default query for the view, users 
will get a more informative message when they log 
on.

Layouts Layouts do not include fields that are not 
exported.

Sorts Sorts default to sorting by issue number if a 
field is missing.

Listing Reports Listing reports (such as the 
Current Issue - Detailed report, which is used by 
the Print button) include only the fields exported to 
the view.

Custom Reports Like listing reports, custom 
reports include only the fields exported to the view. 
However, unlike listing reports, custom reports 
cannot always handle missing fields properly.

For example, if the Owner field is not exported, 
then instead of showing owner names along one 
axis of a chart, the report may show the summary 
descriptions or the priority values. What the report 
shows depends on the order of the fields in the 
report definition (if a field is missing, the next one 
in the definition is used).

Should you automatically update choice 
lists?
If you expect to frequently update a choice list, you 
may want to set the Automatically Update List 
attribute to Yes. 

This means you won’t have to regenerate the Web 
view every time you update the list. The view will 
check for updates each time a user logs on.

By default, only the Contact, Owner, and Submitter 
choice lists are automatically updated.

Automatically updating a large number of choice 
lists may affect performance. You should 
automatically update only the choice lists that you 
plan to frequently change. 
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Do you want to change a field caption?
You can change field labels by setting the Caption 
attribute in the Web View Editor. This allows you to 
override the label specified in the project. For 
example, if the original labels assumed the users 
were help desk staff, you may want to change the 
labels in a view intended for employees.

The Caption attribute changes only the label 
displayed beside the field in the HTML form. 
Everywhere else in the Web view (such as in 
reports and the Ad-hoc Query Editor), the label 
defined in the project is used.

When do you have to regenerate?
When you:

• Add a new field or query to a project. 
Remember to move the new field or query to 
the Export to View list before you generate.

• Change a choice list (for example, add a new 
choice, or change the text of a choice), unless 
Automatically Update List is set to Yes.

• When you change any of the attributes for a 
field (such as when you set Automatically 
Update List to Yes).

You don’t have to regenerate when you:

• Change the definition of a query, sort, or layout.

• Define new sorts and layouts. All sorts and 
layouts are automatically exported to views of 
the project.

• Create or edit reports.

• Add a group to, or remove from, the list of 
groups allowed to open the view. You just have 
to save the view.

• Enable or disable features.

Web view users must exit and log back on to see 
the changes.

How to control the layout of fields?
The order of the fields in the Export to View list 
determines the order in which they are laid out in 
the two columns of the HTML form. For example, 
here’s how the first six fields in the Export to View 
list would be arranged, if:

• None of the first five fields are Memo fields.

• Field 3 has Column Span = 2.

• Field 6 is a Memo field and has Column Span = 
2 and CSS Class = MemoFieldWidth. (Memo 
fields automatically have Column Span set to 2 
and CSS Class = MemoFieldWidth.)

Setting Up Notifications
Notifications allow you to alert help desk staff and 
employees when issues are updated. For 
example, you can:

• Notify analysts when issues are assigned to 
them.

• Notify analysts when employees update an 
issue.

• Notify employees when issues are resolved.

1 2

54

3

6
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You should try to keep the number of notifications 
to a minimum. Defining too many notifications for 
field updates can overwhelm users with e-mail, 
resulting in users missing important notifications. 
Use notifications for changes to critical fields like 
Owner, Progress, and Priority. 
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Chapter 3: Projects

What is a Project?
In Enterprise HelpDesk, projects are used to keep 
issues in separate databases. How you organize 
your projects is up to you. You can have one 
project for tracking all issues, or you can have 
several projects. To create and manage projects, 
use HelpDesk Admin.

A project includes:

• A database of issues and their revision 
histories.

• A set of project-specific definitions, which 
include styles (queries, sorts, layouts, reports, 
and report pages), the fields, and notification 
definitions. These definitions are shared by all 
users of a project. 

Project Structure

Creating New Projects
Typically, you start a new project because you 
want to start tracking issues in a new database. 
However, there are other reasons for creating a 
new project. For example, you may want to:

• Share the definitions of styles, notifications, and 
fields with another project. 

• Stop sharing definitions so you can add project-
specific changes. For example, you may need 
to change the fields for one project but not for 
the others. 

• Build a template project and use it as a base for 
all other projects. 

• Break a large project into several smaller 
projects. 

New projects are always based on an existing 
project. When you create a new project, you can 
copy the issues, styles, notifications, and the fields 
from the base project. You can also share the 
styles, notifications, and fields between projects.

To create a new project:

1 Start HelpDesk Admin

2 On the File menu, click New Project.

3 In the Project Name box, type the name of the 
new project.

4 In the Base Project list, click the project you 
want to use as a template for the new project.

5 In the Groups Allowed to Open Project, click the 
user groups that will be allowed to access the 
project, either through HelpDesk Admin, 
HelpDesk Web Admin, the Web View Editor, or 
Web views.

Note that access to individual Enterprise 
HelpDesk components can be selectively 
disabled. For example, a group can have 
access to Web views of a project, but be denied 
access to HelpDesk Admin, HelpDesk Web 
Admin, and the Web View Editor.

6 Under Global Styles and Notifications:
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• Click None to create a project with no 
queries, sorts, layouts, reports, or 
notifications. Only the fields will be copied 
from the base project.

• Click Copy from the Base Project to copy the 
definitions of fields, queries, sorts, layouts, 
reports, and notifications to the new project.

• Click Share with Base Project to share a 
single set of fields, queries, sorts, layouts, 
reports, and notifications.

7 If you want to copy the issues from the base 
project, click the Copy issues and revision 
history from base project check box.

8 If you don’t want to copy the Web views from 
the base project, clear the Copy Web views 
from the base project check box.

Copying Web views from the base project can 
save you time. For example, copying the Web 
views from HelpDesk means you don't have to 
manually set up timestamping in a new Web 
view.

Creating your first project? Use one of the 
sample projects that come with Enterprise 
HelpDesk as the base project. Copy the styles and 
notifications, but do not copy the issues and 
revision history. Also, you should read “Building a 
Project Template” on page 19 before you start 
tracking issues. 

Copying and Sharing 
Definitions
A new project is always based on an existing 
project. The new project can either share or take a 
copy of the styles, notifications, and fields in the 

base project. In the New Project dialog box, select 
the option that corresponds to what you want to do 
with the new project:

None Clear the styles and notifications so you can 
build your own. Copy the fields from the base 
project and use it as a starting point.

Copy from the Base Project Copy the styles, 
notifications, and fields from the base project and 
use them as a starting point, or template, for the 
new project. 

Share with Base Project Share styles, 
notifications, and fields with the base project. 

Why copy styles and notifications? Copying 
styles and notifications allows you to make 
changes on a project-by-project basis. For 
example, you may need to add project-specific 
fields. In turn, the new fields may require changes 
to the styles (for example, you may need to include 
new fields in queries and reports).

Why share styles and notifications? Sharing 
styles and notifications provides consistency 
across projects and simplifies the distribution of 
new styles and notifications. For example, when 
you define a new report, it is immediately available 
in all projects that share the same styles.

Shared Project Definitions

Sharing styles and notifications sometimes 
requires that you create extra styles. For example, 
suppose you want to print the product name in 
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report titles. To do this, you need a copy of your 
standard report page for each product. Then for 
each report that uses that report page, you need to 
provide a product-specific report definition.

Building a Project 
Template
Before you start using Enterprise HelpDesk to 
track issues, you should build a project template. A 
project template is a project that you use as the 
base for all new projects. The project template 
contains styles and definitions common to all 
projects.

For example, a project template can define a 
standard set of queries, reports, and notifications. 
In addition, a project template can include a set of 
fields customized to match your company's 
process and terminology.

Using a project template allows you to reuse 
custom styles, notifications, and fields. Each new 
project can copy (or share) the styles and 
definitions from the project template.

Before you build a project template, you must first 
evaluate your issue tracking and reporting 
requirements. For example, you should decide:

• What custom fields and choice lists are 
required.

• What standard queries and reports you want in 
each project.

• What notifications are needed to the workflow 
in your process.

To build the actual project template, create a new 
project based on the HelpDesk project, then 
customize the issue fields and define the custom 
styles and notifications you need.

Deleting Projects
To delete a project:

1 In HelpDesk Admin, click a project in the 
Project list.

2 On the File menu, click Delete Project.

Editing Project Properties
The project properties are displayed when you 
click a project in the Project list.

Project Location
Location of the project files, which includes the 
definitions database. 

Definitions Database
The name of the project definitions database. The 
definitions database contains the definitions of the 
fields, queries, sorts, layouts, reports, and 
notifications for the project.

If a project shares the definitions of another 
project, the two projects have the same definitions 
database.

Database Engine
Specifies whether the project uses Microsoft 
Access or SQL Server for the issue database. 

Groups Allowed to Open Project
List of user groups that are allowed to open the 
project. Groups allowed to open a project can:
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• Log on to Web views of the project (if they also 
have permission to open the views).

• Edit the project in HelpDesk Admin (depending 
on what features are enabled for the group).

• Edit views of that project in Web View Editor, or 
generate new views of that project.

If the Users group is allowed to open the project, 
then all groups can open the project. The Admins 
group is always allowed to open projects.

Current Users

Displays the users currently logged on to Web 
views of the project.

Name Logon name of the user.

Date/Time Date and time that the user logged on.

Workstation The user’s IP address or computer 
name.

Project The user is logged on to a Web view of 
this project.

Virtual Directory The virtual directory is the final 
part of the URL used to access the Web view. For 
example, if the virtual directory is named 
“helpdesk”, then the URL is http://server/helpdesk.

Virtual directories such as helpdesk00, 
helpdesk01, and helpdesk02 are all accessed 
through the //server/helpdesk URL.

Application This is always “Web View”. The 
Logons Editor also lists the Web View Editor and 
Web Admin.
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About the Field Editor
Before you start recording and tracking issues, you 
probably need to customize some of the fields 
used to collect information. For example, the 
Problem Area and Priority fields should list choices 
that correspond to your terminology and 
environment. 

You may want to delete unused fields, add new 
fields to track additional information, or add new 
tabs. For example, you may want to add a tab for 
hardware configuration details.

HelpDesk Admin provides a simple Field Editor for 
editing fields. To open this editor, click Field Editor 
on the Project menu. The Field Editor allows you 
to edit field definitions, but to export fields to Web 
views you use the Web View Editor.

Editing Fields Click a field in the Field list to edit, 
copy, rename, or delete the field. The Field list 
contains all the fields defined in the project. 

The buttons beside the Field list allow you to 
create new fields or copy, delete, or edit the 
selected field.

Destination Tab Tabs allow you to group sets of 
related fields. 

Labels A field has two labels. One label is the 
field name, which appears in choice lists such as 
the Field list in any of the HelpDesk Admin editors. 
The other label is the caption that appears beside 
the field in a Web view.

Data Under Data, you specify what type of input 
the field accepts: text, dates, times, numbers, 
yes/no values, or choices from a list.

The choices displayed in a choice list field are 
defined in a choice table. To edit and create choice 
tables, click  beside the Table Containing 
Choices list to open the Choice Editor.

Field Is The Field Is check boxes give you control 
over how the field behaves in a Web view. 
Required fields cannot be left blank. Visible fields 
appear in a Web view, instead of being hidden. 
Enabled fields accept user input, while disabled 
fields are read-only (they display data but do not 
accept user input). Enabled choice list fields can 
also be used in workflow rules.

The Read-Only For list specifies which user 
groups cannot edit the field.

Show in Choice Lists This check box controls 
whether you can use the field to build queries, 
reports, and other styles. 
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Maintain Revision History This check box 
controls whether Enterprise HelpDesk tracks 
revisions to the field, and whether you can use the 
field for update notifications (update notifications 
are generated when the value of a field changes).

Applying Changes To apply changes to fields, 
HelpDesk Admin must log off the users who are 
logged on to Web views of the project. 

Adding Fields

About Adding Fields

You can add new fields to any of the tabs. New 
fields are automatically available in all Enterprise 
HelpDesk editors, such as the Query Editor and 
Report Editor. 

New fields are not automatically exported to Web 
views. You must use the Web View Editor to export 
the fields and regenerate the Web views.

You can use an existing field as a starting point for 
a new field. In the Field list, click a field and then 
click .

Adding New Fields to Reports

When you add new fields, you should update the 
reports that Enterprise HelpDesk uses to print 
issues and to format notifications.

• Current Issue - Detailed is used to print the 
current issue in a Web view.

• Notification - Detailed Record and 
Notification - Summary are used to format the 
contents or attachments to e-mail notification 
messages.

Making Fields Required 

By default, fields are optional, which means users 
can leave the fields blank when they submit an 
issue. To make a field required, click the Required 
check box. Users cannot save an issue without 
filling in a required field. Required fields have a 
highlighted label in a Web view.

Making Fields Read-Only

To make a field read-only for all users Clear 
the Enabled check box. 

To make a field read-only for a specific user 
group Click the Enabled check box, and then 
click the group in the Read-Only For list.

Using Fields to Define Styles

If you don't need to use a field to build queries, 
sorts, layouts, reports, or notifications, clear the 
Show in Choice Lists check box. This removes the 
field from the Field lists of editors such as the 
Query Editor. It also removes the field from the 
Fields list in the Ad-hoc Query Editor of a Web 
view.

For example, the Attachments field is a field that 
you don't need for queries, sorts, layouts, reports, 
or notifications. How often would you expect users 
to search for or sort issues based on what files are 
attached? 
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Tracking Changes
If you don't need to track changes to a field, clear 
the Maintain Revision History check box. 
Enterprise HelpDesk won’t update the revision 
history when a user changes the field.

For a memo field, Enterprise HelpDesk doesn’t 
track the actual changes to the field value. Instead, 
Enterprise HelpDesk marks the field as “modified”.

If you want to send notifications when a field is 
updated, you must select the Maintain Revision 
History check box for that field.

Choosing a Destination Tab
The Destination Tab specifies the tab to which the 
new field is added. 

Fields added to the Contact tab are read-only 
(visible but not enabled). These fields are also 
added to the Users and Contact page in HelpDesk 
Web Admin, which is where you enter data into the 
fields.

To create new tabs, use HelpDesk Web Admin. 
See “Working with Tabs” on page 27.

Setting Field Labels
Field Caption is the label that appears beside the 
field in a Web view. You can override this label in 
the Web View Editor by setting the Caption 
attribute.

Choice Lists is the label that appears in any choice 
list that allows a user to choose a field (for 
example, in the Field list of the Ad-hoc Query 
Editor of a Web view). To change this label, click 

 to rename the field.

Choosing a Field Type
Currency, Date, Number, Text, and Time These 
are all input fields where a user can enter text. 
Enterprise HelpDesk automatically validates the 
text entered in these field types, and displays a 
warning if a user enters any invalid characters or 
uses the wrong format.

For example, Number fields accept only numeric 
values, and Currency, Date, and Time fields 
require the input values to follow the Windows 
Regional Settings. 

Memo A Memo field is a text field that allows a 
large amount of characters to be input. 

Single Choice and Multi Choice These fields 
are drop-down lists of choices. Choice lists present 
fixed lists of choices to the user. Multi Choice fields 
allow a user to select one or more choices.

Yes/No This is a check box.

Setting the Field Size
For Text fields, the field size is the maximum 
number of characters that a user can type in the 
field. For Number fields, however, the size is the 
data size (Byte, Integer, Long Integer, Double, or 
Single).

Size Description

Byte Stores numbers from 0 to 255 (no frac-
tions).

Decimal precision: None

Storage size: 1 bytes
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Removing Fields

About Removing Fields
To remove a field, you can either delete it or hide it. 
Or you can simply not export the field when you 
generate your Web views.

You can also disable fields, making them read-only 
(see “Making Fields Read-Only” on page 22).

Deleting Fields
Deleting a field removes it and all stored data from 
the issue database. If you don't want to lose the 
data, you can disable the field, hide it, or remove it 
from the Web views.

You can delete a field only if it is not used in any 
query, sort, layout, report, or notification.

Hiding Fields
Because you can simply remove a field from a 
Web view (by not exporting the field), hiding fields 
is not something you will do often. However, you 
may want to hide a field if some of the queries you 
export use the field, but you don’t want users to 
see the field. 

To hide a field in all Web views of a project, clear 
the Visible check box in the Field Editor. To hide a 
field in specific Web views, use the Visible attribute 
of the field in the Web View Editor.

Note that if you hide a field, it is still available in 
editors such as the query, sort, layout, and report 
editors, unless you clear the Show in Choice Lists 
check box.

Integer Stores numbers from –32,768 to 32,767 
(no fractions).

Decimal precision: None

Storage size: 2 bytes

Long 
Integer

Stores numbers from -2,147,483,648 to 
2,147,483,647 (no fractions).

Decimal precision: None

Storage size: 4 bytes

Single Stores numbers from
–3.402823E38 to
–1.401298E–45 for negative values and 
from
1.401298E–45 to 3.402823E38 for posi-
tive values.

Decimal precision: 7

Storage size: 4bytes

Double Stores numbers from
–1.79769313486231E308 to
–4.94065645841247E–324 for negative 
values and from 1.79769313486231E308 
to 4.94065645841247E–324 for positive 
values.

Decimal precision: 15

Storage size: 8 bytes

Size Description
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Queries do not work if the fields used in the query 
definition are not in the Web view.

Removing Fields from Web Views
Using the Web View Editor, you can remove fields 
from some Web views and leave the fields in other 
views.

Working with Choice Lists

About Choice Lists
A choice list is a list of choices displayed in a 
selection list on an HTML form. The list of choices 
is defined in a choice table.

Editing Choice Tables
You can edit the choices in the list from either:

• HelpDesk Admin

• HelpDesk Web Admin

Both allow you to add new choices, delete choices, 
change choice text, and reorder choices. 

Using HelpDesk Admin Use HelpDesk Admin 
when you want to create new choice tables. Using 
the Field Editor, you can both create the choice 
table and associate it with a field.

Also, use HelpDesk Admin when you want to edit 
the Progress choice table. Progress choices must 
be mapped to State choices (see “Editing the 
Progress and State Lists” on page 26), and you 
can do this only with the Field Editor.

When to use HelpDesk Web Admin Use 
HelpDesk Web Admin to edit existing choice 
tables (for example, when you want to edit choice 
text or add new choices). While you can create 
new choice tables in HelpDesk Web Admin, you 
cannot associate the new choice table with a 
field—for that you need to use the Field Editor in 
HelpDesk Admin.

Also, don’t use HelpDesk Web Admin to edit the 
Progress choice list. Use HelpDesk Admin 
instead. All Progress choices must be mapped to a 
State choice, and you cannot edit (or even view) 
that mapping in HelpDesk Web Admin. 

Any new choices you do add to Progress will not 
be mapped to a State choice. And if you do edit the 
text of a Progress choice, remember that if the 
new text changes the sense of the choice, the 
State field will be set incorrectly. For example, if 
you change “Resolved” to “Reopened”, then 
Reopened will still be mapped to the Closed state.

HelpDesk Web Admin can also delete choice lists, 
but only if they are not referenced by a field. 

Advantages of HelpDesk Web Admin The 
advantage of HelpDesk Web Admin is that you can 
edit choice lists across the Web. You don't have to 
be sitting at a machine where HelpDesk Admin is 
installed. Also, you must use HelpDesk Web 
Admin to define global choice lists.

Editing Choice Text

When you change the text of a choice, you must 
update any queries that test the choice value. For 
example, consider this query:

Progress = Assigned
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If you change the choice text from "Assigned" to 
"InProgress" in the choice table, then the query will 
not find any issues. Issues store the index of the 
choice, but queries store the actual text.

Renaming Choice List Tables

HelpDesk Web Admin (in the Choice List list on the 
Choices tab) displays a name associated with the 
choice table, not the name of the choice list field.

A choice table actually has two names: the name 
of the choice table (for example, “tblState”) and a 
friendly name (for example, “State”). HelpDesk 
Web Admin displays the friendly name. You can 
change the friendly name by renaming the choice 
table in HelpDesk Web Admin.

Sorting Choice Lists

Choices can be listed in alphabetical order, or in 
any order that you want. For example, a non-
alphabetic choice order such as Highest, High, 
Medium, Low, Lowest is more appropriate for a list 
of relative values than the alphabetic order.

When you create a new choice list, you choose 
how you want to order the list. The Allow Choice 
Order Sort check box controls whether a choice list 
supports non-alphabetic choice orders and sorts.

By default, Enterprise HelpDesk automatically lists 
choices in alphabetic order. But when you allow 
choice order sorts, you can specify a non-
alphabetic choice order, and you can define sorts 
that sort issues by choice order as well as by 
alphabetic order.

To specify a non-alphabetic choice order, you 
assign a numeric ID to each choice. This ID 
represents the position of the choice in the list (1st, 
2nd, and so on).

If you do not specify the choice order, Enterprise 
HelpDesk automatically sorts the list into 
alphabetic order.

Editing the Progress and State Lists
The Progress choice list is a special type of choice 
list. When a user selects a choice from the 
Progress list, the State field is automatically set to 
either Open or Closed.

If you want to change the mapping of Progress 
values to State values, you must use HelpDesk 
Admin.
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In HelpDesk Admin, the choice table for the 
Progress list contains an extra column that maps 
Progress choices to State choices. You must fill in 
this column when you add or edit the choices in 
the Progress list.

When you edit the State choice table, remember 
that the Closed choice is the choice that sets the 
Closed Date and Time fields. So, for example, 
changing the choice text from “Closed” to 
something else may confuse users.

If you edit the Progress choice list, you should 
check that workflow rules based on the Progress 
field still work.

Global Choice Lists
Global choice lists are choice lists that are shared 
by all projects. After you create a global choice list, 
you use the Field Editor in HelpDesk Admin to 
associate the choice list with a field. You will also 
have to regenerate the Web views that will use the 
field.

To define a global choice list

1 In HelpDesk Web Admin, click the Choices tab.

2 In the Project list, click Global Choice Lists.

3 Click  to create a new choice list.

To create a new choice by copying an existing 
list: in the Choice List list, click a list and then 
click .

4 In the Add Choice List dialog box:

• In the Choice List Name box, type a name 
for the database table that will store the 
choices in the choice list.

• In Choice List Caption, type a display name 
for the choice list (this is the name displayed 
in in HelpDesk Web Admin).

• Select the Non-Alphabetical Choice Order 
check box if you want to define a non-
alphabetical order for the choices in the list 
(for example, "Applications", "System", 
"Hardware"). 

5 In the Choices section, click  to add a new 
choice to the list.

Working with Tabs
HelpDesk Web Admin allows you to add new tabs 
to a project. After you add a new tab, you use the 
Field Editor to add new fields to the tab.

You can also reorder the tabs, change the tab 
names, and delete tabs. To delete tabs you must 
either delete all the fields on the tab or move the 
fields to another tab.
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Chapter 5: Finding and Listing Issues

Building Queries

About Queries

To build queries in HelpDesk Admin, click Query 
Editor on the Project menu. In the Query Editor, 
you use And and Or operators to combine multiple 
search conditions. To control the order in which 
search conditions are evaluated, you insert sets of 
parentheses.

To use one query as a starting point for a new 
query, choose a query from the Query Name list, 
click Copy, and give the new query a name.

To test a query, click Preview.

Searching by Dates

You can use the value <Today> to match the 
current date. For example, you can search for all 
issues submitted or updated today. 

To search against specific dates, double-click the 
Value box and then double-click a date in the 
calendar.

Searching for Unassigned Issues

By default, the Owner field is set to <None>. You 
can use the value <None> in queries to find 
unassigned issues.

Finding Issues for the Current User

You can use the value <User> to match the current 
user. With <User>, you can build generic queries 
that work for any user. For example, the My 
Assigned Issues query finds all issues assigned to 
the current user. 

Finding New Issues 

To find all issues that have not been updated since 
they were first submitted, search against the 
revision number: Revision Number = 1.

Finding Parent Issues 

You can find the parent issues of a child issue by 
searching against the Child Issues field. For 
example, to find the parent issues of the issue 22, 
use the Advanced query editor to search for Child 
Issues = 22. 

To find all parent issues, use the Advanced query 
editor to search for Child Issues <> 0. 

Searching Choices Lists with Relational 
Operators

The relational operators are <, <=, >=, and >. 
When you search choice lists with a relational 
operator, the search is based on the order of the 
choices in the list. 
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For example, the order of choices in the Problem 
Area list is:

Apps - Goldmine
Apps - MS Excel
Apps - MS Outlook
Apps - MS Word
Apps - Other
HW - Disk
...
So the query Problem Area < HW - Disk returns all 
the application-related issues.

If a choice list uses a non-alphabetical sort order, 
the sense of the relational operators is reversed. 
For example, the Priority list has this choice-order 
sort:

ASAP
Next 4 Hours
Today
Tomorrow
This Week
Next Week
This Month
Whenever

The query Priority > Today returns issues marked 
ASAP or Next 4 Hours. The query Priority < Today 
returns issues marked Tomorrow, This Week, Next 
Week, This Month, or Whenever.

Previewing Queries 
To check the results of a query without closing the 
Query Editor, click the Preview button. This runs 
the query and displays the results in a preview 
window. 

Saving Queries

To save changes and continue editing: 

• Click Apply to apply your changes without 
closing the Query Editor.

To save changes and exit the Query Editor:

• Click Close to apply your changes and close 
the Query Editor.

Inserting Parentheses Around Search 
Conditions
When you combine search conditions with the And 
and Or operators, you may not always get the 
results you expect. For example, suppose you 
want to find all new issues with priorities ASAP or 
Today.

Progress = New And 
Priority = ASAP Or 
Priority = Today

And has a higher precedence than Or, so this 
query finds all new issues with priority ASAP, plus 
all issues (not just the new ones) with priority 
Today:

( Progress = New And Priority = ASAP ) Or 
Priority = Today

To find just the new issues with priorities ASAP 
and Today, you need to put parentheses around 
the conditions joined by Or, so that the query looks 
like this in the Code View:

Progress = New And 
(Priority = ASAP Or 
Priority = Today)

To insert the parentheses, click the Priority = 
Today search condition and then click .

Searching for Strings
The Contains operator performs a case-insensitive 
search for a string of text anywhere in a field. You 
can use Contains to search for keywords in the 
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Summary or Description fields. This allows you to 
package common keyword searches such as 
predefined queries. For example:

Summary Contains printer
You can also use Contains to find all choices in a 
list that contain the same string of characters. For 
example, the choices in the default Problem Area 
list start with either “HW - “, “Apps - “, or 
“System - “. So Contains “HW -” finds all 
hardware problems.

Searching for Wildcards
The Like and Not Like operators support wildcard 
characters, which gives you considerable flexibility 
in the specification of search patterns. Using 
wildcards, you can search for inexact patterns of 
text in any field.

To search for the wildcard characters _ and %, you 
must enclose them in brackets. For example, to 
search for a percent sign, use the pattern [%].

Defining Sorts

About Sorts

You can sort the Summary List by issue number, 
priority, state, progress, owner, or any other field or 
combination of fields. Enterprise HelpDesk allows 
you to define sorts, which are named sets of sort 
criteria. Sorts appear in the Sort list on the 
Summary toolbar.

Wildcard Matches

_ Any single character. For example:

“run_time" matches "run time" or 
"run-time"

% Zero or more characters. For exam-
ple:

Contains run%time matches any 
string that contains "runtime", 
“run time”, or "run-time".

Like Install% matches any string that 
starts with “Install”.

Like %run%time% matches the same 
strings as Contains run%time.

[charlist] Any single character in charlist. Can 
include spaces, but not the right 
bracket (]) character. For example:

"SP[56]" matches "SP5" or "SP6"

Use a hyphen to specify a range of 
characters. For example:

"[1-36-9]" matches the digits 1, 2, 3, 6, 
7, 8, or 9

To match the hyphen character, the 
hyphen must be either the first or last 
character in charlist. For example:

"[-0-9]" or "[0-9-]" match any digit or a 
minus sign

[!charlist] Any single character not in charlist. 
For example:

"[!tb]rash" matches "crash" but not 
"trash" or "brash"

Wildcard Matches
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To define a sort in HelpDesk Admin, click Sort 
Editor on the Project menu to open the Sort Editor.

In the Sort Editor, choose the fields you want to 
use as sort keys. The first field is the primary sort 
key, the second field is the secondary key, and so 
on. 

For example, if you sort by Owner and Priority, 
then issues are sorted alphabetically by owner, so 
that all issues belonging to the same person are 
grouped together. Then the issues for each owner 
are sorted by Priority. 

To use one sort as a starting point for a new sort, 
choose a sort from the Name list, click Copy, and 
give the new sort a name.

Sort Orders

Choice Order Ascending and Choice Order 
Descending sort the issues based on the order of 
the choices in the choice list, not on alphabetical 
order. For some choice lists, this is not the same 
order.

For example, a choice list may contain the values 
"High, Medium, Low" in that order. An alphabetical 
order for the sort list would "High, Low, Medium" or 
"Medium, Low, High", which doesn't make as 
much sense. 

Previewing Sorts 

To check the results of a sort without closing the 
Sort Editor, click the Preview button. This runs the 
sort and displays the results in a preview window. 

Saving Sorts

To save changes and continue editing: 

• Click Apply to apply your changes without 
closing the Sort Editor.

To save changes and exit the Sort Editor:

• Click Close to apply your changes and close 
the Sort Editor.

Defining Layouts

About Layouts
When you use different queries, you probably want 
to list different information in the Summary List. 
For example, when you list all issues assigned to 
you, you might replace the Owner column with 
some other column. But when you list all issues 
assigned to a group, you probably want to see who 
owns each issue.

Enterprise HelpDesk allows you to define layout 
styles that specify the column layout and contents 
of the Summary List. Layout styles appear in the 
Layout list on the Summary Toolbar.

To define a layout in HelpDesk Admin, click Layout 
Editor on the Project menu to open the Layout 
Editor.

Each column in the Summary List corresponds to 
a field. Choose the fields you want to list, and set 
the column widths and alignments. By default, field 
names are used as column headings, but you can 
change this by entering a new heading in the Title 
cell.
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To use one layout as a starting point for a new 
layout, choose a layout from the Name list, click 
Copy, and give the new layout a name.

Previewing Layouts 
To check a layout definition without closing the 
Layout Editor, click the Preview button.

Saving Layouts
To save changes and continue editing: 

• Click Apply to apply your changes without 
closing the Layout Editor.

To save changes and exit the Layout Editor:

• Click Close to apply your changes and close 
the Layout Editor.
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Chapter 6: Reporting

About Reports
Reports help you understand and assess the state 
of your project. An issue tracking system like 
Enterprise HelpDesk contains a lot of valuable 
information about a project. Reports allow you to 
access this information, break it down, analyze it, 
and present it. 

Enterprise HelpDesk provides three types of 
reports: Summary (cross-tab), Listing, and Time 
(trend).

In addition to defining standard Listing reports in 
HelpDesk Admin, you can also use Crystal 
Reports (must be purchased separately) to 
customize Listing reports by adding features such 
as charts, formulas, field highlighting, and running 
totals

To design reports in HelpDesk Admin, click 
Reports on the Project menu, and then click 
Report Editor.

Viewing Reports
Depending on the report format and definition, you 
can view reports as text or as line, bar, or pie 
charts. Charts can be in either 2D or 3D.

You can view Summary, Time, and Listing reports 
in HelpDesk Admin. You can also view Listing 
reports in Web views. By default, Web views use 
HTML to format and display Listing reports, and 
Crystal Reports 9.0 for custom reports (Enterprise 
HelpDesk includes the Crystal Reports 9.0 
Runtime Software).

Changing Report Viewers
Options control which report viewers are used by 
the Web views:

• Standard Report Engine specifies the report 
viewer used for Listing reports.

• Custom Report Engine specifies the report 
viewer used for Custom reports.

To set these options, log on to HelpDesk Admin, 
and on the Tools menu, click Options.

To build custom reports, you need to change 
Standard Report Engine from HTML to Crystal 
Reports 9 or Crystal Reports 8.5. You also need to 
license the Report Creation API, because 
Enterprise HelpDesk has to create the initial .rpt 
file when you first view a Listing report. This initial 
.rpt file is the file that start with when you build a 
custom report.

Selecting Which Issues to 
Include in a Report
In the Query list, choose a query to extract issues 
from the issue database and include them in the 
report. For example, if you want a report that 
breaks down the open issue count, then use the 
Open Issues query.

In Web views, users can use a combination of 
predefined and ad-hoc queries to specify what 
issues to include in a report. The Web-based 
report viewer allows users to generate reports 
using the current contents of the Summary List, or 
using the current issue.
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Defining Summary 
Reports

About Summary Reports
Summary reports are like spreadsheets. They give 
you a numerical break down of the state of your 
project. Use Summary reports to answer questions 
like: What's the distribution of open issues among 
help desk analysts? How many of the open issues 
are urgent? Is there a relationship between 
department and issue priority?

You can view Summary reports in HelpDesk 
Admin.

Adding Rows
Each row corresponds to a possible value of a 
choice-list field (single or multi). For example, you 
can add rows for all users in the Owner list, or just 
for the help desk analysts in the list.

A “row” is something different in each type of 
report.

Text (cross-tab) reports Each row is a row in the 
cross-tab table.

Bar charts A bar chart shows bars for each row. 
That is, the “rows” define the horizontal axis, while 
the “column” defines what the bars represent.

If you don’t include a “column”, then there is one 
bar for each row. This bar represents the total 
number of issues for the row. If you include a 
“column”, then you get side-by-side bars for each 
row.

Pie charts Each row is a slice of the pie. To 
ensure that the slices add up to 100%, select <All> 
in the Rows column.

Adding Columns
Each column corresponds to a possible value of a 
choice-list field (single or multi). For example, you 
can add columns for all possible priority values, or 
just for the highest priorities (ASAP, Next 4 Hours, 
Today).

Like rows, columns mean different things in the 
different report formats.

Text (cross-tab) reports Each column is a 
column in the cross-tab table.

Bar charts The column specifies what bars to 
display for each row.

Pie charts Columns are not used in pie charts.

Calculating Totals
You can insert rows to calculate the totals of 
columns of numbers. Choose <Total> from the 
Field Name list. Then choose the groups for which 
you want a total.

A group is the set of rows for a given field. The 
Group column displays the group ID. When you 
add a total row, you use these IDs to specify which 
groups of rows you want to add up.

A Total row sums only the numbers in the selected 
groups. So each group of rows can have its own 
subtotal. To add a grand total, choose <ALL>.

To add a column that calculates the totals of rows 
of numbers, select the Total check box.
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Using Totals and the Show Setting
Suppose you want to break down the open issue 
count, not by individual owner, but by groups of 
owners. For example, you might want to see the 
distribution of open issues between analysts and 
group leaders.

For both groups (Help Desk Analyst and Help 
Desk Group Leader), add a group of rows and a 
total row. The group of rows (for example, row 1 
below) contains a row for each help desk analyst. 
The total row for analysts (row 2) totals up the 
individual numbers to give a group total.

Showing Totals for Groups

To hide the rows for the individual owners in a 
group, clear the Show check box.

Customizing Row and Column Headings
Use the Title fields to enter the heading text for 
rows and columns. 

Controlling Column Width in Text Reports
Use the Column Width box to set a maximum 
width for all columns in a report, including the 
column headings. 

Examples
Text (cross-tab) report A Summary report can 
break down the open issue count by owner and by 
priority.

This example includes a row for each help desk 
analyst, and columns for the priorities ASAP, Next 
4 Hours, Today, and Tomorrow. The report also 
includes totals.
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Bar chart Bar charts show data as vertical bars. If 
you have no columns (in the Columns list, click 
<None>), then the bar chart shows a total for each 
row.

If you add columns, then the bar chart shows a 
series of side-by-side bars for each value of the 
horizontal field. For example, you could show a 
breakdown by priority of the issues with Progress 
= New.

Pie charts A pie charts shows a percentage 
breakdown of the issues. Each slice of the pie 
corresponds to a row. Since a whole pie 
represents 100%, you should select <All> in the 
Rows list.

Having more than one group of rows or a Total row 
won’t make sense in a pie chart (generally, you’ll 
be counting each issue twice if you have two 
groups of rows). If the report defines more than 
one group of rows or a Total row, clear the Show 
check box before you view the pie chart.

Columns are ignored in a pie chart.

Defining Listing Reports

About Listing Reports
Listings extract and present subsets of the 
information entered in issues. Listings are 
available only as text. 

You can view Listing reports in HelpDesk Admin 
and in Web views. You can use Crystal Reports to 
customize the version of the listing report that is 
displayed in Web views.

Defining Listing Reports
Listing reports are listings of information entered in 
issues. Use Listing reports to extract specific 
information from issues.



39
For example, you might want to print out a 
summary of the resolution details for each 
resolved issue. Or you might want only the issue 
number, owner, and a summary of each issue. 
With Listing reports, you choose a set of issue 
fields, and only those fields are included in the 
report.

Query Retrieves the issues included in the report

Sort Sorts the issues.

Page Header, footer, and title to apply to the 
report.

Tabular Tabular listings list issues in the columns 
of a table. A tabular report is like the Summary List, 
except that you can use a report template to add 
things like a report title or page numbering. 

Tabular Listing

Multicolumn Multicolumn listings arrange issue 
information into blocks, which are repeated down 
the page for each issue.

Multicolumn Listing

Custom Report Marks the report as a custom 
report. In a Web view, custom reports are listed on 
the Custom tab of the View Reports dialog box. 
Custom reports are typically Listing reports 
customized with Crystal Reports.

Defining Time Reports

About Time Reports
Time reports show trends over time. Use Time 
reports to answer questions like: What's the issue 
arrival rate? What's the issue resolution rate? How 
fast are issues being resolved? 

Defining Time Reports
Time reports show the relationship between the 
number of issues and time. For example, a Time 
report can show you the number of issues opened 
each week during the last month.

Defining the Time Axis
The time axis divides the reporting period into 
intervals of days, weeks, months, quarters, or 
years (this is the granularity of the report). The 
Time report then sorts the issues into the time 
intervals, and counts the number of issues in each 
interval.

To sort issues into time intervals, a Time report 
uses a master date. The master date is a date 
entered in an issue field such as Submitted Date, 
Closed Date, Assigned Date, or Update Date.

Master 
Date

Description

Assigned 
Date

Date an issue was assigned.

For a report that shows the number of 
open issues per analyst, you might use 
the Assigned Date instead of the Sub-
mitted Date. 
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Including All Dates Select the Show dates with 
no values check box to show days, weeks, 
months, quarters, and years when there were no 
issues. For example, in a report that shows the 
daily arrival rate of new issues during the last 
week, you probably want to see a value for each 
day in the week, even if that value is 0.

Showing Interval Totals When the Cumulative 
check box is selected, a Time report accumulates 
the number of issues from one interval to the next. 
For example, suppose you have a Time report that 
shows the number of submitted issues per week. 
To see how the total number of submitted issues 
grows week by week, select the Cumulative check 
box. To see the number of issues submitted each 
week, clear the Cumulative check box. 

Defining Reporting Periods Enter specific From 
and To dates, or simply choose one of the When 
conditions: This Month, This Quarter, or This Year. 
You can also combine From or To with When. For 

example, if the year was 2004 and you set From to 
"3/3/04" and When to This Year, your reporting 
period would be 3/3/04 to 12/31/04. 

Including Totals Select the Total check box. For 
each time interval, the Time report will show the 
total number of issues included in the report.

Controlling Column Width in Tabular Time 
Reports Use the Column Width box to set a 
maximum width for all columns in a report, 
including the column headings. 

Defining the Field Axis
The field axis determines which issues a report 
counts. For example, to see the number of ASAP 
and Today priority issues, you choose these 
Priority field values as the columns. The Time 
report then counts the number of ASAP and Today 
priority issues in each interval.

Each “column” corresponds to a possible value of 
a choice-list field (single or multi). For example, 
you can add columns for all possible priority 
values, or just for the highest priorities (ASAP, 
Next 4 Hours, Today).

Text (cross-tab) reports Each column is a 
column in the cross-tab table.

Line charts Each column is a line in the line 
chart.

Bar charts The column specifies what bars to 
display for each row.

Closed 
Date

Date an issue was closed. This hap-
pens when Progress is set to a value 
that maps to the Closed state.

Use this date for reports that show the 
number of issues fixed over time (fix 
rate reports). 

Submitted 
Date

Date an issue was originally submitted.

Use this date for Time reports that show 
the number of submitted, open, or 
closed issues over time.

Update 
Date

Date an issue was last modified.

Master 
Date

Description
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If you set Field Name to <None>, then the Time 
report provides a total of all issues for each 
interval.

Defining Report Pages
Report pages define formatting elements common 
to every page of a report, such as headers, 
footers, titles, and column layout. Report pages 
also define report titles. Pages can be shared by 
many reports, allowing you to define a standard 
look for all reports generated by Enterprise 
HelpDesk.

Enterprise HelpDesk comes with a set of 
predefined pages. You can adapt these templates 
to your specific requirements, or define entirely 
new pages.

To open the Page Editor:

On the Tools menu, click Report and then click 
Page Editor.

• Choose a page from the Name list. You can 
then edit, delete, or rename the page.

• To use one page as a starting point for a new 
page, choose a page from the Name list, click 
Copy, and give the new page a name.

• To create a page from scratch, click New.

You can use the Page Editor to define headers, 
footers, and titles for your reports. In addition to 
typing and formatting plain text, you can insert 
placeholders for the current date, time, and page 
number. When you generate your report, these 
placeholders are replaced with the actual values.

To do this Click

Insert the current date

Insert the current time

Insert the current page number

Left-align text

Center text

Right-align text

Format text by changing fonts and point 
sizes, and applying bold, italic, or under-
line styles.
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Chapter 7: Managing Contacts, Users, 
and Groups

About Users and Contacts
In Enterprise HelpDesk, you work with two types of 
users:

• Users, who have logon names and passwords 
and can log on to Web views, HelpDesk Web 
Admin, HelpDesk Admin, or the Web View 
Editor.

• Contacts, who cannot log on. Contacts are 
people who report issues, either by phone, e-
mail, fax, or through submit-only views.

Users are not specific to projects. For example, a 
user can use the same logon name and password 
to log on to any Web view of any project. However, 
each project can store different information for 
users. When you add a field to the Contact tab of a 
project, that field is a project-specific user 
information field. That is why you have to choose a 
project before you can create or edit users in 
HelpDesk Web Admin.

Importing Users and Contacts from Windows
You can import user accounts from Active 
Directory (or from a Windows NT domain), so 
users can log on to Enterprise HelpDesk with their 
Windows user names and passwords. You use the 
User Account Import Manager to import user 
accounts and keep Enterprise HelpDesk 
synchronized with Active Directory/Windows.

Administering Users and Contacts To create 
and manage users and contacts in Enterprise 
HelpDesk you use HelpDesk Web Admin. For 
example, you can use Web Admin to disable 
users, create contacts, and to create user 
accounts.

Users with the required permissions can also 
create contacts in Web views.

About Security
Enterprise HelpDesk provides security features 
that allow you to manage user access to issue 
data and Enterprise HelpDesk features. In 
Enterprise HelpDesk, security is based on the 
concepts of users and groups.

When you install Enterprise HelpDesk, the Setup 
program automatically creates Admin, demo, and 
guest users, along with a number of sample, role-
based user accounts.

To secure your projects, you must either import or 
create user accounts for other users. You then 
assign users to groups and use group privileges to 
control access to Enterprise HelpDesk tools such 
as HelpDesk Admin and HelpDesk Web Admin 
and for individual features such as the Report 
Editor.

About Groups
Every user is a member of one or more groups. 
Access to Enterprise HelpDesk features and 
projects is based on group membership. You can 
enable and disable features and projects on a 
group-by-group basis. A user can only access a 
feature or project if the user is a member of a 
group where the feature or project is enabled.

Enterprise HelpDesk has several default groups.
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• The Admins group has all features enabled. 
Other groups enable only some features.

• The Users group enables features that you 
want to make available to all users. All users 
are members of the Users group.

• The Help Desk Analysts and Help Desk Group 
Leaders groups have access to all Web view 
features controlled by security permissions. 

• The Employees group cannot access any of the 
Web view features controlled by security 
permissions. 

To control access to Enterprise HelpDesk features, 
you assign users to the groups based on their 
roles and responsibilities in the issue tracking 
process. For example, a help desk group leader or 
analyst who is also responsible for administering 
Enterprise HelpDesk must be a member of the 
Admins group.

Use the Web View Editor to control who can log on 
to a given Web view of a project. The Web View 
Editor allows you to set group access permissions 
for Web views. See “Setting Group Access 
Permissions” on page 87. 

Use HelpDesk Admin to control access to projects. 
See “Enabling and Disabling Projects” on page 56.

Importing User Accounts 
from Windows

Importing User Accounts
You can import user accounts from an Active 
Directory domain or from a Windows NT domain. 

For Active Directory domains, Enterprise 
HelpDesk imports the user names and e-mail 
addresses.

To import user accounts:

1 Log on to the HelpDesk User Account Import 
Manager.

2 In the Welcome dialog box, click Next.

3 In the Import Rules dialog box, click an import 
rule. Import rules determine which users are 
imported.

4 In the Active Directory Servers and Windows 
Domains dialog box, select an Active Directory 
LDAP server or a Windows NT domain.

If you need to add an Active Directory server, 
click Add LDAP. Click Add Domain to add a 
Windows NT domain.

5 In the Active Directory Servers and Windows 
Domains dialog box, click the Active Directory 
server or Windows domain from which you 
want to import users.

6 In the Import Users dialog box, do one of the 
following:

• If you want all the users listed in the dialog 
box, click Next.

• For Active Directory: If you want to filter the 
list based on groups, click Add Filter and 
select the groups to filter. Then click Append 
to add the group filter to the current search 
filter, or click Replace to replace the current 
filter with the group filter.

Finally, click Refresh to apply the search 
filter.

You can also type additional LDAP search 
filter conditions directly in the Filter box. For 
example, "(cn=e*)" selects all users with 
user names starting with "e", and 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/adsi/adsi/search_filter_syntax.asp
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"(&(!cn=IUSR*) (!cn=CensusUser))" filters 
out all IUSR_<computername> accounts 
and the CensusUser account.

• For Windows Domains: If you want to filter 
the list of users, select the groups you want 
to import from the list.

• If you want to import only some of the users, 
click Selected Users and then click the users 
you want to import.

7 In the Import Settings dialog box, 

• If you want to import contacts instead of 
users, select the Import as Contacts check 
box.

• Imported users are always added to the 
Users group. If you want to add the imported 
users to another user group such as 
Employees, then in the Import to Group list, 
click the group to which you want to add the 
new users.

• If you want to schedule imports, select the 
When Scheduled check box and then click 
Configure.

Defining Import Rules
An import rule “remembers” the settings you used 
the last time you used the rule.

To define an import rule:

1 In the Import Rules dialog box, click Add and 
then type a name for the import rule.

2 Click Next and continue through the remaining 
steps of the User Account Import Manager. 

All your subsequent choices and settings will be 
saved in the import rule. For example, suppose 
you select an Active Directory server, specify 
an LDAP search filter, and change the default 

import settings. The next time you run the User 
Account Import Manager, you can select the 
import rule to use the same choices and 
settings.

Adding Active Directory Servers and 
Windows Domains
Before you can import user accounts, you need to 
add a connections to an Active Directory server or 
Windows NT domain.

To add an Active Directory server:

1 In the Active Directory Servers and Windows 
Domains dialog box, click Manage.

2 In the Manage Active Directory Servers and 
Windows Domains dialog box, click Add LDAP.

3 In the Display Name box, type a name for the 
LDAP server. Enterprise HelpDesk uses this 
name to identify the server.

4 In the Host, Port, and Base DN boxes, type the 
connection information for the LDAP server.

• Host is the IP address of the LDAP server.

• Port is the port the LDAP server is running 
on. By default, LDAP servers run on port 
389. LDAP over SSL uses port 636 by 
default. 

• Base DN is the top level of the LDAP directory 
tree. For example, if your company’s DNS 
domain name is "mycompany.local", the Base 
DN is "dc=mycompany,dc=local”.

5 If you want to use anonymous authentication 
for the connection, select the Anonymous Bind 
check box. 

6 If the Anonymous Bind check box is cleared, 
enter the information for authenticating a user 
when connected to the server.
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• User DN is the user to authenticate For 
example: 
“CN=Administrator,CN=Users,DC=mycomp
any,DC=local”

• Password is the user's password

7 In the LDAP Logon Name Field box, type the 
name of the LDAP property that stores the user 
account name. Enterprise HelpDesk will use 
this name to log on.

8 Click Test to test the connection.

Adding a Windows NT Domain

To add a Windows NT domain:

1 In the Active Directory Servers and Windows 
Domains dialog box, click Manage.

2 In the Active Directory Servers and Windows 
Domains dialog box, click Add Domain.

3 In the Domain list, click the Windows NT 
domain you want to add.

4 If the Computer Name box is not automatically 
filled in, type the name of the server that is the 
primary domain controller, in the format 
“\\server”.

5 Click Test to test the connection.

Filtering Users
You can use LDAP search filters to filter the list of 
users imported from Active Directory. 

If you want to filter users based on Active Directory 
groups, click Add Filter and select the groups you 
want to filter. Then click Append to append the 
group filter to whatever search filter is already in 
the Filter box, or click Replace to replace any 
existing search filter.

If you want to filter on other conditions, you can 
also write your own LDAP search filters, and 
combine them with the group filters created with 
Add Filter. For example, you could type in filters 
such as:

• (sn=Mark)
selects users with a surname of “Mark”.

• (!cn=IUSR_*)
filters out all user names that start with 
“IUSR_*”.

• (&(!cn=IUSR_*) (!cn=IWAM_*))
filters out all IUSR_<computername> and 
IWAM_<computername> users.

For more information on the LDAP search filter 
syntax, see
http://msdn.microsoft.com/library/default.asp?url=/
library/en-us/adsi/adsi/search_filter_syntax.asp.

Import Settings
Import as Contacts. If you want to import the 
users as contacts, select the Import as Contacts 
check box.

Import to Groups. By default, imported users are 
added the Users group in Enterprise HelpDesk. If 
you want to add the imported users to a different 
group (for example, Admins), click the group in the 
Import to Groups list.

Get E-mail Addresses From. Specifies where to 
get the e-mail addresses of imported users.

Scheduling Imports. Specifies when to import 
users. Select the When Scheduled check box and 
then click Configure is you want to use Windows 
Scheduled Tasks to schedule regular imports. 
Scheduling imports will keep Enterprise HelpDesk 
synchronized with Active Directory and Windows 
domains.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/adsi/adsi/search_filter_syntax.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/adsi/adsi/search_filter_syntax.asp
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Select the Now check box if you want to import 
users as soon as you finish with the User Account 
Import Manager.

Import Settings. These two check boxes control 
whether the Enterprise HelpDesk User Account 
Manager:

• Adds new user accounts for any new users 
found in the Active Directory or Windows 
domain.

• Updates existing user accounts with any 
changes (for example, to the user name or e-
mail address) found the Active Directory or 
Windows domain.

Creating User Accounts
You create Enterprise HelpDesk user accounts 
with HelpDesk Web Admin. New users are 
members of the Users group. To add a new user to 
other groups, you use HelpDesk Web Admin.

To create a user account:

1 In HelpDesk Web Admin, click the Security tab.

If you are in HelpDesk Admin, click Tools > 
Security > Users.

2 In the Project list, click a project.

Users are not specific to a project, but each 
project can have its own user information fields. 
For example, one project may have a 
Department field while other projects do not.

3 In the Display list, click Users.

• To display all users, click All Users.

• To display all contacts, click All Contacts.

• To display all users and contacts whose 
names start with the same letters, click 
Names starting with and then type the first 
few letters of the name.

• To display all users and contacts whose 
names contain the same string, click Names 
containing and then type the string.

4 Click Add User 

5 In the Authenticate With list, click HelpDesk to 
authenticate against the Enterprise HelpDesk 
user database.

6 In the Logon Name box, type the name the user 
will use to log on to Enterprise HelpDesk.

7 In the Password and Confirm Password boxes, 
type the user’s password.

8 Enter the rest of the user information and then 
click Apply.

9 If you want to control the projects in which the 
user is visible, use the Category list to assign 
the user to a category (for example, Internal 
Development or External Development).

Different projects can be configured to display 
different categories of users (and contacts).

Setting Default Values for 
New Users
To save time when creating user accounts, you 
can use an existing user account as a template for 
new accounts. All the user information entered in 
the existing account (except for the password, 
user name, and logon name) will be used as the 
default values for new accounts.
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To set the default values for new user 
accounts:

1 In HelpDesk Web Admin, click the Security tab.

If you are in HelpDesk Admin, click Tools > 
Security > Users.

2 In the Project list, click a project.

3 In the Display list, click Users.

4 Click a user and then click Make Default .

Tip You can do the same thing for contacts. Just 

click a contact in the list and then click . 

Managing Work Teams

About Work Teams
You can use Enterprise HelpDesk to help manage 
and coordinate work teams. Setting up work team 
support involves the following tasks:

• Building a list of work teams. Enterprise 
HelpDesk includes a global choice list named 
Work Team.

• Assigning users to work teams.

• Adding the Assigned Work Team field to Web 
views. This field is used to assign issues to 
specific work teams, either manually by users 
or automatically by workflow rules.

• Define queries for finding work team issues. 
Enterprise HelpDesk includes a My Work 
Team’s Issues query that gets all the issues 
assigned to a user’s work team, but you may 
want to define additional queries for work teams 
(for example, a query that finds all open issues 
assigned to the user’s work team).

Defining Work Teams
The list of available work teams is stored in a 
global choice list named Work Team. The BugTrk, 
XSupport, and XSupportBugTrk projects all have 
an Assigned Work Team field that use this global 
choice list.

You use HelpDesk Web Admin to edit the list of 
work teams.

To edit the list of work teams:

1 In HelpDesk Web Admin, click the Choices tab.

2 In the Project list, click < Global Choice Lists >.

3 In the Choice List list, click Work Team.

4 In the Choices section:

• To rename a work team, click the work team 
and then click .

• To add a new work team, click  and then 
type the name of the work team.

• To delete a work team, click the work team 
and then click  .

Assigning Users to Work Teams
You can assign both users and contacts to work 
teams. No user or contact can belong to more than 
one work team.

To assign a user or contact to a work team:

1 In HelpDesk Web Admin, click the Security tab.

If you are in HelpDesk Admin, click Tools > 
Security > Users.

2 In the Project list, click a project.

3 In the Display list:

• To display all users, click All Users.

• To display all contacts, click All Contacts.
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• To display all users and contacts whose 
names start with the same letters, click 
Names starting with and then type the first 
few letters of the name.

• To display all users and contacts whose 
names contain the same string, click Names 
containing and then type the string.

4 In the list of users, click a user (or contact) and 

then click Edit .

5 In the Work Team list, click the work team to 
which the user belongs.

Adding Work Team Support to Web Views
To allow users (and workflow rules) to assign 
issues to work teams, export the Assigned Work 
Team field (Overview tab) to the Web views.

Building Work Team Queries
You can query for issues assigned to a specific 
work team, for example, all issues assigned to the 
QA Team:

Assigned Work Team = QA Team

You can also use the <My Work Team> macro to 
query for issues assigned to the work team of the 
current user. For example, this query finds all open 
issues assigned to the user’s work team:

Assigned Work Team = <My Work Team> AND
State = Open

Organizing Users by 
Projects

Defining User Categories
You can control which users and contacts are 
visible in a project. Each user (and each contact) 
can be assigned to a user category. For example, 
some users can be assigned to the Internal 
Development category, and others to the External 
Development category.

The list of available user categories is a global 
choice list, so you can use HelpDesk Web Admin 
to build the list of user categories you want to use.

To edit the list of user categories:

1 In HelpDesk Web Admin, click the Choices tab.

2 In the Project list, click < Global Choice Lists >.

3 In the Choice List list, click User Category.

4 In the Choices section:

• To add a new user category, click  and 
then type the category name.

• To rename a user category, click the 
category and then click  .

• To delete a user category, click the category 
and then click  .

Assigning Users to Categories
Assigning users and contacts to categories allows 
you to control which users and contacts are visible 
in a project.

To assign users and contacts to categories:

1 In HelpDesk Web Admin, click the Security tab.
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If you are in HelpDesk Admin, click Tools > 
Security > Users.

2 In the Project list, click a project.

3 In the Display list:

• To display all users, click All Users.

• To display all contacts, click All Contacts.

• To display all users and contacts whose 
names start with the same letters, click 
Names starting with and then type the first 
few letters of the name.

• To display all users and contacts whose 
names contain the same string, click Names 
containing and then type the string.

4 In the list of users, click a user or contact and 

then click Edit .

5 In the User Category list, click the category to 
which the user belongs.

Hiding Users in Projects

To control which users and contacts are visible 
in a project:

1 In HelpDesk Web Admin, click the Security tab.

2 In the Project list, click a project.

3 Click . 

4 In the Advanced dialog box, select the In this 
project, … check box, and then select the 
categories of users and contacts you want to be 
visible in the project.

Disabling User Accounts
Users are not deleted, only disabled.

Disabled user accounts cannot log on, however 
the user names still appear in the Owner and 
Contact lists. That’s because existing issues may 
still refer to the users.

Disabling a contact has no effect.

To disable a user account:

1 In HelpDesk Web Admin, click the Security tab.

If you are in HelpDesk Admin, click Tools > 
Security > Users.

2 In the Project list, click a project.

3 In the Display list, click Users.

4 Select the Disabled check box beside the name 
of the user you want to disable.

Editing User Information
You can edit user information (for both users and 
contacts) with HelpDesk Web Admin.

To edit user information:

1 In HelpDesk Web Admin, click the Security tab.

If you are in HelpDesk Admin, click Tools > 
Security > Users.

2 In the Project list, click a project.

Users are not specific to a project, but each 
project can have its own user information fields. 
For example, one project may have a 
Department field while other projects do not.

3 In the Display list, click Users (or Contacts).

To quickly find a user: in the Display list, click 
Names starting with and then type the first few 
letters of the user’s name. Or click Names 
containing and then type a few letters from 
anywhere in the user’s name.
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To display all users, click All Users.

4 In the list of users, click the user and then click 

Edit .

Changing Passwords
You can change passwords, but only for Enterprise 
HelpDesk user accounts, not for user accounts 
imported from Active Directory or Windows.

To change a user’s password:

1 In HelpDesk Web Admin, click the Security tab.

If you are in HelpDesk Admin, click Tools > 
Security > Users.

2 In the list of users, click the user and then click 

Edit Logon .

To quickly find a user: in the Display list, click 
Users starting with and then type the first few 
letters of the user’s name.

3 In the Change Logon Information dialog box, 
type a new password.

Changing the 
Authentication Method
1 In the Authenticate With list:

• Click HelpDesk to authenticate against the 
Enterprise HelpDesk user database.

• Click an Active Directory server to 
authenticate against Active Directory.

• Click a Windows server to authenticate 
against a Windows domain.

2 If you authenticate with HelpDesk, you may 
need to enter the logon name and password.

Defining User Groups
Groups allow you to assign privileges to users. By 
enabling and disabling features for a group, you 
control the features (privileges) available to the 
members of that group.

Group membership determines which Enterprise 
HelpDesk features are available to a user. Each 
group enables and disables different features. 
Users that belong to more than one group have 
access to any feature enabled in at least one of the 
groups.

Group membership also controls access to 
projects and Web views. You use HelpDesk Admin 
to assign users to groups.

In the Users view of the Security tab, you can 
select a user and then edit the list of groups to 
which the user belongs. In the Groups view, you 
can select a group and edit the list of users that 
belong to the group.

To add a group:

1 In HelpDesk Web Admin, click the Security tab. 

If you are in HelpDesk Admin, click Tools > 
Security > Groups.

2 On the Security tab, click the large Groups 
button on the left side of the tab.

3 Click Add  and type a new for the group.

To delete a group:

1 In HelpDesk Web Admin, click the Security tab. 

If you are in HelpDesk Admin, click Tools > 
Security > Groups.

2 On the Security tab, click the large Groups 
button on the left side of the tab.
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3 In the Groups list, click the group you want to 
delete.

4 Click Delete .

Groups: Adding and 
Removing Users
On the Security tab, the Groups view allows you to 
add or remove multiple users at the same time. 

To add users to a group:

1 In HelpDesk Web Admin, click the Security tab. 

If you are in HelpDesk Admin, click Tools > 
Security > Groups.

2 On the Security tab, click the large Groups 
button on the left side of the tab.

3 In the Groups list, click a group.

4 Click Users 

5 If you want to add users:

a. In the Non-Members list, click the users you 
want to add to the group. Use the Shift and 
Ctrl keys to select more than one user.

b. Click .

6 If you want to remove users:

a. In the Members list, click the users you 
want to remove from the group. Use the 
Shift and Ctrl keys to select more than one 
user.

b. Click .

Users: Changing Group 
Membership
To add a user to a group (in the Users view):

1 In HelpDesk Web Admin, click the Security tab. 
By default, the Security tab shows the Users 
view.

2 In the Project list, click a project.

3 In the Display list, click All Users.

To quickly find a user: in the Display list, click 
Names starting with and then type the first few 
letters of the user’s name. Or click Names 
containing and then type a few letters from 
anywhere in the user’s name.

To display all users, click All Users.

4 In the list of users, click the user and then click 
Groups .

5 In the Select Groups dialog box, select the 
check boxes for the groups to which you want 
to add the user.

To filter the list of groups, click Advanced  
and type part of a group name (for example, 
“Census”). Then click Filter to list only the 
groups that contain the text you typed.

To find all groups with names that start with a 
certain string of characters, click Options and in 
the Search Type list, click Starting With.

Companies
Enterprise HelpDesk maintains a list of 
companies. By assigning users to companies, you 
can create a service level agreement that applies 
to all users at a specific company.
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To create a company:

1 In HelpDesk Web Admin, click the Security tab. 
By default, the Security tab shows the Users 
view.

2 In the Project list, click a project.

3 In the Display list, click All Companies.

4 Click Add Company .

5 Fill in the company information and click Apply.

Departments
By assigning users to departments, you can create 
a service level agreement that applies to all users 
in a specific department.

To edit the list of departments:

1 In HelpDesk Web Admin, click the Choices tab.

2 In the Project list, click a project.

Each project has its own list of departments.

3 In the Choice List list, click Department.

4 Edit the departments:

• Click  to create a new department.

• To delete a department, click the service 
type and then click .

• To rename a department, click the service 
type and then click .

• To reorder the list, click a department and 
then use  and  to move it.

Enabling and Disabling 
Features

About Features
Enterprise HelpDesk provides the following set of 
features that can be enabled and disabled. Most 
features correspond directly to menu commands, 
such as Security or Report Editor. When a user 
does not have permission to use a feature, the 
feature is hidden in the Enterprise HelpDesk user 
interface.

To enable or disable a feature for a group:

1 In HelpDesk Web Admin, click the Security tab. 

If you are in HelpDesk Admin, click Tools > 
Security > Groups.

2 On the Security tab, click the large Groups 
button on the left side of the tab.

3 In the Groups list, click a group.

4 Click Features 

5 If you want to enable a feature:

a. In the Disabled list, click the feature you 
want to disable. Use the Shift and Ctrl keys 
to select more than one feature.

b. Click .

6 If you want to disable a feature:

a. In the Enabled list, click the features you 
want to disable. Use the Shift and Ctrl keys 
to select more than one feature.

b. Click .
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Web View Features

Example The staff responsible for logging issues 
received from customers need to be able to add 
new contacts (each customer is a contact). To 
allow users to add new contacts in Web views, 
enable these features:

• Contacts

• Contacts - Add

HelpDesk Web Admin Features

The following features enable and disable the 
different tabs in HelpDesk Web Admin.

When Web Admin - Security is enabled, you can 
selectively enable features for editing user 
accounts.s

Feature Permits the user to

Ad hoc Queries Access the Ad-hoc Query Edi-
tor. 

Contacts Open the Users and Contacts 
dialog box in a Web view by 
clicking the Contacts button.

Contacts - Add Create contacts.

Contacts - Disable Disable contacts.

Contacts - Update Edit contacts.

Default Value Editor Set default values for new 
issues

Password Editor Change password.

Report Viewer View Enterprise HelpDesk 
reports.

Report Viewer - Hard-
ware Inventory

View Hardware Inventory 
reports.

Report Viewer - Soft-
ware Inventory

View Software Inventory 
reports.

Revision History View the change history for an 
issue.

My Queries Access the My Queries tab in 
the Queries dialog box.

Queries - View 
Source

View the definition of a query.

Save & Remove User 
Queries

Save queries, and remove 
queries from the My Queries 
list.

Feature Permits the user to

Web Admin - 
Choices

Create and edit choices lists.

Web Admin - Inte-
gration Editor

Connect projects to PC-Duo 
Enterprise site databases.

Web Admin - Notifi-
cations

Set the user account used for 
notifications.

Web Admin - Relo-
cation

Relocate databases and 
attachments.

Web Admin - Tabs Create new tabs.

Web Admin - Secu-
rity

Edit users, contacts, and 
groups. Add, edit, and delete 
groups. Enable and disable 
features for groups.

Web Admin - Work-
flow

Edit workflow rules.

Feature Permits the user to

Users - View View user information (such as 
the logon name, full name, and 
password) in the Users and 
Contacts window.

Users - Add Add new users.

Users - Disable Disable users.

Users - Update Edit user information.
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When Web Admin - Security is enabled, you can 
selectively enable features for editing contact 
information.

HelpDesk Admin Features
To enable HelpDesk Admin features, you must 
enable Admin Utility. Otherwise, users cannot 
even log on.

Example If you want to allow users to create new 
reports, you need to enable, at a minimum, the 
Admin Utility and Report Editor features. This will 
allow users to log on to HelpDesk Admin and 
create new reports using existing queries, sorts, 
and report pages. The new reports will be 
automatically made available in existing Web 
views.

Feature Permits the user to

Add Contact Editor View contact information (such 
as the full name and e-mail 
address) in the Users and Con-
tacts window.

Add Contact Create contacts.

Delete Contact Disable contacts.

Update Contact Edit contact information.

Feature Permits the user to

Admin Utility Log on to HelpDesk Admin.

Delete Project Delete a project.

Delete Issues Delete issues from a project.

Import Issues Import issues into a project.

Integrity Editor Open the Integrity Editor.

Layout Editor Open the Layout Editor and 
define custom layout styles for 
the Summary List. 

Licenses Open the Licenses dialog box.

Logons Editor Log off users. 

New Project Create a new project.

Notification Editor Set up automatic e-mail notifi-
cations.

Password Editor Change password, in Web 
views and in HelpDesk Admin.

Page Editor Create and edit report pages.

Project Properties Edit project properties, such as 
which groups are allowed to 
open a project. 

Query Editor Open the Query Editor and 
define custom queries. 

Repair and Com-
pact

Repair and compact a project 
database. 

Report Editor Define new reports, and edit 
existing reports.

Sort Editor Open the Sort Editor and define 
custom sorts.

Field Editor Add new fields. Change labels. 
Modify the values that appear 
in choice lists.

Upgrade Editor Upgrade Enterprise HelpDesk 
server files.

Web Tools Menu Start the Web View Editor and 
HelpDesk Web Admin from the 
Tools > Web menu.

When Editor Edit the when conditions for 
notifications.

Windows Account 
Editor

Edit the Windows user account 
used for anonymous access to 
virtual directories and for run-
ning the notification service.

Feature Permits the user to
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Enabling the Query Editor, Sort Editor, and Page 
Editor features will allow users to create new 
queries, sorts, and report pages and use them in 
report definitions. New queries won’t be available 
in Web views unless you export the queries and 
regenerate the views. All new sorts, however, will 
automatically be made available in Web views.

Web View Editor Features
You can prevent users from logging on to the Web 
View Editor by disabling the Web View Editor 
feature.

Enabling and Disabling 
Projects
When you disable a project for a group, members 
of that group cannot:

• Log on to Web views of the project.
• Edit the project in HelpDesk Admin.
• Edit views of that project in Web View Editor, or 

generate new views of that project.

You can disable specific Web views for members of 
a group. See “Setting Group Access Permissions” 
on page 87.

To enable or disable a project for a group:

1 In HelpDesk Web Admin, click the Security tab. 
Then click the large Groups button on the left 
side of the tab.

2 In the Groups list, click a group.

3 Click Projects 

4 If you want to enable a project:

a. In the Disabled list, click the projects you 
want to disable. Use the Shift and Ctrl keys 
to select more than one project.

b. Click .
5 If you want to disable a project:

a. In the Enabled list, click the projects you 
want to disable. Use the Shift and Ctrl keys 
to select more than one project.

b. Click .

You can also enable or disable projects from the 
Groups Allowed to Open list in the Project 
Properties dialog box. 
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Chapter 8: Defining Workflow Rules

About Workflow Rules
Workflow rules allow you to define and enforce an 
issue handling process. Together with e-mail 
notifications, workflow rules help you automate the 
tracking and management of issues.

What Can You Do with 
Workflow Rules?

Overview
When a user selects a choice from a choice list, 
you can:

• Select choices in other choice lists.

• Change the possible choices in other choice 
lists.

These are the basics of workflow rules. However, 
this explanation leaves out some important details.

By default, rules are applied when a user creates, 
saves, or loads an issue. If necessary, you can 
force rules to be evaluated when a user selects a 
choice.

Workflow rules can also be based on more 
complicated conditions. For example, a rule may 
require that certain choices are selected from a 
number of different choice lists, or that the user is 
a member of a specific group, or both.

A few examples will help you understand what you 
can do with workflow rules.

Automate Workflow

By controlling the possible values of the Progress 
field, you can define and enforce a process.

Simple workflow controlled by Progress values

Example 1:

After an analyst starts work on an issue and marks 
it In Progress, you can enforce a process where 
only the analyst can mark the issue as Dropped, 
Resolved, or To be Verified.

When:
<User in Group> = Help Desk Analyst AND
Progress = In Progress
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The possible values are: 
Progress = Dropped
Progress = Resolved
Progress = To be Verified

Note that Progress = In Progress is an implied 
possible value. A choice list can always be set 
back to its current value. For example, if a user is 
not a help desk analyst and an issue is marked In 
Progress, the Progress list contains only one 
choice: In Progress.

This rule is an example of a possible values rule.

Example 2:

You can prevent anyone except a group leader 
from assigning new issues.

When:
<User in Group> = Help Desk Group Leader AND
Progress = New

The possible values are: 
Progress = Assigned

This prevents new issues from being resolved or 
dropped without first being assigned to an analyst 
by the group leader. If a user is not a group leader, 
the only possible choice will be New.

Create Related Choice Lists
You can define rules to create a relationship 
between two choice lists. 

Example:

Suppose that Problem Type can be either 
Hardware, Software, or System. Problem Area can 
then be a type-specific list that displays either a list 
of hardware components, software applications, or 
system components.

When:
Problem Type = Hardware

The possible values are: 
Problem Area = Disk
Problem Area = Monitor
Problem Area = Keyboard
Problem Area = Memory

You need similar rules for software and system 
problems.

By default, workflow rules are evaluated when an 
issue is saved. For related choice lists like the 
ones in this example, you probably want to 
evaluate the rule whenever the Problem Type 
changes. Otherwise, users would have to select a 
Problem Type, save the issue, and then select the 
Problem Area.

Set Field Values
Instead of setting the possible values of a choice 
list, you can define rules that select choices from 
other lists. These type of rules are called a 
dependent values rules, because they make the 
value of one field depend on the value of another 
field.

Example:

This rule that assigns a default owner based on 
the Problem Area.

When:
Owner = <None> AND
Problem Area = SW - Outlook

The values to set are: 
Owner = Erick Yanez

This rule assigns a default owner for new issues, 
but allows the issue to be reassigned later. Without 
the <New Issue> = yes part, you could never 
change the owner of the issue.
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What You Should Know 
about Workflow Rules

Rules work with single-choice list fields You 
cannot define rules that apply to any other type of 
field, including multiple-choice list fields.

Rules are defined per project All Web views of 
a project share the same workflow rules. You 
cannot disable the workflow rules for specific Web 
views. The rules are either enabled for all views or 
disabled for all views.

Rules can impact performance Defining a large 
number of rules may impact the performance of 
Web views.

Using workflow rules to set default values is a 
good choice if you have a small number of rules 
and are not limited by resources (server, network, 
end-user computers). 

Rules are evaluated when issues are loaded 
and created By default, workflow rules are 
evaluated when an issue is loaded or created 
(note that when you save an issue it is immediately 
re-loaded, triggering the workflow rules). You can 
force rules to be evaluated when a user changes 
the value of one of the fields specified in the 
condition. Evaluating rules on field changes has a 
potentially higher performance cost. However, if 
you want to implement dependent fields, you 
should evaluate the workflow rule on field 
changes.

Changes to choice lists can break workflow 
rules If you remove choices from a choice list, or 
change the meaning of a choice, rules that use the 
choice list may stop working or result in 
unexpected behavior.

By default, rules apply to all users To build 
group-specific rules, use the macro <User in 
Group> in your conditions.

The order of rules is important Rules are 
evaluated in the order they are listed in the 
Workflow Editor. For example, in the default 
workflow, the rule Admins-<Any> is the first rule in 
the list. This ensures that any member of the 
Admin group can make any change to the 
Progress field.

If the Admins-<Any> rule was last, then a help 
desk analyst who is also a member of Admins 
does not have full administrator permissions for 
changing the Progress field. The stricter HelpDesk 
Analyst rules would be evaluated first, limiting the 
changes the analyst can make.

What is a Workflow Rule?
A workflow rule has this simple format:

if ( condition ) then
action

The condition can test:

• If a user belongs to a specific group

• If a specific choice was selected from a choice 
list.

Multiple conditions can be joined with a logical 
AND. The only test operator available is the equal 
to operator (=).
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If the rule is a possible values rule, the action can 
specify the possible values for one or more choice 
lists. If the rule is a dependent values rule, the 
action can select choices from one or more choice 
lists.

Creating Rule Templates
Before you can define any rules, you must create a 
template. Templates define the fields used in rules, 
and rules provide the values. For example, a 
template might look like this:

When:
<User in Group> = _ _ _ _ AND
Progress = _ _ _ _ 

The possible values are: 
Progress = _ _ _ _ 

A template defines what the rules look like, while a 
rule fills in the _ _ _ _ parts with specific values.

To create a rule template:

1 Log on to HelpDesk Web Admin. Click the 
Workflow tab. In the Project list, click a project.

Workflow rules based on this template will 
apply to all Web views of this project.

2 Click Template and click Add.

3 In the Add New Template dialog box:

• In the Template Name box, type a name for 
the template. 

• In the Template Description box, type a short 
description of the template. 

• Select the type of rules you want to define.

A Dependent Values rule makes the value of 
one field depend on the value of another 
field. For example, if How Found = Reported 
by Customer then Priority = Highest.

A Possible Values rule makes the possible 
values of one field depend on the value of 
another field. For example, if Type = Doc 
Defect then the possible values for 
Functional Area = Help, Readme, or Manual.

4 Click OK. 

5 In the list of templates and rules, click the new 
template.

6 Under Conditions, click . Then click the Field 
box three times and click a field whose value 
you want to test. Repeat for each additional 
field you want to test.

Conditions determine when a rule is applied. If 
all the field tests evaluate to True, then the rule 
will be applied.

Note that the Field list contains single-choice 
fields only.

7 If you created a dependent-values template, 

then under Dependent Values, click . Then 
click the Field box three times and click the field 
whose value you want to set. Repeat for each 
additional field whose value you want to set.

If you created a possible-values template, then 
under Possible Values, click . Then click the 
Field box three times and click the field whose 
possible values you want to specify. Repeat for 
each additional field whose possible values you 
want to specify.

Note that the Field list contains single-choice 
fields only.
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A Workflow rules are defined on a project-by-project 
basis. All Web views of a project share the same workflow 
rules.

B A rule template specifies the fields used in each 
instance of the rule. Click a rule template to see and edit 
the list of fields that can be used in the rule instances.  
means that the rule template is incomplete (for example, 
no fields listed on the Conditions tab).

Note that while you edit a rule template, you cannot edit 
the values. You can only add and remove fields.

C You can use  and  to change the order of the 
templates. The rules in the first (top) template are 
evaluated first, the rules in the second template are 
evaluted next, and so on. 

Within a template, the rules are evaluated in the order 
listed (from top to bottom). The order of the rules is fixed, 
and corresponds to the order in which they are created.

D Conditions specifies the fields that are tested to 
determine if an rule is applied. The <User in Group> 
condition allows you to define different rules for different 
groups of users. 

E Possible Values specifies which fields can be modified 
by the rules. In this example, the DefaultWorkflow rules 
can change the list of possible choices in the Progress list. 

 adds a field 

 removes a field

E
D

A

B

C
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Editing Rules

A Click a rule instance to see and edit the values.  
means that the values are filled in for the rule.

Note that while you edit rules, you cannot add or remove 
fields. You can edit only the values.

B After you edit a rule, add a new rule, or remove a rule, 
you must apply your changes. Otherwise your changes 
are saved, but not applied to the Web views of the project.

C Conditions specifies the conditions that are evaluated. 
In this example, the rule applies only if the current user is 
a member of the Employees group and the Progress is To 
be Verified.

D  The Possible Values list specifies the possible choices 
for the fields. A Dependent Values list looks much the 
same, but you can select only one value.

A
B

D

C
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Defining Conditions based on User 
Groups
By default, a rule applies to all users. To build 
group-specific rules, use the macro <User in 
Group> in your conditions.

If a user belongs to a group for which there is no 
rule, then for possible values, the fields displays all 
possible values.

Rules that apply to the Users group apply to all users, 
because all users are members of the Users group. Rules 
for specific groups can override the base rule defined for 
the Users group.

Defining Conditions for New Issues
To define rules that apply only to new issues, use 
the macro <New Issue> in the condition. <New 
Issue> is equal to Yes only for issues that have 
never been saved.

Defining Rules
Defining a rule involves filling in the template with 
specific values.

Note that while you edit rules, you can edit the 
values, but you cannot add or remove fields. To 
add or remove fields you must edit the rule 
template.

To define a rule:

1 Log on to HelpDesk Web Admin. Click the 
Workflow tab.

2 In the Project list, click a project. Then click a 
rule template.

3 Click Rule and then click Add.

4 Under Conditions, specify the values to test. 
For each field, click the Value box three times 
and then click the field value you want to test 
for.

5 If you are defining a dependent-values rule, 
then under Dependent Values, for each field, 
click the value you want to set. To use the value 
of another field, double-click the <Values of 
Field???> macro.

If you are defining a possible-values rule, then 
under Possible Values, for each field, select the 
check boxes for each possible value.

6 Click Apply to apply the rule to the Web views 
of the project.

You can also copy a rule and edit it. To copy a rule, click 
the rule. Then click Rule, click Copy, and type a name for 
the new rule.

Deleting Rules

To delete a rule:

1 In the list, click a rule.

2 Click Rule and then click Remove.

3 Click Apply to apply the changes to the Web 
views of the project.
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Renaming Rules
To rename a rule:

1 In the list, click a rule.

2 Click Rule and then click Rename.

3 Type the new name for the rule.

To change the default names for new rules:

1 In the list, click a rule template. Click Template 
and then click Properties. 

2 In the Name rules according to box, type the 
new default name for rules.

By default, rule names are based on the 
condition values (the values entered in the 
Value column). The string %Value0% repre-
sents the value in the first row of the condition, 
%Value1% represents the value in the second 
row, and so on.

If you use a text string (such as "WorkflowRule") 
as the default rule name, rule names are formed 
by appending a number to the string.

Using Macros in Rules

<Any> Use the <Any> macro in conditions to 
define a rule that applies to any value of a field, 
including <Empty>. For example, in the default 
workflow, the Admins-<Any> rule allows members 
of the Admins group to set any value in the 
Progress field.

<Empty> Use the <Empty> macro in conditions to 
define a rule that applies when a field is empty.

<User> <User> represents the current user (the 
user currently logged on to the Web view). You can 
use <User> in conditions, as a possible value, and 
as a dependent value.

<New Issue> is Yes for issues that 

<Value of Field???> This macro allows you to 
define a Dependent Values rule that assigns the 
value of a field to another field. For example, when 
an issue is fixed, a workflow rule could set the 
vaue of the Fixed By field to <Value of Owner>.

When you add a dependent values rule, you’ll see 
the <Value of Field???> macro in the Values 
column of the Dependent Values table. Double-
click <Value of Field???> and then select the field 
whose value you want to use.

If you want to use the Submitter field in the <Value 
of Field ???> macro, you’ll have to enable the 
Submitter field. By default, the Submitter field is 
not enabled (to enable the field, use the Field 
Editor in HelpDesk Admin).

Setting Possible Values
When you set the possible values of a field, you 
don't have to include the current value of the field 
in the list of possible values. For example, given 
this rule: 

When:
<User in Group> = Employees AND
Progress = Waiting

The possible values are: 
Progress = Dropped
Progress = In Progress
Progress = Resolved

then when Progress is set to Waiting, the Progress 
list will contain Dropped, In Progress, Resolved, 
and Waiting.
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Changing When Rules Are 
Evaluated
By default, workflow rules are evaluated when an 
issue is loaded and when issues are created.

However, you can force rules to be evaluated 
when a user changes the value of one of the fields 
specified in the condition. Keep in mind that 
evaluating rules on field changes can have a 
potentially higher performance cost.

To evaluate rules on field changes:

1 In the list, click a template.

2 Click Template and then click Properties.

3 Select the Evaluate rules when users change 
field values check box.

4 In the Template Properties dialog box, click OK.

5 Click Apply to apply the change to the Web 
views of the project.

Changing the Order of 
Evaluation
Rules are evaluated in the order they are listed in 
the Workflow Editor. You cannot change the order 
of rules in a template (except by creating them in 
the desired order), but you can change the order of 
the rule templates.

To change the order of evaluation of rule 
templates:

1 In the Templates list, click a template.

2 Click  or  to move the template up or down 
in the list.

3 Click Apply to apply the change to the Web 
views of the project.

Applying Workflow Rules
When you edit a rule, define a new rule, define a 
new group of rules, or change the group options, 
you must apply these changes.

To apply workflow rules:

1 In the list, click a template.

2 Click Apply.

Apply automatically enables the group of rules. If 
you just enable the rules, but don’t apply them, 
nothing happens.

Web view users must log out and then log back on before 
the changes take effect.

Disabling Workflow Rules
You can disable all the rules based on a given 
template.

To disable workflow rules:

1 In the list, click a template.

2 Click Template and then click Properties.

3 Clear the Enable in all Web views of the project 
check box, and click OK in the message box 
that appears.

4 In the Template Properties dialog box, click OK.

5 Click Apply to apply the change to the Web 
views of the project.
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Chapter 9: Defining Service Level 
Agreements

About Service Level 
Agreements
A service agreement is an agreement between the 
help desk and users. The service agreement 
defines a required level of service for the users.

A service agreements can be with individual users 
(contacts), with all users in a department, or all 
users in a company.

A service level is a guarantee of a certain level of 
service. For example, a basic service level may 
provide 9-to-5 service during the regular working 
week, while a more comprehensive service level 
might provide 24 hour service, 7 days a week.

Each service level has its own hours of service, 
target response and closure times for issues, and 
escalation rules.

A Web view used by help desk analysts has an 
SLA tab. This tab contains information about the 
service level agreement that applies to the issue.

For example, when employee submits new issue, 
the Escalation State is automatically set to On, and 
the Problem Area is set based on the Service Type 
selected by the employee. Based on the service 
type, priority, and the employee’s contact 
information (name, department, and company), 
Enterprise HelpDesk sets the Target Initial 
Response Time, Target Closing Time and 
Associated SLA fields. 

Setting Up Service 
Agreements
1 Define companies and departments, so you can 

quickly create service level agreements with 
groups of users. When you create an 
agreement, it can be either with a specific user 
or with all users in a department or in a 
company.

2 Define the escalation levels.

3 Define the service types.

4 Define service levels. Each service level is 
defined by the following:

• Target times

• Escalation Rules

• Operational Hours

5 Define service agreements.

6 [Optional] Define workflow rules. Enterprise 
HelpDesk includes default workflow rules for 
the Service Type and Escalation State fields in 
Web views.

Target Times
A service level defines target response and 
closure (resolution) times for each possible priority 
value. 
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Target Initial Response Time The time it takes to 
initially respond to a new issue. When a help desk 
analyst responds to an issue, the analyst has to 
enter the response date and time on the SLA tab 
of the Web view.

Target Closure Time The time it takes to resolve 
the issue, either by fixing the problem or providing 
an acceptable workaround. When an issue is 
resolved, Enterprise HelpDesk automatically 
enters the date and time into the issue.

When you create a service level, the level gets the 
default target times. 

To edit the target times:

1 In the Service Level list, click a service level.

2 On the Target Times tab, click a row (for 
example, to edit the target times for the Highest 
priority, click that row).

3 Click Edit.

4 In the Edit Target Times dialog box, type the 
target times in the Initial Response Time and 
Closure Time boxes.

The target times must be integer values such 
as 2, 7, or 10. You cannot type values like 2.5.

You can change the time units between 
minutes, hours, and days. For example, to 
change from hours to minutes, click hour(s) and 
then click minute(s) in the pop-up list.

Escalation Levels
By default, each Service Level has five escalation 
levels. Typically, time-based escalation rules are 
used to define a sequence of escalation levels.

For example, when a new issue is first submitted 
to the help desk, the issue is at the “Level 1” 
escalation level. If the help desk does not respond 
to the issue within the target initial response time, 
then the issue is escalated to “Level 2”. As more 
time goes by without either a response or a 
resolution, the escalation level of the issue will be 
raised, until it reaches the highest escalation level, 
“Level 5”.

Escalation levels allow the help desk to better 
identify, query, report, and monitor priorities and 
urgent issues.

Note Escalation rules and SLA are enforced only 
for issues where the Escalation State is set to On. 
Escalation State is a field on the SLA tab of a Web 
view. By default, escalation is on, but help desk 
analysts can pause or disable escalation.

Defining Escalation Levels
By default, Enterprise HelpDesk defines five 
escalation levels, with “Level 1” being the lowest-
priority level, and “Level 5” being the highest 
priority.

You can edit the escalation levels for a project on 
the Choices tab of HelpDesk Web Admin. For 
example, you can:

• Change the names of the escalation levels.

• Change the colors of the escalation levels (in 
Web views, the Summary List displays different 
colors for different escalation levels).

To edit the escalation levels:

1 In HelpDesk Web Admin, click the Choices tab.

2 In the Project list, click a project.

3 In the Choice List list, click Escalation Level.

4 Edit the escalation levels:
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• To edit an escalation level, click the 
escalation level and then click . 

• Click  to create a new escalation level.

• To delete an escalation level, click the 
escalation level and then click .

• To reorder the list, click an escalation level 
and then use  and  to move it.

Defining Escalation Rules

About Escalation Rules
Escalation rules are responsible for changing the 
escalation level of an issue. Each service level has 
its own escalation rules.

An escalation rule consists of conditions and 
actions. If all the conditions are true, then all the 
actions are executed.

To define an escalation rule:

1 In HelpDesk Web Admin, click the SLA tab.

2 In the Project list, click a project.

3 Click Service Levels.

4 Click the Escalation Rules tab.

5 Click Add, or click an existing rule and then 
click Copy.

6 In the Escalation Rule Name box, type a name 
for the rule.

7 Define the condition that triggers the rule.

8 Define an action that changes the escalation 
level when the condition is met.

9 Click the check box to enable the condition.

Order of Evaluation
Escalation rules are evaluated in the order they 
are listed on the Evaluation Rules tab. The first 
(top) rule is evaluated first, then the next rule 
below it, and so on.

You can change the order of evaluation by using 
the Up and Down buttons.

Conditions
You can define multiple conditions. When you 
have multiple conditions, then all conditions must 
be satisfied before the corresponding actions are 
executed. Conditions are evaluated as if there was 
a logical AND between each condition.

Note that you must select the check box beside a 
condition; otherwise the condition is disabled.

Target Time conditions You can define 
conditions based on the target response and 
closure times. For example, an escalation rule can 
escalate an issue if the issue has not been 
assigned to a help desk analyst within the 
guaranteed response time for that service level.

Or an escalation rule can send an e-mail reminder 
when an issue has not been resolved within the 
guaranteed response time.

<Field> = <Value> For convenience, the Add 
Escalation Rule editor allows you to easily add 
conditions that test the values of up to five choice 
list fields.

Meets the query <Value> For more complex 
conditions, you can use queries built with the 
Query Editor in HelpDesk Admin. Queries can use 
any number and type of field to determine whether 
to escalate an issue.
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Actions
Escalation rules can perform the following actions:

• Change the issue priority, owner, assigned 
work team, or escalation level.

• Send an e-mail message.

• Run a program.

Sending E-mail Messages
To send an e-mail message

1 Under Actions, click Send an e-mail.

2 In the E-mail Content Editor, fill in the To, 
Subject, and Body of the message. You can 
also attach files.

Editing the To, CC, and From Fields
You can either use the macros or you can specify 
users.

To insert a macro:

1 Click in the To, CC, or From box.

2 Under Available Macros, click the macro you 
want to insert.

The Contact is the person who reported the 
issue, while Submitter is the person who 
actually entered the issue into Enterprise 
HelpDesk. For example, if a help desk analyst 
takes a support call, the contact is the person 
who called, and the analyst is the submitter.

Previous Owner is useful when you send an e-
mail message because an issue is reassigned.

To add users to the To, CC, and From lists:

1 Beside the To, CC, or From box, click .

2 In the Select Users and Contacts dialog box, 
double-click the users and contacts you want to 
add.

The list of selected users and contacts is 
displayed under Selected Users and Contacts. 
You can edit this string of text, for example, to 
remove a user, or to add the e-mail address of 
a person who is not a user or contact.

Tips

• The text box beside the Find button allows you 
to display all users and contacts whose names 
start with the same letters. In the text box, type 
the first few letters of the name and then click 
Find. 

To display the complete list of users and 
contacts again, delete all text from the box and 
then click Find.

• Click Advanced if you want to search for all 
users and contacts whose names contain the 
same string, or if you want to search based on 
e-mail addresses (for example, all contacts with 
example.com e-mail addresses).

Editing E-mail Content
You can use macros to insert the issue number, 
the name of the project, and the values of different 
fields (such as the Summary and Description Log).

To insert the value of a field:

1 In either the Subject box or the Body box, click 
where you want to insert the field value.

2 Under Available Macros, click Field Value.

3 In the Field Value dialog box, click the field 
whose value you want to insert.
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If you want to insert the issue description, insert 
the Description Log field, not the Description 
field. 

To switch to HTML format:

• Select the HTML in Body check box.

Attaching Files

To attach files to an e-mail message:

1 Beside the Attachments box, click .

2 In the E-mail Content Attachments dialog box, 
click Browse and locate the file you want to 
attach. Then click Link.

This adds the file to the list of files linked to this 
e-mail message. Every time the e-mail 
message is sent, the linked files are attached to 
the message.

Running Programs
To run a program, type the location and name of 
the program in the Run Program box. You can 
include command-line arguments for the program.

The default working directory for programs is the 
Windows system folder (for example, 
C:\Windows\system32).

Note Programs must not have a user interface or 
require any user input. The programs are run 
silently by the Mq.Evaluator service. By default, 
the programs are run under the credentials of the 
same user who runs the Mq.Evaluator service 
(CensusUser by default). You can check this in the 
Services dialog (click Administrative Tools > 
Services, open the Properties for the service, and 
then go to the Log On tab).

Specifying Operational 
Hours
The operational hours define when the service 
level agreement is in effect. The service level clock 
stops running outside of those hours.

For example, if the hours of operation are from 9 to 
5, Monday to Friday, then a new issue submitted at 
4:59pm on Friday is not going to trigger any 
escalation rules during the weekend. If the service 
level specifies an initial response time of 30 
minutes, then the help desk has until about 
9:29am on Monday before any escalation rules are 
triggered.

Note also that help desk analysts can stop the 
clock for specific issues (by setting the Escalation 
State to Paused). For example, the analyst may 
“hit pause” while waiting for more information from 
the end user.

To set the operational hours

1 In HelpDesk Web Admin, click the SLA tab.

2 In the Project list, click a project.

3 Click Service Levels.

4 Click the Operational Hours tab.

5 In the Start Time and End Time boxes, enter the 
working hours during which the service level is 
in effect. Type the times in the format “9:00 AM” 
or “5pm”.

6 Enter the number of working hours in a day.

7 Add holidays and other exceptions to the 
standard working hours.

a. Click Add.

b. Click the day you want to add.

c. Click OK.



CHAPTER 972
Defining Service Level Agreements
Defining Service Levels
To define a service level:

1 In HelpDesk Web Admin, click the SLA tab.

2 Click Service Levels.

3 In the Project list, click a project.

4 Beside the Service Level box, click .

5 In the Add Service Level dialog box, type a 
name and a description for the service level.

Service Agreements

Creating Service Agreements
A service agreement is an agreement between the 
help desk and users. The service agreement 
defines a required level of service for the users.

A service agreements can be with individual users 
(contacts), with all users in a department, or all 
users in a company.

To create a service agreement:

1 In HelpDesk Web Admin, click the SLA tab.

2 In the project list, click a project.

Each project has its own service agreements.

3 Define a service type.

Each agreement is for a specific type of service 
(for example, Network, Software, or Hardware 
service).

4 In the Service Agreements section, click Add.

5 In the Add Service Agreement dialog box, fill in 
the required information.

• Agreement Name
The name used to identify the agreement.

• Agreement Description
Allows you add some notes or comments 
related to the agreement. Note that you can 
also attach documents to an agreement.

• Agreement is with a 
A service agreements can be with individual 
users (contacts), with all users in a 
department, or all users in a company.

• Agreement Customer
Depending on whether the agreement is 
with a contact, a department, or a company, 
this list includes all the possible users, 
departments, or companies.

• Reporting Period
Choose whether reports for this agreement 
are weekly, monthly, quarterly, semi-annual, 
or annual. The reports are available from the 
Service Agreements section of the SLA tab 
(click the Reports button).

Applying Service Agreements to Issues
You can apply a service agreement to the issues 
that are already in the project database. To do this, 
you use a query to specify the issues to which the 
service agreement is applied.

To apply a service agreement:

1 In HelpDesk Web Admin, click the SLA tab.

2 In the project list, click a project.

3 In the Service Agreements section, click a 
service agreement.

4 Click Apply.
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5 In the Apply Service Agreement dialog box, 
click a query. The agreement will be applied to 
the issues returned by that query.

Disabling Service Agreements

To disable a service agreement:

1 In HelpDesk Web Admin, click the SLA tab.

2 In the project list, click a project.

3 In the Service Agreements section, click a 
service agreement.

4 Click Edit.

5 In the Update Service Agreement dialog box, 
clear the Service Agreement is enabled check 
box and then click OK.

Service Level Reporting
Enterprise HelpDesk includes a set of service level 
reports to help you monitor and measure help desk 
performance against service level objectives, 

To view a service level report:

1 In HelpDesk Web Admin, click the SLA tab.

2 In the project list, click a project.

3 In the Service Agreements section, click 
Reports.

If the Reports button is disabled, click a service 
agreement.

4 In the Service Agreement Reports dialog box, 
click the report you want to view, and then click 
OK. 

You can also double-click a report to open it.

5 In the toolbar of the Crystal Reports viewer, 

click  to print the issue. Click  to save the 
report as PDF, Word, or Excel.

Service Types
A service type identifies a type of service delivered 
by the help desk to help desk customers. The 
Service Type (for example, software or hardware) 
is set when an issue is submitted.

Note Enterprise HelpDesk includes default 
workflow rules that set the Problem Area based on 
the Service Type.

To edit the list of service types:

1 In HelpDesk Web Admin, click the SLA tab.

2 In the Project list, click a project.

Each project has its own list of service types.

3 In the Choice List list, click SLA Service Types.

4 Edit the service types:

• Click  to create a new service type.

• To delete a service type, click the service 
type and then click .

• To rename a service type, click the service 
type and then click .

• To reorder the list, click a service type and 
then use  and  to move the service 
type.
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About Notifications
Enterprise HelpDesk can generate notifications (e-
mail messages) to inform team members of 
changes to the project database. Notification 
messages are sent via the native e-mail system.

Notifications keep team members up to date with 
changes to reported issues. They don't have to run 
queries, inspect issues, and review revision 
histories to find out about changes. Instead, they 
get e-mail messages whenever new issues are 
assigned to them, or whenever someone edits a 
issue already assigned to them.

You should try to keep the number of notifications 
to a minimum. Defining too many notifications for 
field updates can overwhelm users with e-mail, 
resulting in users missing important notifications. 
Use notifications for changes to fields like Owner, 
Progress, and Priority. 

What Can You Do With 
Notifications?

You can send notifications to specific users or 

contacts, or to the current owner, the previous 
owner, or the contact (the person who reported the 
issue). 

To trigger notifications, you use simple when 
conditions that test for changes to an issue.

Send a notification when an issue is 
reassigned When an issue is reassigned, you 
can use the <Owner> and <Previous Owner> to 
send notifications to both the new and the previous 
owner.

Send Notification To:
<Owner>;<Previous Owner>

When:
Owner Update

The when condition in this example tests for 
updates to the Owner field.

Send a notification when a field is updated

You can use the Update test to send a notification 
when a field is updated.

When:
Priority Update AND
Revision Number > 1

In this when condition, the Update test checks for 
changes to the Priority field.

Testing the Revision Number allows you to 
distinguish between new issues and existing 
issues that have had their priority changed. 
Without the Revision Number > 1 test, a "Priority 
Updated" notification would be generated every 
time someone set the Priority when they submitted 
a new issue.

Send a notification when a field is set to a 
certain value You can send a notification when 
the priority of an issue is changed to “ASAP”. To do 
this, you use a when condition that looks like this:

When:
Priority Update AND
Priority = ASAP
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This when condition sends a notification when 
Priority is changed to ASAP. Without the Update 
test, it would send a notification every time an 
issue with Priority = ASAP is saved.

Send a notification when a new issue is 
submitted Each issue has a revision number that 
is increases by one each time the issue is saved. 
When an issue is first submitted, this revision 
number is set to “1”, so you can test the revision 
number to find new issues.

When:
Revision Number = 1 AND
Submitted Date = <Today> AND
Priority = ASAP OR

Priority = Today

This when condition looks for new issues 
submitted today with priority of ASAP or Today.

Send a notification when certain users update 
an issue In the default workflow, employees can 
mark the issues they reported as Dropped or 
Resolved. When this happens, you can notify the 
owner of the issue.

Send Notification To:
<Owner>

When:
<User in Group> = Employees AND
Progress Update

The <User in Group> macro allows you to test for 
user group membership.

Send a notification when an issue is resolved
You can use the <Contact> macro to notify 
employees when the issues they submitted are 
resolved, dropped, or need to be verified by the 
employee. The contact for an issue is always the 
employee who reported the issue.

Send Notification To:
<Contact>

When:
Progress Update AND
( Progress = Resolved OR

Progress = Dropped OR
Progress = To be Verified )

However, if you want to send an e-mail with a 
different subject for each possible case (for 
example, “Issue resolved”, “Issue dropped”, and 
“Issue to verify”), you need to define three 
notifications, one for each Progress value.

Editing Notifications
HelpDesk Admin provides a Notification Editor for 
editing notifications. To open the editor, click 
Notification Editor on the Project menu. With the 
Notification Editor, you can:

• Specify who will receive the notification. Select 
the names of one or more Enterprise HelpDesk 
users from the Send Notification to list. 

• Define when you want Enterprise HelpDesk to 

send the notification. Click  beside the When 
list to define a when condition, which is like a 
query that retrieves updated issues. 

• Specify what you want to include in the notifi-
cation message. The body of a notification 
message can include information from the 
issue or the revision history. 
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• Describe why the notification was sent. Type a 
one-line description in the Notification 
Description box. You can include this 
description in the body of the e-mail message. 

Specifying Notification 
Recipients
While you can send notifications to specific 
Enterprise HelpDesk users and contacts, it’s 
typically more useful to send notifications to the 
users listed in the Owner and Contact fields of an 
issue. To do this, you use macros. For example, to 
send a notification to the owner of an issue, you 
click the <Owner> macro in the Send Notification 
To list.

<Owner> The user whose name is currently 
entered in the Owner field.

<Previous Owner> The user who owned the 
issue before it was reassigned. 

<Contact> The person whose name is currently 
entered in the Contact field.

Defining When Conditions

About When Conditions

When conditions determine when Enterprise 
HelpDesk sends notifications. A when condition is 
a test. If an issue satisfies the test, Enterprise 
HelpDesk sends a notification for that issue. You 
typically use when conditions to:

• Test for updates of a given field. For example, a 
when condition can generate a notification 
when issues are reassigned (by testing if the 
Owner field has been updated). 

• Test for updates by a specific user or by users 
in a specific group. For example, a when 
condition can generate a notification when 
anybody except a manager updates the 
Priority. 

To edit the when conditions for a notification, you 
use the When Editor. Like the Query Editor, the 
When Editor allows you to combine multiple 
conditions with parentheses and the And and Or 
operators.

To open the When Editor:

Click  beside the When field in the Notification 
Editor.

Sending Notifications of Field Updates
To send a notification when someone edits a field, 
use the Update test. 

To send Update notifications for a field, select the 
Maintain Revision History check box for that field 
(in the Field Editor).

Basing Notifications on Users
The Field Name list includes the macros <User> 
and <User in Group>. Use these macros together 
with = and <> to test who updated an issue. For 
example, the following condition sends a 
notification when any employee updates the 
Progress of an issue (in the default workflow, 
employees can mark issues as Resolved or 
Dropped).
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Notification Based on User Groups

Specifying Notification 
Contents
A notification message can include information 
about the event and issues that generated the 
notification. For example, if Enterprise HelpDesk 
generates a notification because a new high 
priority issue was submitted, the message can 
include a brief description such as "New high 
priority issue". 

Notifications generated because of changes to a 
field can include entries from the Revision History 
that show the changes. The notifications can also 
include either a summary or a complete copy of 
the issue.

To specify the contents, you select one or more of 
the following from the Include list:

• Notification Description is the text entered in the 
Notification Description box of the Notification 
Editor. 

• Detailed is a copy of the issue. 

• Revision Record is the entry from the Revision 
History for the change that generated the notifi-
cation.

• Summary is a brief summary of the issue. 

The Notification Description, Revision Record, and 
Summary are included as text in the message 
body. Detailed is included as a separate 
attachment.

To change the information included in the 
Summary section, edit the Notification - Summary 
report. For the Detailed attachment, edit the 
Notification - Detailed Record report.

By default, the Detailed attachment is an HTML 
file. If you use Crystal Reports for listing reports, 
the Detailed attachment is an RTF file. See 
“Viewing Reports” on page 35 for more information 
on using Crystal Reports for listing reports.

The subject of an e-mail notification message is 
automatically generated, and has this format:

Notification [<project>]: Record <issue number> 
<notification name>
For example:

Notification [HelpDesk]: Record 11 Progress Updated

Managing Workflow with 
Notifications
The Progress (status) of an issue indicates where 
the issue is in your issue tracking system. As the 
status of an issue changes from New to Assigned 
to In Progress to To Be Verified to Resolved, 
different team members become responsible for 
the issue.

For example, when the issue is assigned to a help 
desk analyst, you can use update notifications to 
help manage your help desk workflow. To do this, 
define a notification that is sent to <Owner> when 
the issue is assigned and the Progress field set to 
Assigned.
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When the help desk analyst marks the issue as In 
Progress, you can send a notification to the 
employee who submitted the issue. Similarly, 
when an employee updates an issue (for example, 
by adding more details to the description), you can 
have Enterprise HelpDesk notify the help desk 
analyst of the change. 

Setting Up Notifications
To set up notifications for HelpDesk Web, you use 
both:

• HelpDesk Web Admin, a web-based adminis-
tration utility.

• HelpDesk Admin, a Microsoft Windows-based 
administration tool.

To set up notifications:

1 Set up the notification service.

2 In HelpDesk Web Admin, specify the Enterprise 
HelpDesk user account used to send 
notifications. 

3 In HelpDesk Admin, set the Mail Server 
options. These options configure the mail 
server used to send notifications, and specify 
how often the notification services checks for 
new notifications to send.

4 Define the notifications you want to send.

Setting Up the Notification Service
Enterprise HelpDesk installs a Microsoft Windows 
service named Mq Issue Agent. This service runs 
on the server where you installed HelpDesk Web, 
and takes care of generating and sending e-mail 
notifications. 

During installation, you can specify whether you 
want the service to start automatically whenever 
the server boots or you want to start the service 
manually. 

To set up the notification service on 
Windows XP:

1 Click Start, point to Settings, and then click 
Control Panel. Double-click Administrative 
Tools, and then double-click Services to open 
Services.

2 In the right pane, right-click the Mq Issue Agent 
service, and then click Properties. 

3 On the Log On tab, select This account to 
choose a user account. Type the password for 
the account in Password, and then type it again 
in Confirm password. 

The user account must be a valid domain user 
account and have permissions through the 
network.

4 Click Apply.

5 On the General tab, stop and start the service.

To set up the notification service on 
Windows 2000:

1 Click Start, click Control Panel, click 
Performance and Maintenance, and then click 
Administrative Tools to open Services.

2 In the right pane, right-click the Mq Issue Agent 
service, and then click Properties. 

3 On the Log On tab, select This account to 
choose a user account. Type the password for 
the account in Password, and then type it again 
in Confirm password. 

The user account must be a valid domain user 
account and have permissions through the 
network.
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4 Click Apply.

5 On the General tab, stop and start the service.

To set up the notification service on 
Windows NT:

1 Click Start, point to Settings, and then click 
Services to open Services. 

2 Stop the Mq Issue Agent service.

3 Click Startup.

4 In the Service dialog box, select Startup 
Automatic if you want to start the service 
automatically every time the computer is 
restarted.

5 Select This Account and enter a valid domain 
user account and password that has 
permissions through the network.

6 Click OK.

7 Click Start to start the service.

Setting the Mail Server Options

To set the mail server options:

1 In HelpDesk Admin, click Options on the Tools 
menu.

2 Set the server mail options. These options are 
used when sending notifications.

3 If you use an SMTP mail system, test your 
settings by clicking Test.

Specifying the User Account Used to 
Send Notifications
By default, HelpDesk Web uses the issueagent 
user account (password = issuesvc) to log on to 
Enterprise HelpDesk and send notifications.

To set the user account:

1 In HelpDesk Web Admin, click the Notifications 
tab.

2 Type the user name and password, and click 
Apply.

After you change the user account, you must stop 
and restart the Mq Issue Agent service.Option Description

Server Mail 
System

1 = MAPI

2 = SMTP

4 = Lotus Notes

Server Mail 
Sender 

Name of sender for SMTP e-
mail. Some SMTP mail servers 
require the sender name to be 
a valid e-mail address. Note 
that this name does not appear 
in the From field.

Server MAPI 
Profile

Name of the MAPI Profile. If 
you have one profile only, you 
can leave this field blank. 

SMTP Server Name or IP address of your 
SMTP mail server.

You can test your settings by 
clicking Test.

Server Mail 
Interval

Specifies how often (in min-
utes) Enterprise HelpDesk 
generates notifications.

Option Description
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Handling Notification 
Failures
If Enterprise HelpDesk is unable to send a 
notification, it will continue to retry to send the 
notification. The maximum number of times will 
Enterprise HelpDesk retry controlled by the 
Maximum Notification Retries option, which by 
default is 100.

When the maximum number of retries is reached, 
the notification is sent to the e-mail address 
specified by the Send Invalid Notifications To 
option.

To set these options, click Tools > Options in 
HelpDesk Admin.
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Chapter 11: Generating Web Views

What is a Web View?
Web views are different views of an Enterprise 
HelpDesk project. Each Web view of a project can 
display different issues and different fields.

For example, employees don't need to see all the 
issues in the database, just the ones they 
reported. Also, they don't need to see internal 
notes and other information entered by the help 
desk staff. Help desk staff, on the other hand, need 
access to all the information in the issue database.

Editing Web Views

About the Web View Editor
You use the Web View Editor to create, edit, and 
generate Web views. To create Web views, you 
must run the Web View Editor on the Web server.

To start the Web View Editor from HelpDesk 
Admin:

• On the Tools menu, click Web, then click Web 
View Editor.

The Tools > Web > Web View Editor command 
is available only if Web View Editor is installed 
on the same computer where you are running 
HelpDesk Admin.

To start the Web View Editor from the Start 
menu:

Click Start, point to Programs, point to PC-Duo 
Enterprise, point to HelpDesk, and then click Web 
View Editor.
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WEB VIEWS Web views are different views of a project. Each Web view of a project can include a different set 
of queries and show a different set of fields.

A View toolbar. Allows users to generate reports, 
review the revision history of an issue, send e-mails, 
add contacts, change passwords, set defaults, set 
options, get help, and exit. Most of the buttons can 
be disabled by setting group permissions.

B Summary List toolbar. Allows users to select 
predefined queries, sorts, and layouts. Each Web 
view can export a different set of queries.

C Simple search form. The Advanced button 
displays the ad-hoc Query Editor, which allows 
users to build and save ad-hoc queries. Can be 
hidden by setting group permissions.

D Summary List. Displays all the issues that match 
the current query.

E Issue details. Each Web view can export a 
different set of fields.

C

A

B

D

E
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Creating Web Views
To create a new Web view, you must run the Web 
View Editor on the Web server. Web View Editors 
installed on other computers can only edit and 
regenerate existing Web views.

You can either create a new, blank Web view or 
you can copy an existing web view. Copying allows 
you to reuse all the settings in the existing Web 
view. For example, when you copy a Web view, all 
the field attribute settings are copied.

To create a new, blank Web view:

1 Run the Web View Editor on the Web server.

2 Click New View , type the name of the Web 
view, and click OK.

3 In the Project Name list, click a project.

4 In the View Type list, click the type of view you 
want to generate.

5 Set the group access permissions for the view. 
See “Setting Group Access Permissions” on 
page 87.

6 Set the Web view attributes. See “Setting Web 
View Attributes” on page 87.

7 Export fields to the Web view. See “Exporting 
Fields” on page 87.

8 Export queries to the Web view. See “Exporting 
Queries” on page 88.

9 Click  to save your settings and generate the 
Web view.

To log on to the Web view, click .

Click  to save your settings without generating 
the Web view.

Generating Web Views

To generate a Web view:

1 In the Project / View list, click a Web view. 

2 Click  to generate the Web view.

3 If you want to log off all users before generating 
the Web view, click Yes. If you click No, users 
logged on to the Web view will not see any 
changes until they exit and log on again.

4 Click Yes to overwrite the existing files.

5 After the Web view is generated, you can click 
 to log on to the Web view and test it.

Notes

• You can generate Web views without using the 
Web View Editor. On the Web server computer, 
click Start > All Programs > PC-Duo Enteprise > 
HelpDesk > HelpDesk Tools > Generate Web 
Views.

Copying Web Views
You can create a Web view based on an existing 
Web view. Note that if you copy a view and then 
change the project, all view settings are cleared.

To copy a Web view:

1 In the Project / View list, click a Web view. 

2 Click Copy .

3 Type a name for the new Web view. 

The Web View Editor creates a new Web view that 
is an exact copy of the selected Web view. 
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Deleting Web Views

To delete a Web view:

1 In the Project / View list, click a Web view. 

2 Click Delete .

Deleting a view deletes all the generated files and 
folders (used by that Web view) on your server.

Renaming Web Views

To rename a Web view:

1 In the Project / View list, click a Web view. 

2 Click Rename .

3 Type a new name for the Web view. 

Configuring Web Views

Types of Web Views
Normal views allow users to submit and update 
issues.

Read-only views allow users to review existing 
issues, but not to edit them. All fields are read-only, 
and users cannot create or submit new issues.

Knowledge Base views provide a simple search 
front-end to an Enterprise HelpDesk project. Users 
can either search the KB by keyword or type in a 
KB article number.

A Knowledge Base view allows an unlimited 
number of users to search the KB database. All 
you need is a single Enterprise HelpDesk user 
account. All users automatically log on to the view 
with this account (in fact, users never see the 
logon window, they go straight to the view).

This user account must belong to a group that has 
permission to open the Web view, and to add and 
update contacts.

Submit-only views are used to submit new issues. 
A submit-only view is basically just a form and a 
Submit button. Users cannot run queries or edit (or 
even view) existing issues. 

A submit-only view allows an unlimited number of 
users (such as customers or employees) to submit 
issues. All you need is a single Enterprise 
HelpDesk user account. All users automatically log 
on to the view with this account (in fact, users 
never see the logon window, they go straight to the 
view).

This user account must belong to a group that has 
permission to open the Web view, and to add and 
update contacts. The account is used to set the 
Submitter field.

If you have more than one submit-only view for the 
same project, you may want to create separate 
accounts for each view. This will allow you to 
distinguish between issues submitted from 
different views.

The user submitting the issue is considered the 
contact. Users must enter their contact information 
(name, e-mail, and so on) the first time they submit 
an issue.
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Setting Web View Attributes

To set Web view attributes:

1 In the shortcut bar, click  Web View.

2 Click  (beside Attributes) to open the Web 
View Attributes dialog box.

Description Description of the Web view. 
Displayed in the list of Web views that appears 
when a user logs on. The default description is the 
Project / View name (for example, “BugTrk / 
BugTrk” for the BugTrk view of the BugTrk project). 
To include the project and view names in the 
description, use the macros <ProjectName> and 
<ViewName>.

If you change this attribute, you must regenerate 
the Web view.

Display All Read-Only Fields As Text Read-
only fields can be displayed as text (Yes) or as 
disabled controls (No). In a read-only Web view, all 
fields are read-only. In normal and submit-only 
Web views, read-only fields are fields that have 
been disabled through the Field Editor.

If you change this attribute, you must regenerate 
the Web view.

Issues per Page The number of issues to show 
per page in the Summary List. 

Timeout The number of minutes of inactivity 
before the browser session times out and the user 
is logged off.

Load Issues Not In Query If Yes, users can load 
any issue by typing the issue number in the Issue 
box of a Web view. If No, users can load only the 
issues shown in the Summary List.

Setting Group Access Permissions
You can control access to Web views on a group-
by-group basis. When users try to log on, they see 
only the Web views that they have permission to 
access.

To set group access permissions:

1 In the shortcut bar, click  Web View.

2 Click  (beside Groups Allowed to Open) to 
open the View Permissions dialog.

3 In the Groups box, click the groups you want to 
be able to access the Web view.

If you allow the Users group to open the Web 
view, then all users can open the Web view.

The Groups box lists the groups that are allowed to 
open the project (as specified in HelpDesk Admin). 

Exporting Fields and 
Queries

Exporting Fields

To export fields:

1 In the shortcut bar, click  Fields.

2 In the Tab list, click a tab (a tab is a group of 
related fields).

3 In the Available list, click a field and then click 

. This moves the field to the Export To View 
list, which lists the fields included in the Web 
view when it is generated.
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4 Use  and  to change the order of the fields 
in the Export to View list. The order of the fields 
in the list determines the layout of the fields in 
the Web view.

Click  to move all fields in the Available list to the 
Export To View list.

Required fields are exported by default. You can 
remove the fields—just ignore the warning.

The Field list in Ad-hoc Query Editor lists exported 
fields only, plus the Issue field

Layouts show only exported fields.

Exporting Queries
Queries control which issues a user can see in a 
Web view. For example, if "My Submitted Issues" 
is the only query available in a Web view, then 
users can see only the issues they submitted.

To ensure that users cannot access any issues 
other than the ones found by the exported queries, 
you should hide the ad hoc query editor. The Ad-
hoc Query Editor allows users to see any issue (for 
example, by running a query like Issue Number > 
0, which returns all issues).

In the Queries section, the Available box lists all 
the queries that you can export to the Web view. 
The Export to View box lists all the queries that will 
be exported to the Web view. 

To export queries:

1 In the shortcut bar, click  Queries.

2 In the Available list, click a query.

3 Click  to move the query from the Available 
box to Export To View. 

To move all queries from Available to Export To 
View, click .

Adding the Child Issues 
Tab
Web views can have a Child Issues tab that allows 
users to link one or more child issues to a parent 
issue.

To add the Child Issues tab:

1 In the shortcut bar, click  Fields.

2 In the Tab list, click Child Issues.

3 In the Available list, click the Child Issues field 

and then click .

The Child Issues field is a special grid control 
that allows users to build a list of child issues.

4 If you want to allow users to control whether 
child issues can have a different Progress value 
than their parent, export the Progress 
controlled by parent field (Details tab).

By default, child issues have the same substate 
as their parent. Users can set Progress 
controlled by parent to No to override this 
default behavior.

5 Regenerate the Web view.
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Working with Fields

Editing Field Attributes
The fields on a Web view are arranged in a two-
column layout inside an HTML table. The order of 
the fields is determined by the order in which they 
are listed in the Export to View list. 

The appearance and layout of the fields can be 
customized through field attributes, which control 
options such as alignment, width, and height. 

To edit field attributes:

1 In the shortcut bar, click  Fields.

2 In the Tab list, click a tab. Then in the Export to 
View list, click a field.

3 Click Attributes to open the Attribute Editor.

The Attribute Editor displays the attributes for 
the selected field.

4 After you open the Attribute Editor, you can edit 
the attributes for another field by clicking the 
field in the Field Name list.

Using Field Variables
Field variables allow you to insert the name, value, 
or id of a field into an attribute. The field variables 
are particularly useful with the Html code after 
control and URL attributes.

Adding Pop-up Editors
A Memo field such as the (Detailed Description 
field) has an Editor attribute that controls how the 
content of the field is edited.

Aligning Fields
Alignment. Aligns a field (both the caption and the 
input control). Possible values are Left, Right, or 
Center. By default, all fields are left-aligned.

Aligning Fields

Vertical Alignment Sets the vertical positioning 
of a field (both the caption and the input control). 
Possible values are: Top, Middle, and Bottom. The 
default is Top.

Variable Inserts

%fieldvalue% The current value of the field.

For choice lists, %fieldvalue% is 
the ID of the choice.

%fieldname% The name assigned to the input 
control (for example, 
cbo_18_cboPriority).

%fieldid% The numeric ID of the field (this is 
the nID of the field in tblDtsFIelds).

Value Description

<None> The Memo field is an editable text 
area in the Web view.

HTML The contents of the Memo field are 
edited in a pop-up HTML editor.

Text The contents of the Memo field are 
edited in a pop-up Text editor.

Variable Inserts
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Vertical Alignment of Fields

Automatically Updating Choice Lists
Automatically Update List If Yes, the choice list 
is updated each time a user logs on to the Web 
view. To turn on the automatic update of choice 
lists, you must regenerate the view.

If No, the choice list is updated only when the Web 
view is regenerated.

Automatically updating a large number of choice 
lists may affect performance. You should 
automatically update only the choice lists that 
change frequently.

Changing Field Captions
The Caption attribute specifies a text label for a 
field. Note that reports and the Field list in the Ad-
hoc Query Editor still use the original field name, 
not the value of the Caption attribute.

Spanning Columns
Set Column Span to 1 to have the field span a 
single column, or 2 to have the field span the entire 
width of the page.

To make a field span 2 columns, you must also set 
the CSS Class to MemoFieldWidth. Use the 
SpanTwoWidthOne class if you want a field to 
span two columns but still be one column wide 
(that is, be alone on a line).

For example, in the default HelpDesk Web view, 
the Priority field uses the SpanTwoWidthOne 
class.

Applying CSS Styles
CSS Class Name of a style class defined in the 
cascading style sheet (CensusMain.css) used by 
the Web view. This class is applied to the controls 
(for example, the <input> form element for a text 
box). By default, fields use the classes 
ComboBoxWidth, MemoFieldWidth, and 
TextFieldWidth. These classes set the width and 
border of the control. ComboBoxWidth, and 
TextFieldWidth set the width to one column, and 
MemoFieldWidth sets the width to two columns.

The CSS Class attribute does not apply to read-
only/disabled fields. These fields use the 
readOnlyStyle class.

Displaying Read-Only Fields
You can display read-only fields as either text or as 
disabled controls.

Read-only field displayed as text

Read-only field displayed as a disabled control

In a read-only Web view, all fields are read-only. In 
normal and submit-only Web views, read-only 
fields are fields that have been disabled through 
the Field Editor.
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To set the default for all read-only fields in the 
Web view:

1 In the shortcut bar, click  Web View.

2 Click  (opposite Attributes) to open the Web 
View Attributes dialog box.

3 Set Display All Read-Only Fields As Text to 
either Yes or No.

By default, this setting applies to all read-only 
fields in the Web view.

To override the default for a specific read-only 
field:

1 In the shortcut bar, click  Fields.

2 In the Tab list, click the tab that contains the 
field.

3 In the Export to View list, click the field and then 
click Attributes.

4 Change Display Read-Only Field As Text to 
either No or Yes.

When Display Read-Only Field As Text is set to 
Default, the field uses the value of the Web 
view attribute Display All Read-Only Fields As 
Text.

Notes

• If you display a read-only memo field as a 
disabled control, the scroll bar is disabled, so 
the user may not be able to see everything in 
the field.

• You must regenerate the Web view after you 
change either the Web view attribute or the field 
attribute.

Width and Height

Width Width in characters of a single-line text 
box, or width in pixels of a list box.

The CSS classes assigned to text boxes and list 
boxes override the Width attribute. These CSS 
classes (TextBoxWidth and ComboBoxWidth) 
specify the widths of the input controls.

Inserting Custom HTML Code

Html code before/after control HTML inserted 
before and after the control in the generated HTML 
page. Must be a single line of text.

For example, suppose you want to add a help icon 
that displays a tooltip.

A simple way to implement field-level tooltips is to 
put this HTML in the Html code after control 
attribute:

<img src="help.gif" title="Tooltip text goes here">

This inserts a help icon that displays a tooltip when 
a user points to the icon. 

A more generic approach would be to write a 
javascript function in CustomCode.js that returns a 
string of HTML. 

function getHelpIcon ( tooltip ) {

var str;

str = '<img src="help.gif" title="' + tooltip + '">';

return str;

}
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The Html code after control would then call this 
function to get the HTML:

<script type="text/javascript" language="javascript">
document.write(

parent.objCustomCode.getHelpIcon( 'Tooltip text')
);
</script>

Important You must declare your function in 
CustomCode.js. Look for the public declarations at 
the bottom of the file, and add this line:

this.getHelpIcon = getHelpIcon;

In the Html code before/after control attributes, you 
can use the string %fieldname% to refer to the 
name of the control. (The name of a control is the 
value of the name attribute on the form element.) 
For example, you could pass %fieldname% into the 
getHelpIcon() function, which would then return the 
help for that field.

Adding URL Buttons
A URL button opens a new browser window and 
loads the document specified by the URL attribute. 
A URL button is associated with a field, and can 
use the field value as part of the URL.

For example, suppose you wanted to record the ID 
number of a Microsoft KB article that explains how 
to resolve a problem. 

To add a URL button that opens the specified KB 
article in a browser window, set the URL and URL 
Button CSS attributes as follows:

URL = http://support.microsoft.com
/default.aspx?scid=kb;en-us;%fieldvalue%
URL Button CSS = URLButton

In the URL attribute, %fieldvalue% is a placeholder 
for the KB article ID number entered in the field. 

If you omit the “http://” prefix from the URL, 
Enterprise HelpDesk automatically adds it when 
you generate the Web view.

The URL Button CSS attribute identifies the CSS 
classes used for the button. Enterprise HelpDesk 
includes several different URL button classes you 
can use:

• URLButton 

• MailToButton 

• RemoteControl 

A URL button always opens a new browser 
window, even if you specify a URL like 
“mailto:xsupport@vector-networks.com”.

Text Boxes
Number of Characters Maximum number of 
characters per line in the text box. 

Multi-Choice Lists
Number of Visible Items Number of items visible 
in a multi-choice list. Users can always see items 
that are outside the visible window by scrolling the 
list box. 

Show Selected Items In Text Shows a comma-
separated list of the selected items in a text box 
above the multi-choice list. This helps users see 
what items are selected.
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Show Selected Items In Tooltip Shows a 
comma-separated list of the selected items in a 
tooltip. This helps users see what items are 
selected in a multi-choice list.

Hiding Fields
Setting the Visible to No hides the field in the Web 
view. The field is still included in reports and listed 
in the Field list of the Ad-hoc Query Editor.

Web View URLs

Pointing Users to Web Views
The URLs for a normal or read-only Web view are 
displayed in the Web View Editor. The Enterprise 
HelpDesk Logon URL is for users with Enterprise 
HelpDesk users accounts. The Windows 
Integrated Logon URL is for users whose Windows 
user accounts have been imported into Enterprise 
HelpDesk.

The default page at the URL is logon.asp.

For Submit-only and Knowledge Base views, you 
have to add the logon.asp file name and a query 
string to the URL displayed in the Web View Editor. 
For example:

http://server/helpdesk/logon.asp?View=HelpDesk%2FRep
ort%20Issue

http://server/helpdesk/logon.asp?View=HelpDesk%2FKB

The query string (the part after the question mark) 
specifies the project and view:

View=<project>%2F<view>

%2F is the escape sequence for a forward slash 
(/). Spaces in the view name are replaced with the 
escape sequence %20.

Changing URLs and Directories

A Web view is accessed through a URL like 
//server/HelpDesk, where server is the name of the 
Web server computer, and HelpDesk is the name 
of a virtual directory.

On a Web site hosted by Microsoft Internet 
Information Services (IIS), a virtual directory is an 
alias (a short, descriptive name) that is mapped to 
a directory on the Web server. 

The Web View Editor includes a Web View wizard 
to help you:

• Change the URL (for example, change 
//nan/HelpDesk to //nan/CallTracking) by 
changing the virtual directory.

• Change the directory where the Web view is 
published.

There are two ways to change the URL. You can 
create a new virtual directory, or you can use a 
existing virtual directory.
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To change the URL by creating a new virtual 
directory:

1 In the shortcut bar, click  URL.

2 Click  to open the Web View Wizard and then 
click Next.

3 Click Advanced, click Create a new URL and a 
new Directory, and then click Next.

4 Type the name of your Web server and click 
Next.

5 In the Web Site list, click the Web site where 
you want to create the virtual directory.

6 In the Virtual Directory box, type the name of 
the new virtual directory.

7 In the Path box, select the directory where you 
want to put the generated Web view files.

8 If you need to change the user account used for 
anonymous access to the virtual directory, 
select the Show advanced options check box.

9 Click Next and then click Finish.

To change the URL by using a different virtual 
directory:

1 In the shortcut bar, click  URL.

2 Click  to open the Web View Wizard and then 
click Next.

3 Click Use existing URL and click Next.

4 In the Web Site list, click the Web site that 
contains the virtual directory you want to use.

5 In the Virtual Directory list, click the virtual 
directory you want to use. 

By default, the Virtual Directory list contains 
only the virtual directories used by Enterprise 
HelpDesk Web views. To show all the available 
virtual directories, select the Show all virtual 
directories from IIS check box.

6 Click Next and then click Finish.

To change the directory:

1 In the shortcut bar, click  URL.

2 Click  to open the Web View Wizard and then 
click Next.

3 Click Advanced, click Update existing virtual 
directory, and then click Next.

4 Click Next and then click Next again.

This assumes you want to change just the 
directory, not the Web server, Web site, or 
virtual directory.

5 In the Path box, select the new directory where 
you want to put the generated Web view files.

6 If you need to change the user account used for 
anonymous access to the virtual directory, 
select the Show advanced options check box.

7 Click Next and then click Finish.

Changing the Windows Account
Enterprise HelpDesk needs a Windows domain 
account to use for:

• Anonymous access to the virtual directories on 
the Web server.

Anonymous access is required to run any Web 
view or HelpDesk Web Admin, which are all 
stored in virtual directories on the Web server.
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• Access Enterprise HelpDesk databases in a 
distributed configuration, where the databases 
are not on the Web server.

• Access to attachments, which may be stored on 
a different computer than the Web server.

• Access to PC-Duo Enterprise site databases.

By default, Enterprise HelpDesk uses the 
CensusUser account, which is created when you 
install Enterprise HelpDesk. The default password 
for the CensusUser account is “nd5kvmWJ”. 

The CensusUser account is a Windows domain 
account.

If you change the password for the CensusUser 
account, or delete the user account and use 
another one, you must update the virtual 
directories in the Internet Service Manager 
(Windows NT) or Internet Services Manager 
(Windows 2003, 2000, XP).

To change the Windows account used for 
anonymous access to a virtual directory:

1 Start the Web View Editor. In the shortcut bar, 

click  URL.

2 Click  to open the Web View Wizard and then 
click Next.

3 Click Advanced, click Update existing virtual 
directory, and click Next.

4 Click Next until you get to the Virtual Directory 
Properties dialog.

5 Select the Show Advanced Options check box.

6 In the User Name box, enter the name of the 
user account. 

Click Browse to locate a domain user account.

7 In the Password box, type the user account 
password.

You can also use HelpDesk Admin to change the 
Windows account.

To change the Windows account used by 
Enterprise HelpDesk:

1 Start HelpDesk Admin.

2 On the Tools menu, click Windows Account.

3 Enter the name and password of the domain 
user account you want to use.

This user account will be used for anonymous 
access by all subsequent Web views you 
generate.

When you change the user account used for 
anonymous access with the Web View Editor or 
HelpDesk Web Admin (Notifications tab), all 
required permissions and rights are automatically 
set.

Customizing Web Views

Setting Default Values

To set default values for a Web view:

1 Log on to the Web view.

2 In the Web view toolbar, click Defaults .

3 In the Default Values dialog box, set the field 
values you want to use as defaults for new 
issues.

4 Click Apply.
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This creates a file named MqDefaultValues.js in 
the folder
CensusWebVD\<project>_<view>\Users\<logon
-name>
where <logon-name> is the name you used to 
log on to the Web view.

5 Copy the file
\CensusWebVD\<project>_<view>\Users\<logo
n-name>\MqDefaultValues.js
to 
\CensusWebVD\<project>_<view>\Users\Users
\MqDefaultValues.js

The folder Users\Users applies to all users that 
log on to the Web view.

6 Copy Users\Users\MqDefaultValues.js to the 
CustomizedFiles folder.

For example, if you want the default values to 
apply to all Web views of the BugTrk project, 
copy MqDefaultValues.js to:

CUSTOMIZEDFILES\#Project#BugTrk\#AllWebVie
ws#\Users\Users
If you want the default values to apply only to 
the BugTrk_BugTrk view, copy MqDefault-
Values.js to:

CUSTOMIZEDFILES\#Project#BugTrk\#WebView#B
ugTrk_BugTrk\Users\Users

Notes

• Users can override these default values by 
setting their own defaults.

• You can remove the Defaults button from Web 
views by disabling the Default Value Editor feature.

Templates and the CustomizedFiles 
Folder
The files that make up a Web view (such as .JS, 
.CSS, .HTML, and .ASP files) are generated from 
templates. If you edit the original templates, your 

customizations will apply to all Web views. And if 
you edit the generated files for a given Web view, 
you'll have to reapply your changes every time you 
generate the view. 

To customize specific Web views without editing 
the generated files, you put your customized files 
in a special CustomizedFiles folder. Each time you 
generate the view, the Web View Editor copies 
your customized files from the CustomizedFiles 
folder into the view. 

Customizing Web View Files

To customize Web view files:

1 In the <HelpDeskServer>\CensusWeb folder, 
create a CustomizedFiles folder.

<HelpDeskServer> represents the folder where 
your HelpDesk Server is installed (for example, 
"C:\Program Files\PC-Duo Enter-
prise\HelpDeskServer").

2 In the CustomizedFiles folder, create a folder 
structure to hold the customized files.

To customize files for all Web views of all 
projects, create this folder structure:

To customize files for all Web views of a specific 
project, create a folder structure like this:

and replace "HelpDesk" with the name of the 
project.
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To customize files for all Web views accessed 
through a given URL, create a folder structure 
like this:

and replace "CensusWeb" with the last part of 
the URL. For example, if the actual URL is 
http://SERVER/HelpDesk, replace 
"CensusWeb" with "HelpDesk").

Use this approach if you generate Web views 
outside of the HelpDeskServer folder.

3 Copy the files you want to customize from the 
view into the CustomizedFiles folder. 

You must recreate the same folder structure. 
For example, if you want to customize files in 
the HTML, JS, and Reports folders of Web 
views of the HelpDesk project, you must create 
this folder structure: 

4 Customize the files and generate the view.

Customizing Shared Web View Files
You can also customize the files that are shared by 
Web views accessed through the same URL. 
These are the files found in the CensusWebVD 
folder, such as logon.asp.

To customize the files in CensusWebVD for all 
Web views:

Put the files in the folder 
CustomizedFiles\#AllProjects#
-or-
CustomizedFiles\<virtual directory>

To customize files for all Web views accessed 
through a given URL:

Put the files in the folder 
CustomizedFiles\<virtual directory>

For example, if the URL is //server/HelpDesk, then 
put the customized files in a folder named 
CustomizedFiles\HelpDesk.

Use this approach if you generate Web views 
outside of the HelpDeskServer folder.

Overriding Customizations

To override the customizations in #AllWebViews# 
for a given Web view, you can create a 
#WebView#<project>_<view> folder. For example:

The files in #WebView#HelpDesk_HelpDesk 
override all #AllWebViews# customizations.

You can create a #WebView#<project>_<web 
view> folder in any of the three customization 
folders (#AllProjects#, #Project#<project>, and 
CensusWeb).
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Customizing the Web View Interface
You can customize most of the HTML and ASP 
pages that make up a Web view. If you edit the 
templates, make sure to backup the original files 
before you begin your customization. 

CensusMain.css Style sheet for a Web view. The 
normalfield, requiredfield, and disabledfield 
classes define the appearance of the fields.

TmplCensusMain.htm Defines the frame 
structure for the frames that make up the Web 
view page. You can change the size and position 
of each frame, add and remove scrollbars, and set 
the frame border size.

TmplToolbar.htm Defines the Web view toolbar.

TmplSummaryList.htm Defines the Summary 
List. You cannot customize this page.

TmplSQE.htm Defines the Ad-hoc Query Editor. 

Tabs.asp Defines the layout of the tab navigation 
buttons. 

TmplCmdBar.htm Contains the navigation 
controls. 

When editing these files, do not change references 
to file names, the <WC@ ... > tags, or any of the 
Javascript code.

Changing the Date and 
Time Formats for Web 
Views

About the Date/Time Formats
The format of the dates and times entered and 
displayed in a Web view are controlled by the 
Regional Settings of the Web server, not the 
Regional Settings of the local computer. 

Web views use the short date format.

Microsoft Windows NT 4.0 
When no one is physically logged on to the Web 
server, the Date/Time formats (and other Regional 
Settings) come from the system default settings 
(found in the Locale.nls file for the default locale). 
You can change the system default settings by 
clicking Set Default in the Regional Settings 
section of Control Panel. 

After you change the default locale, you should 
restart the computer. Note that changing the 
default locale changes all regional settings, not 
just the date and time formats. There is no way to 
modify a specific setting within the locale. 

When someone is logged on to the computer, the 
Date/Time formats come from the logged-on user's 
Regional Settings. These settings are read from 
the user profile settings in the 
HKEY_CURRENT_USER/Control 
Panel/International registry key. You can change 
this setting in the Regional Settings section of 
Control Panel, after which you must restart the 
computer. 
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Microsoft Windows 2000 and XP
The Date/Time formats come from system default 
settings in the HKEY_USERS/.Default/Control 
Panel/International registry key. This key contains 
the Regional Settings options specified during the 
operating system installation. 

To change these default system settings, you must 
edit the registry. You may need to restart your Web 
server for the changes to take effect.

Administering Enterprise 
HelpDesk on the Web

About HelpDesk Web Admin
HelpDesk Web Admin is a Web-based 
administration tool that allows you to:

• Add and edit users and contacts.

• Define workflow rules.

• Create new tabs.

• Set up choice fields.

• Enable e-mail notifications.

• Migrate projects to SQL Server and move 
projects to different SQL Server computers.

• Move attachments to a different computer.

• Integrate PC-Duo Enterprise Inventory.

Logging On
You can log on to HelpDesk Web Admin directly 
from the Web View Editor, using the same logon 
account you used to log on to the Web View Editor.

To log on to HelpDesk Web Admin

Do one of the following:

• In your Web browser, go to 
//server/helpdeskadmin, where server is the 
name of your Web server.

• In HelpDesk Admin, click Tools > Web > Web 
Admin.

• If you are sitting at the Web server, click Start > 
Programs > PC-Duo Enterprise > Enterprise 
HelpDesk > HelpDesk Web Admin.

• In the Web View Editor, click Admin and then 
click Log On.

Generating HelpDesk Web Admin
When you install the HelpDesk Web Server, the 
setup program generates a copy of HelpDesk Web 
Admin. If necessary, you can generate another 
copy of HelpDesk Web Admin. For example, you 
may want to change the URL used to access 
HelpDesk Web Admin.

To generate HelpDesk Web Admin:

1 In the Web View Editor, click Admin.

2 If required, change the URL and directory for 
HelpDesk Web Admin. See “Changing URLs 
and Directories” on page 93 for more 
information.

3 Click OK.

Windows Permissions
When you log on to HelpDesk Web Admin, 
HelpDesk Web Admin uses your Windows 
credentials to run tasks if you are a member of the 
CensusAdminsGroup group or the local 
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Administrators group on the HelpDeskServer 
computer. Otherwise, HelpDesk Web Admin runs 
tasks as CensusUser.

Members of the CensusAdminsGroup group (or of 
the local Administrators group on the 
HelpDeskServer computer) have the required 
permissions to perform any task with HelpDesk 
Web Admin. The CensusUser account, on the 
other hand, cannot perform IIS-related tasks such 
as unloading virtual directories (when logging off 
users), and may not be able to relocate databases 
to other computers.

During installation, the Setup program creates the 
CensusAdminsGroup group and adds all 
members of the domain Administrators group to 
the CensusAdminsGroup group. Setup also adds 
the CensusAdminsGroup to the local 
Administrators group on the HelpDeskServer 
computer. The purpose of the 
CensusAdminsGroup is to control access to Web 
Admin.
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Chapter 12: Setting Up E-mail Submission

About Submitting Issues 
by E-mail
You can set up Enterprise HelpDesk to 
automatically convert e-mail messages to issue 
records. The e-mail messages must be located in 
an Exchange mailbox or an Exchange Public 
folder. Every new e-mail message sent to the 
mailbox or Public folder is converted to an issue.

The conversion of an e-mail message is 
configurable, but typically goes something like this:

• The e-mail subject is a one-line summary of the 
issue

• The e-mail body is the issue description

• The e-mail sender is the issue submitter.

• E-mail attachments become attachments to the 
issue.

To set up and configure e-mail submission of 
issues, you use the Exchange Server Integration 
wizard. By default, this wizard is installed on the 
HelpDesk Server computer. If the Exchange 
server is on a different computer, you must install 
the wizard on the Exchange server by running the 
stand-alone setup program (hdexchsetup.exe)."

To start the Exchange Server Integration 
wizard:

On the Exchange server, click Start > All Programs 
> PC-Duo Enterprise > HelpDesk > Exchange 
Server Integration.

Defining Integration Rules
An integration rule specifies how an e-mail 
message is converted to a Enterprise HelpDesk 
issue. You define a rule by choosing the Exchange 
mailbox or Public folder that contains the e-mail 
messages to be converted, mapping e-mail fields 
to HelpDesk fields, and assigning default values to 
HelpDesk fields.

Choosing a mailbox or Public folder All new 
messages sent to a specified mailbox or Public 
folder will be converted to HelpDesk issues. You 
can have different mailboxes/Public folders for 
each of your Enterprise HelpDesk projects.

Mapping Fields You map the e-mail fields (such 
as From, Subject, and Body) to Enterprise 
HelpDesk fields. For example, a common mapping 
is the E-mail Subject to the Summary field, and the 
E-mail Body to the Description Log field.

For fields like Submitter and Contact, you should 
use the <Look up User from sender’s e-mail> 
macro to fill in the field with Enterprise HelpDesk 
user ID.

Copying Attachments When an e-mail message 
is converted to an issue, you can copy 
attachments to an issue field (such as the 
Attachments field). The field will store links to the 
attachments, which are actually copied to the Web 
server.

Assigning Default Values You can assign 
default values to Enterprise HelpDesk fields. If an 
Exchange field is mapped to an Enterprise 
HelpDesk field, the default value is used only if the 
Exchange field is empty.
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Important Fields that are required in Enterprise 
HelpDesk (for example, Summary and Priority) 
must be either mapped or assigned a default 
value. For this reason, you may want to add an 
“Unknown” or “Unspecified” value to a choice list 
field and use it as the default value in issues 
submitted by e-mail.

Configuring the Servers
Each integration rule can be associated with a 
different mailbox or Public folder on the Exchange 
server. If you have multiple Exchange servers or 
HelpDesk Servers, you can even define different 
rules for different servers.

Exchange Server Name
The computer name of the Exchange server.

Inbox/Folder Name
A mailbox or Public folder on the Exchange server. 
The integration rule will be applied to all new e-
mail messages in the specified mailbox or Public 
folder.

Server Path
The location of the HelpDesk Server 

Logon Name
A user name that can be used to log on to 
Enterprise HelpDesk. The user must have access 
permissions for the project where the new issues 
will be created.

Password
The user’s password.

Mapping Fields
The mapping of Exchange fields to Enterprise 
HelpDesk fields controls how information is copied 
from an e-mail message to an issue.

For example, you could map fields like this:

To map an Exchange field to a Enterprise 
HelpDesk field:

1 Click the Enterprise HelpDesk field.

2 In the Exchange Field column, click <click here 
to map field> to open the Map Field dialog box.

3 In the Exchange Field list, click the e-mail field 
that you want to map to the Enterprise 
HelpDesk field.

When the e-mail message is converted to an 
issue, the contents of the Exchange field are 
copied to the specified Enterprise HelpDesk 
field.

Exchange Field Enterprise HelpDesk Field

Subject Summary

Body Description Log

Priority Priority (if you can rely on the 
submitters to set the e-mail 
priority)

From Instead of mapping From to a 
Enterprise HelpDesk field, you 
can use the <Look up User from 
sender’s e-mail> macro to fill in 
the field with Enterprise HelpDesk 
user ID.

To Contact (this would allow you to 
search for issues submitted by e-
mail)
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To remove the mapping between an Exchange 
field and a Enterprise HelpDesk field:

1 In the Exchange Field column, click the field 
that is mapped to the Enterprise HelpDesk 
field.

2 In the Map Field dialog box, clear the Map this 
field check box.

To copy attachments:

1 Select the Copy e-mail attachments check box.

2 In the list HelpDesk fields, click a field. The list 
displays only the fields that support 
attachments.

Assigning Default Values
You can assign default values to Enterprise 
HelpDesk fields that are not mapped. For 
example, you can set the Progress field to New.

Required Enterprise HelpDesk fields that are not 
mapped must be assigned a default value.

Another way to assign default values would be to 
associate different default values (such as Priority) 
with different mailboxes.

To assign values to an Enterprise HelpDesk 
field:

1 Click the Enterprise HelpDesk field.

2 In the Value column, click <click here to assign 
value> to open the Assign Value dialog box.

3 Select or type the value you want to assign.

To remove an assigned value:

1 In the Value column, click the value assigned to 
an Enterprise HelpDesk field.

2 In the Map Field dialog box, clear the Assign 
value to this field check box.
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Chapter 13: Maintaining Your Help Desk 
System

Relocating Databases

Relocating Databases to SQL Server
You can relocate (migrate) databases from 
Jet/MSAccess to SQL Server, or from one SQL 
Server to another. To relocate databases to SQL 
Server, you must have a license for PC-Duo 
Enterprise HelpDesk SQL Enabled.

There are two types of databases you can 
relocate:

• Global databases are the databases shared by 
all projects: the users database (users.mdb), 
the Web views database (censusweb.mdb), 
and the licenses databases (licenses.mdb).

• Project databases contain issues and project 
definitions (such as the definitions of fields, 
queries, and reports). 

To relocate databases to SQL Server:

1 Log on to HelpDesk Web Admin.

• In HelpDesk Admin, click Tools > Relocate > 
Databases. This logs you on to HelpDesk 
Web Admin, where you can use the 
Relocation tab to relocate databases to SQL 
Server.

• In your Web browser, go to 
//server/helpdeskadmin, where server is the 
name of your Web server.

2 On the Relocation tab, under Databases to 
relocate, select the databases you want to 
relocate.

3 In the Relocate databases to this SQL Server 
list, click the SQL Server computer where you 
want to relocate the databases.

To relocate to a SQL Server instance, click Add 
a SQL Server to this list and then type the 
instance name using the syntax <computer 
name>\<instance name>.

4 In the New location for database files box, type 
or paste the name of an existing folder on the 
SQL Server computer.

This folder is where the database files (*.mdf, 
*.ldf) will be stored.

The new location must be the path as seen 
from the Web server. If the SQL Server is in a 
different computer, enter a UNC. Otherwise, 
enter a local path.

5 Click Apply to relocate the databases.

6 During the relocation, you may be prompted for 
the password for the sa SQL Server login 
account. Enterprise HelpDesk needs the 
password so it can initialize the SQL Server.

7 After the databases are relocated, regenerate 
your Web views.

If you relocated the global databases, 
regenerate all Web views. If you relocated 
project databases, regenerate the Web views of 
the relocated projects.

Notes

• We recommend that all databases be stored on 
the same SQL Server computer. This improves 
performance by reducing the amount of data 
sent over the network.
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• When relocating databases from one SQL 
Server to another, the locations of the physical 
data files (.mdf,.ldf) on both the source and 
target computers must be accessible from the 
Web server. Also, the user running HelpDesk 
Web Admin must have full permission on the 
locations in order to move and create files.

• Relocating databases will log off users and 
prevent users from logging on, so choose a 
time when there is little or no activity on Enter-
prise HelpDesk.

• When you relocate a database to SQL Server, 
Enterprise HelpDesk creates a SQL Server 
database with one data file and one log file. 
After the database is created and is accessible 
in SQL Server, database administrators can 
add more files or configure the database as 
required.

• Enterprise HelpDesk creates a SQL Server 
login account named “censusapplication”, 
which is used to connect to the SQL Server.

Troubleshooting Relocation
If HelpDesk Web Admin cannot contact or initialize 
the SQL Server during relocation:

• Check that the SQL Server is running.

• Check that the SQL Server is configured to use 
SQL Server and Windows authentication 
(Mixed Mode authentication).

• Verify that the SQL Server login account sa 
exists, is not disabled, and has permissions to 
log into the master database in the SQL Server. 
sa must be system administrator in SQL 
Server. 

• Stop any antivirus software that is running on 
the SQL Server computer or the Web server 
computer.

• Verify that the HelpDesk Web server computer 
and the SQL Server computer can 
communicate through the network (for 
example, use Ping to test connectivity).

• Try using the IP address instead of the 
computer name to identify the SQL Server 
computer.

• To relocate to a SQL Server instance, click Add 
a SQL Server to this list and then type the 
instance name using the syntax <computer 
name>\<instance name>.

• Verify that both the SQL Server and the Web 
server are using the same protocol (by default, 
TCP/IP). To do this, use the SQL Server Server 
Network Utility on the SQL Server computer, 
and the SQL Server Client Network Utility on 
the Web server.

Relocating Attachments
When users upload attachments, the attachments 
are stored on the Web server. For example, the 
files attached to issue #3 in the HelpDesk project 
are stored in the folder

HelpDeskServer\HelpDesk\Data\Attachments
For security purposes, you may want to move the 
attachments to a separate file server. 

To relocate attachments:

1 In HelpDesk Admin, click Tools > Relocate > 
Attachments.

This logs you on to HelpDesk Web Admin, 
where you can use the Relocation tab to move 
(relocate) attachments.

2 In HelpDesk Web Admin, click the Relocation 
tab and then click Relocate Attachments.
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3 Under Relocate the attachments for these 
projects, select the projects whose attachments 
you want to move.

4 In the New location for attachments box, type or 
paste the name of an existing folder on another 
computer. 

• The Windows account (by default, 
CensusUser) must have (full) permissions 
on the new location. 

• The new location must be a UNC path (for 
example, \\sharename\Attachments) that the 
Web server can access.

• The new location is the root folder where 
Enterprise HelpDesk creates folders to store 
the attachments. For example, if the new 
location is

//fileserver/HelpDeskWeb

then attachments to the HelpDesk project 
are stored in

//fileserver/HelpDeskWeb
/HelpDesk/Data/Attachments

If you created your own attachment field, 
then attachments are stored in

//fileserver/HelpDeskWeb
/HelpDesk/Data/<fieldname>

5 Click Apply to relocate the attachments.

6 After the attachments are relocated, regenerate 
the Web views of the projects whose 
attachments were relocated.

Notes

• Relocating attachments will log off users and 
prevent users from logging on, so choose a 
time when there is little or no activity on Enter-
prise HelpDesk.

Deleting Issues
Using HelpDesk Admin, you can delete specific 
issues (for example, “1” or “3, 6, 9”) or a range of 
issues (for example, “1-100”) from a project.

To delete issues:

1 In HelpDesk Admin, click Delete Issues on the 
Project menu.

2 In the Issues to delete box, type the issue 
numbers you want to delete.

You can type a specific issue number, a 
comma-separated list of issue numbers 
(“1, 5, 7”), or a range (“1-25”).

3 If you want to reuse the issue numbers of 
deleted issues, select the Recycle Issue 
Numbers check box.

Recycled issue numbers are assigned to new 
issues.

Managing Logon Sessions

About the Logons Editor
HelpDesk Admin includes a Logons Editor (Tools 
menu) that lists all users logged on to Web views, 
HelpDesk Admin, HelpDesk Web Admin, or the 
Web View Editor.

The Logons Editor displays the following infor-
mation for each logon session.

Name Logon name of the user.

Date/Time Date and time that the user logged on.

Workstation The user’s IP address or computer 
name.
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Project If the user is logged on to a Web view, the 
name of the project is displayed.

Virtual Directory If the user is logged on to a 
Web view, the virtual directory is displayed. The 
virtual directory is the final part of the URL used to 
access the Web view. For example, if the virtual 
directory is named “helpdesk”, then the URL is 
http://server/helpdesk. You can use the Web View 
Editor to determine which views are at the 
specified URL.

Virtual directories such as helpdesk00, 
helpdesk01, and helpdesk02 are all accessed 
through the //server/helpdesk URL.

Application This is either “Web View”, “Web View 
Editor”, “Admin”, or “Web Admin”.

Logging Off Users

To log off a specific user:

1 On the Tools menu, click Logons Editor.

2 In the list of users, click a user.

3 Click Log Off. 

To log off all users:

1 On the Tools menu, click Logons Editor.

2 Click Log Off All. 

Before logging off a user, a Web view displays a 
message telling the user that Enterprise HelpDesk 
is shutting down. You can give users a bit more 
time by sending an immediate message. To do 
this, set the Send immediate shutdown message 
project option to Yes. 

Setting the Monitor 
Interval
The Monitor Interval option (Tools > Options) 
controls how long (in seconds) Enterprise 
HelpDesk waits before:

• Checking for messages from a Web view

• Checking for user activity in a Web view

• Terminating a user session when logging off 
users.

The default interval is 60 seconds. If your Web 
server is on a slow Internet connection and you 
want to reduce network traffic and bandwidth 
usage, you can try increasing the monitor interval. 
Too large an interval, however, will mean that 
administrators will have to wait a long time when 
performing any action that involves logging off 
users.

Repairing and Compacting

About the Repair and Compact Tool
HelpDesk Admin includes a tool for repairing and 
compacting Microsoft Access database files. This 
tool is available from the Tools menu (Repair and 
Compact), but to repair and compact project 
database files, you must select a project first.

About the Database Files
The Repair and Compact dialog box displays a list 
of databases and their locations. The list of 
includes both common databases (databases 
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shared by all projects) and project-specific 
databases. Note that while SQL Server databases 
are listed, you cannot repair and compact them.

Project-specific databases:

Databases shared by all projects:

Compacting Database Files

Compacting optimizes the performance of 
Microsoft Access databases and can help prevent 
data corruption. If you make frequent changes in a 

database, parts of the database may become 
fragmented. We strongly recommend that you 
periodically repair and compact your databases.

To compact database files:

1 In the Project list, click a project.

2 In the Tools menu, click Repair and Compact.

3 In the Repair and Compact dialog box, select 
the database files you want to compact.

Note that SQL Server databases cannot be 
repaired and compacted with this tool.

Repairing Damaged Database Files
Repairing files allows you to recover corrupted or 
damaged Microsoft Access databases.

To repair a database file.

1 Make a copy of the damaged database file so 
that you have a backup.

2 Delete the .ldb file if it is present. You must 
close the corresponding database file before 
you delete the .ldb file.

3 If the database file is project-specific, click a 
project in the Project list.

4 In the Tools menu, click Repair and Compact, 
and then select the files you want to repair.

5 Click Start to run Repair and Compact on the 
selected files.

Running Security Repair
The Security Repair utility program repairs and 
compacts CenSys.mdw. CenSys.mdw is the 
system workgroup file that stores security settings 
such as user group permissions and passwords.

Issue database .dat (Jet/Access)

_DAT (SQL Server)

Project definitions .def (Jet/Access)

_DEF (SQL Server)

Temporary database 
used by HelpDesk 
Admin

.usr (Jet/Access)

Web view definitions censusweb.mdb 
(Jet/Access)

CENSUSWEB_MDB 
(SQL Server)

User and contact infor-
mation

users.mdb 
(Jet/Access)

USERS_MDB (SQL 
Server)

Licenses Licenses.mdb 
(Jet/Access)

LICENSES_MDB 
(SQL Server)
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CenSys.mdw may become bloated and stop 
working. Symptoms include changes in user 
permissions, such as the inability to log on, or an 
increase in file size (normal file size is around 160 
KB).

Security Repair works on the copy of CenSys.mdw 
found in the local HelpDeskTools folder (for 
example, C:\Program Files\PC-Duo 
Enterprise\HelpDeskTools). This prevents users 
from accidently running the program on the 
CenSys.mdw on the database server.

To repair and compact CenSys.mdw:

1 Make sure no one is editing users, groups, or 
passwords.

2 Copy CenSys.mdw from the HelpDeskServer 
folder to the HelpDeskTools folder.

3 On the Start menu, point to Programs and then 
click PC-Duo Enterprise. Point to HelpDesk and 
then click Security Repair.

4 Copy CenSys.mdw back to the 
HelpDeskServer folder.

Checking Integrity

About the Integrity Editor

The Integrity Editor (available from the Tools 
menu) allows you to remove database locks and 
validate the integrity of your databases. The 
integrity tasks apply to both SQL Server and 
Microsoft Access databases.

Remove Locks

Locks on Project Definitions Removes locks on 
project definitions, such as reports, queries, fields, 
and sorts. 

If you get "locked by another user" messages 
when you try to use HelpDesk Admin, run the 
Remove Locks task to remove the locks.

Locks on Users and Logon Sessions

Removes locks on users and logon sessions. 
Users are locked while someone is editing a 
record in the users database (the users.mdb file or, 
in SQL Server, the USERS_MDB database).

Sessions shown in the Logons Editor can be 
locked. For example, you may not be able to 
remove a logon that is several weeks old because 
it is locked. Run Remove Locks to unlock the 
logon.

Validate Integrity of Fields

This task verifies that the issue database and the 
project definition database are in-sync and have 
the same set of fields. The task also checks 
primary keys and indexes.

For example, suppose your issue database is 
damaged and cannot be repaired, and that your 
backup of the issue database is not in-sync with 
the current project definitions database (the 
definitions database has new fields that are not in 
the backup issue database). By running the 
Validate Integrity of Fields task, you can 
synchronize the backup issue database with the 
current project definitions database.
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Validate Relationships

This task verifies that built-in related fields are set 
correctly in the issue database. In the HelpDesk 
project, the only built-in related fields are State and 
Progress. See “Editing the Progress and State 
Lists” on page 26 for a description of the 
relationship between these two fields.

Validate Relationships does not apply to field 
relationships created with the Workflow Editor.

Validate Integrity of Issues

This task verifies that the issue database and the 
revision history are in-sync, by checking the 
revision numbers stored in the different tables of 
the database.

Enabling Auto Repair
If you have problems running HelpDesk Admin, try 
using the Enable Auto Repair option (Tools menu).

Enable Auto Repair tries to repair HelpDesk Admin 
by fixing broken references, linking tables, and 
recreating objects. 

To turn on auto-repair, click Enable Auto Repair in 
the Tools menu. Then exit HelpDesk Admin and 
log back on. While auto-repair is turned on, 
HelpDesk Admin runs in “repair mode”, which may 
be slower than normal mode.

To turn off auto-repair, click Enable Auto Repair 
again.

Entering License Keys
When you receive a new license key, or when you 
want to enable the SQL Server functionality of PC-
Duo Enterprise HelpDesk SQL Enabled, you use 
HelpDesk Admin to enter your license key.

PC-Duo Enterprise HelpDesk SQL Enabled 
requires both the Access Enabled and the SQL 
Enabled license keys. The Access Enabled 
license key is the base license that specifies the 
number of concurrent-use licenses. The SQL 
Enabled license key enables SQL Server support.

To enter your license key:

1 Log on to HelpDesk Admin.

2 On the Tools menu, click Licenses.

3 In the Product list, click a product.

• Access Enabled to enter a PC-Duo 
Enterprise HelpDesk Access Enabled 
license key.

• SQL Enabled to enter a PC-Duo Enterprise 
HelpDesk SQL Enabled license key.

4 Click  , enter your license key, and click 
Apply.

Number of Licenses Shows how many users 
can run Enterprise HelpDesk concurrently. The 
Access Enabled license key determines the 
number of concurrent users (to see the number of 
concurrent users, click Access Enabled in the 
Product list).

License Type Evaluation licenses are temporary 
licenses that have an expiration date. Concurrent 
licenses are permanent licenses that allow a 
specified number of users to use Enterprise 
HelpDesk simultaneously.
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Expiration Date Shows the date at which 
evaluation licenses expire and Enterprise 
HelpDesk stops working.

Releasing Databases
Some Enterprise HelpDesk administrative tasks 
start a Shutdown Process. Examples of such tasks 
include relocating databases, creating projects, 
applying changes in the Field Editor, generating 
Web views, running integrity tasks, and repairing 
and compacting databases.

The Shutdown Process logs off users and 
releases databases. During the Shutdown 
Process, you may see a “Still releasing databases” 
message.

When you get the "Still releasing databases" 
message, you can:

• Click Cancel to stop trying to release the 
databases, and start logging off users. Do this 
only if you are sure that no one is using the 
databases.

• Try to manually release the databases and then 
click OK. To release the databases:

• Unload the virtual directories used by 
Enterprise HelpDesk.

• Stop the Mq Issue Agent service.

• Exit all Enterprise HelpDesk programs.

• Exit any programs (such as Microsoft 
Access or SQL Server Enterprise Manager) 
that may be accessing the databases.

Note that if you set the option Tools > Options > 
Always verify locked databases to No, Enterprise 
HelpDesk will not try to release databases during 
the Shutdown Process. In general, setting Always 

verify locked databases to No is not 
recommended, unless you know there is a process 
that regularly accesses the databases but does 
not affect Enterprise HelpDesk.

Backing Up

About Backing Up
You should regularly back up your Enterprise 
HelpDesk databases. Besides backing up all the 
issue data entered into the system, you should 
also (though perhaps less frequently) back up the 
files and databases that define your projects and 
Web views.

Backing Up PC-Duo Enterprise HelpDesk 
Access Enabled By default, PC-Duo Enterprise 
HelpDesk Access Enabled databases use the 
Jet/Access database engine, and are located in 
the HelpDeskServer folder on Web server. To back 
up the Jet/Access databases, you just have to 
back up the databases files.

Backing Up PC-Duo Enterprise HelpDesk SQL 
Enabled In PC-Duo Enterprise HelpDesk SQL 
Enabled, most Access databases can be migrated 
to SQL Server. After migration, the databases are 
located in an admin-specified folder on a SQL 
Server computer, which may or may not be the 
same computer as the Web server 

To back up SQL Server databases, you can use 
the SQL Server backup functionality to do 
incremental or complete backups of the 
databases.

Locating databases By default, all databases 
are stored in the HelpDeskServer folder on your 
Web server. However, the databases can be 
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relocated to different folders on different 
computers. For example, the databases may be 
relocated to a separate SQL Server computer.

To locate the databases, log on to HelpDesk Web 
Admin and go to the Relocation tab.

Attachments By default, attachments are stored 
on the Web server. For example, the files attached 
to issue #3 in the HelpDesk project are stored in the 
folder

HelpDeskServer\HelpDesk\Data\Attachments\3

Attachments may be relocated to a separate file 
server. To check the location of the attachments, 
log on to HelpDesk Web Admin, go to the 
Relocation tab, and click Relocate Attachments.

Web views By default, Web views are stored on 
the Web server in the HelpDeskServer folder:

HelpDeskServer\CensusWeb\Views\CensusWebVD\
To check the location of your Web views, log on to 
the Web View Editor and in the shortcut bar click 
URL.
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WHAT TO BACK UP

Databases

Databases that use the Jet/Access database engine 
are located in the HelpDeskServer folder on the 
Web server. Databases that are migrated to SQL 
Server may be located in a different folder or on a 

different SQL Server computer. Use HelpDesk Web 
Admin (Relocation tab) to check the location of your 
databases.

Files

In addition to the databases, there are a number of 
files you should backup. In particular, you should 
back up the attachments (the files attached to 
issues). By default, attachments are stored on the 

Web server, but they can be moved to a separate file 
server. Use HelpDesk Web Admin (Relocation tab) 
to check the location of the attachments.

Jet/Access SQL Server

Issue database <project>01.dat <project>01_DAT

Global databases users.mdb
licenses.mdb
censusweb.mdb

USERS_MDB
LICENSES_MDB
CENSUSWEB_MDB

Project definitions <project>01.def <project>01_DEF

Security database CenSys.mdw —

Temp database <project>03.usr —

Attachments By default, the attachments for a project are stored in
HelpDeskServer\<project>\Data\Attachments
This location can be changed.

Project versioning HelpDeskServer\<project>.cen

System files HelpDeskServer\CenSession.xml
HelpDeskServer\CenInfoSession.xml

Web view files Customized Web view files are located in the folder
HelpDeskServer\CensusWeb\CUSTOMIZEDFILES\

Generated Web view files are located in the folder
HelpDeskServer\CensusWeb\Views\CensusWebVD\

Project folder The project folder is located in 
HelpDeskServer\<project>
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Backing Up Issues
To back up the issue data stored in a project, you 
need to back up:

• The issue database, which stores all the issue 
information entered into the Enterprise 
HelpDesk system.

• The files attached to issues. These files are 
stored outside of the issue database, in the file 
system.

What to backup IAll issue information (except 
for attached files) is stored in the issue database. 

By default, attachments are stored in the project 
folder (for example, C:\Program Files\PC-Duo 
Enterprise\HelpDeskServer\HelpDesk\Data\Attach
ments). Note that the attachments may be stored 
in a different folder or on a different computer.

To check the location of the databases, log on to 
HelpDesk Web Admin and click the Relocation tab.

To check the location of the attachments, log on to 
HelpDesk Web Admin, click the Relocation tab, 
and click Relocate Attachments.

You can use HelpDesk Admin to verify the location 
of the issue database. In the Project list, click the 
project to display the Project Properties. The 
Project Location specifies the location of the issue 
database.

Backing Up Projects
Projects include the definitions of fields, queries, 
sorts, layouts, reports, and notifications.

What to backup. Project definitions are stored in 
the definitions database.

In addition to the definitions database, there are 
several related files you should also back up.

Note that Enterprise HelpDesk automatically 
backs up the tblDtsFields table in the definitions 
database. This table contains the definitions of the 
fields in the project. The backup copies of the table 
are stored in the definitions database.

Backing Up the Users Database
The users database contains all user and contact 
information, and is shared by all projects.

What to backup If at least one project uses SQL 
Server, the user data is stored in a SQL Server 
database. Otherwise, the user data is stored in a 
Microsoft Access .mdb file. The users database is 
located in the HelpDeskServer folder (for example, 
C:\Program Files\PC-Duo 
Enterprise\HelpDeskServer).

Database engine Database 

Jet/MSAccess <project>01.dat

SQL Server <project>01_DAT

Database engine Database 

Jet/MSAccess <project>02.def file

SQL Server <project>02_DEF database 

Project File Description

<project>.cen Used for project initialization and 
versioning

<project>03.usr Access database used by Help-
Desk Admin
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Backing Up System Files

We recommend you do a general backup of the 
files in the HelpDeskServer folder. 

What files to backup You should backup these 
files:

• Censys.mdw (security database that contains 
users, groups, and passwords).

• The license database.

• CenSession.xml

• CenInfoSession.xml 

Enterprise HelpDesk automatically creates backup 
copies (in the HelpDeskServer folder) of 
CenSys.mdw and CenSession.xml when the files 
change. A mirror of CenSys.mdw is also available 
(the mirror file is named CenSys_mir.mdw).

Backing Up Web Views

What to backup You should backup these 
databases, files, and folders:

• The database of Web view definitions and 
settings.

• The CUSTOMIZEDFILES folder. This folder 
contains all the customized Web view files (for 
example, custom reports).

• The generated Web view files. Each Web view 
has its own folder. For example:

C:\Program Files\PC-Duo Enterprise
\HelpDeskServer
\CensusWeb\Views\CensusWebVD
\HelpDesk_HelpDesk

• The project folders. Each project has its own 
folder. For example:

C:\Program Files\PC-Duo Enterprise
\HelpDeskServer\HelpDesk

The project folder stores attachments, the 
reports used to format notifications, the 
macro70.bas file, and the queue of notification 
messages.

Note that the attachments may be stored on a 
different computer. To check the location of the 
attachments, log on to HelpDesk Web Admin, 
click the Relocation tab, and click Relocate 
Attachments.

Automatic Backups
Enterprise HelpDesk automatically backs up:

• The tblDtsFields table in the project definitions 
database. This table contains the definitions of 
the fields in the project.

• CenSession.xml

Database engine Database 

Jet/MSAccess users.mdb

SQL Server USERS_MDB

Database engine Database 

Jet/MSAccess Licenses.mdb

SQL Server LICENSES_MDB

Database engine Database 

Jet/MSAccess censusweb.mdb

SQL Server CENSUSWEB_MDB
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• CenSys.mdw

You can disable these automatic backups by 
setting the Enable Backups option to No (in the 
Tools menu, click Options).

Performing Hot Backups
Hot backups are backups performed while the 
Enterprise HelpDesk system is in use. Hot 
backups are ideal for 24-hour-a-day operations.

To perform hot backups, the Enterprise HelpDesk 
administrator has to use database-specific tools:

• To back up data in a SQL Server database, use 
the built-in SQL Server backup utility.

• To back up Jet/MSAccess databases, use a 
third-party tool like FMS Total Visual Agent.

Restoring Backups
After restoring backups of the issue database and 
the project definitions database, use the Integrity 
Editor to validate the integrity of fields, 
relationships, and the issue database.

Troubleshooting Problems 
with Attachment Fields

Uploading Large Attachments
On Windows Server 2003 systems, the default 
size limit for uploaded files is 4096 KB. If a user 
tries to upload an attachment that exceeds this 
limit, the user may get "The page cannot be 
displayed" or "Cannot find server or DNS Error" 
error messages.

To increase the upload limit for attachments:

1 Using your favorite text editor, open the file

C:\Program Files\Common Files
\MetaQuest\Scripts\IIS\MqWVDConfig.vbs
The above assumes that C: is your system 
drive. 

2 Set the constant UPLOAD_FILE_MAX_SIZE to 
the maximum size (in bytes) for uploaded 
attachments.

For example:

UPLOAD_FILE_MAX_SIZE = 1048576 ' 1 MB

UPLOAD_FILE_MAX_SIZE = 5242880 ' 5 MB

UPLOAD_FILE_MAX_SIZE = 10485760 ' 10 MB
3 Re-create the virtual directories where you 

want the new size limit to apply. Note that re-
creating virtual directories will log off users.

a. Start the Web View Editor.

b. In the shortcut bar, click  URL.

c. Click  to open the Web View Wizard.
d. In the Web View Wizard, click Next until you 

get to the last page of the wizard, and then 
click Finish. This will re-create the virtual 
directories associated with the existing URL.

e. Click Yes each time the Wizard asks if you 
want to re-create a virtual directory and reset 
its properties.
A URL (such as //Server/helpdesk) has 
several associated virtual directories (for 
example, helpdesk, helpdesk00, 
helpdesk01, and helpdesk02). 

Fixing 404 Errors
When Enterprise HelpDesk is installed on a 
Windows Server 2003 system, users may get 404 
errors (File not found) when trying to open 
attachments. This is because in Windows Server 
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2003, IIS 6.0 only accepts requests for static files 
with extensions that it recognizes. If an attached 
file has an unknown file extension, IIS denies the 
request and returns the 404 error page.

The known extensions that IIS will serve are 
controlled by the MIME Types settings.

To define a MIME type for a specific extension:

1 Open Internet Information Services.

2 In the console tree, right-click the virtual 
directory used for attachments (for example, 
helpdesk-HelpDesk-Upload) and then click 
Properties.

3 On the HTTP Headers tab, click MIME Types.

4 Click New.

5 In the Extension box, type a file name extension 
(for example, "ini").

6 In the MIME Type box, type the MIME type of 
the file (for example, "text/ini”).

7 Apply your changes. 

Notes

• You may need to restart the World Wide Web 
Publishing Service before your changes take 
effect.

• For more information on MIME types, see 
MIME Types in the IIS 6.0 Manager Help.

• The URLScan tool can also be configured to 
block processing of certain file name exten-
sions. Verify these settings. 
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Chapter 14: Importing Issues

About Importing Issues
Enterprise HelpDesk stores most of its issue data 
in the table tblDts of the issue database 
(<project>01.dat for Microsoft Access, 
<project>01_DAT for SQL Server). To import issue 
data into this table, you use the Import Issues 
command (File menu) in HelpDesk Admin.

Projects created with previous versions of 
Enterprise HelpDesk may also store information in 
the table tblFixInformation. In previous versions of 
Enterprise HelpDesk, fields added to the 
Resolution tab were stored in tblFixInformation.

Import Issues

Source table You import issues from a source 
table, which could be a table in a Microsoft Access 
database, a table in a SQL Server database, a 
delimited text file, or a number of other formats.

Source fields Source fields are the fields 
imported from the source table

Destination fields Destination fields are the 
fields in the Enterprise HelpDesk database table 
tblDts.

Mapped fields You map source fields to 
destination fields. When you click Start, the 
mapping determines how the source fields are 
copied to the destination fields.

To import issues:

1 Prepare your issue data and the Enterprise 
HelpDesk database. 

2 Import issue data into a source table.

A source table is an intermediate table that 
holds the issue data you want to import into 
tblDts and tblFixInformation. 

3 Map the fields in the source table to the fields in 
tblDts and tblFixInformation. 

4 Click Start to create new records in tblDts and 
tblFixInformation and to copy the imported 
issues from the source table into these new 
records. 

What Can You Import?
Enterprise HelpDesk uses Microsoft Access 
functionality to import data, so you can import from 
any of the formats and applications supported by 
Microsoft Access:

• Microsoft Access (databases other than the 
open database) 

• Delimited text (values separated by commas, 
tabs, or other characters) 

• Fixed-width text (values arranged so that each 
field has a defined width) 
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• Microsoft Excel (versions 2.x, 3.0, 4.0, and 5.0) 

• Lotus 1-2-3 or 1-2-3/W (.WKS, .WK1, and .WK3 
files) 

• Paradox (version 3.x or 4.x .DB files) 

• FoxPro (version 2.0 and 2.5 .DBF files) 

• dBASE III and dBASE IV (.DBF files) 

• Btrieve (with the data definition files FILE.DDF 
and FIELD.DDF) 

• SQL databases, using ODBC drivers 

• HTML 

With Enterprise HelpDesk, you can import data 
into any of the fields in the tblDts table. This table 
contains most of the issue data.

You cannot use Enterprise HelpDesk to import 
data into the following tables:

• tblUser, which contains user information such 
as the user's logon name, full name, e-mail 
address, and telephone number. 

• tblAttachment, which contains the names of the 
files attached to different issues. 

• Any of the tables that contain the possible 
values for choice lists.

How New Records are 
Created
When you click the Start button, Enterprise 
HelpDesk creates new records in tblDts and 
tblFixInformation, and copies the data from the 
source table into the new records.

In general, if there is no mapping for a field or the 
imported data is invalid, Enterprise HelpDesk 
leaves the field blank. However, there are 

exceptions. The following summarizes how 
Enterprise HelpDesk handles fields when it 
creates new issues.

Issue Number You cannot import issue numbers. 
Enterprise HelpDesk automatically assigns issue 
numbers to issues.

Owner (nUserID) You can import the full name of 
a user or the ID of the user in tblUsr.

If there is no mapping or the user name is not 
found in tblUsr, the field is left blank.

Submitter (nSubmitterID) You can import the full 
name of a user or the ID of the user in tblUsr.

If there is no mapping or the user name is not 
found in tblUsr, the name of the current user is 
stored in the field.

Contact (nOriginatorID) You can import the full 
name of a user or the ID of the user in tblUsr.

If there is no mapping or the user name is not 
found in tblUsr, the name of the current user is 
stored in the field.

Progress You can import the ID of a choice value 
or the choice text. If there is no mapping for a 
choice list field, Enterprise HelpDesk sets the 
Progress field to the choice with ID = 0 (by default, 
New). 

State You cannot import State values. Enterprise 
HelpDesk sets the State field based on the 
Progress field. 

Time and Date fields You can import time and 
date values. If you do not map a date or time field, 
Enterprise HelpDesk sets the field to the current 
date or time. See the tblSubstate choice table for 
the mapping of Progress values to State values.

The Closed Date field value is imported only if the 
State is Closed.
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Imported date values should use the format 
yyyy/mm/dd.

Imported time values should use the time format 
specified in the Regional Options of Windows 
Control Panel.

Choice lists You can import either the choice ID 
(the nID of the choice in the Enterprise HelpDesk 
choice table) or the choice text.

Before You Import
Add fields for imported data Compare the issue 
data you want to import against the fields in tblDts 

and tblFixInformation. If you want to import 
additional issue data for which there are no 
corresponding fields in these two tables, use the 
Field Editor to add the required fields.

Create a Number field to hold imported IDs or 
record numbers If you want to import the IDs or 
record numbers of your data records, create a 
numeric field in Enterprise HelpDesk. You can then 
map your record IDs to this field when you import 
your data. 

Create users and contacts Add users and 
contacts in Enterprise HelpDesk before importing 
data that contains user names.

If you want to import user names into the Owner, 
Submitter, and Contact fields, the names you 
import must match the full names assigned to the 
users in Enterprise HelpDesk. You must use the 
users' full names, not their logon names.

For example, if you import a set of issues owned 
by "Erick Yanez" and there is no such user defined 
in Enterprise HelpDesk, the Owner field is left 
blank. 

Note that you can import the numeric ID for a user 
in the tblUser table (users database).

Customize Enterprise HelpDesk choice lists to 
match the imported data In Enterprise 
HelpDesk, customize choice lists to match the 
values you want to import. You could also change 
the values in the imported data to match the 
Enterprise HelpDesk choice lists. You could do this 
in the original issue data. Or you could use 
Microsoft Access to modify the source table 
created when you imported the original issue data. 

If you are importing text files If your issue data 
is in a text file, the first data record should contain 
the field names. Otherwise, Enterprise HelpDesk 
assigns the fields the names 1, 2, 3, and so on. 
This makes it harder to map the fields.

Also, the first data record should have no blank 
fields. Microsoft Access uses the first data record 
to determine the data types of the fields. For 
example, if a date field is blank, Microsoft Access 
will import it as a text value, and you won't be able 
to get this value into a Enterprise HelpDesk date 
field. 

Back Up Projects Make a backup copy of the 
issue database before you import any data. If you 
make a mistake mapping the fields, having a 
backup copy allows you to change the mapping 
and try again. 

Log off users Make sure no one is using the 
project database while you import issues. Ask all 
users to exit Enterprise HelpDesk before you start 
to import issues. 
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Importing Issues into a 
Source Table
You don't import issues directly into the Enterprise 
HelpDesk tables. Instead, you import the issues 
into a source table. Enterprise HelpDesk copies 
the imported data into its tables after you define a 
mapping between the fields in the source table and 
the Enterprise HelpDesk fields.

To import issues from a file:

1 On the File menu, click Import Issues. 

2 Click New Source Table to import data from a 
text file, spreadsheet, or database table into a 
Microsoft Access table (the source table).

3 In the Files of Type list, click the file format you 
want to import.

To import issues from another Enterprise 
HelpDesk database (or from any other 
Microsoft Access database), click Microsoft 
Access. 

4 Click the file you want to import, and then click 
Import. 

To import issues from an Enterprise HelpDesk 
Access database, select the project01.dat file. 

5 In the Import Objects dialog box, select the 
import options you want.

If you are importing from a text file or spread-
sheet, select the First Row Contains Field 
Names check box. 

If you are importing from a Microsoft Access 
database, select the tables you want to import.

6 Click OK to import the data.

Enterprise HelpDesk creates a source table 
named after the file you selected. 

If you want to import another file, repeat steps 4 
and 5. When you've finished importing, click 
Close.

To import issues from a SQL database:

1 On the File menu, click Import Issues. 

2 Click New Source Table.

3 In the Files of type list, click ODBC.

4 In the Select Data Source dialog box, click the 
Machine Data Source tab.

5 Find the SQL Server data source and click OK.

6 In the SQL Server Login dialog box, type your 
SQL Server login ID and password.

7 Click Options, and in the Database list, click a 
database.

To import issues from an SQL Server database, 
click the issue database.

8 Click OK.

9 In the Import Objects dialog box, select that 
tables you want to import.

For SQL Server databases, the table to import 
is dbo.tblDts.

10 Click OK.

Combining Multiple 
Source Tables
When you import issues into Enterprise HelpDesk, 
you work with one source table at a time. If your 
issue data is stored in two or more tables, you'll 
need to combine those tables into a single source 
table before you can map the source fields to the 
destination fields.
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First, use the Import Issues dialog box to import 
each file into a separate source table. Then use 
Microsoft Access to define a query that joins these 
source tables into a single table.

Importing Issues from 
Enterprise HelpDesk 
Projects
In Enterprise HelpDesk projects, issue data may 
be split across two tables (tblDts and 
tblFixInformation) in the issue database. This 
happened in previous versions of PC-Duo 
Enterprise when you added new fields to the 
Resolution tab: the new fields were stored in 
tblFixInformation.

You need to merge the two tables before you can 
map the fields.

To import issues from Microsoft Access .dat 
files:

1 Add tblDts and tblFixInformation to the list of 
source tables.

2 In the Source Table list, click 
qryMergeCensusTables.

This query adds the combined fields from tblDts 
and tblFixInformation to the Source Fields list.

3 Click Auto Map, and then click Start. 

To import issues from a SQL Server issue 
database:

1 Add dbo.tblDts and dbo.tblFixInformation to the 
list of source tables.

The source tables are named dbo_tblDts and 
dbo_tblFixInformation.

2 Create a new query to merge dbo_tblDts and 
dbo_tblFixInformation. See “Creating Queries 
to Merge Source Tables” on page 123.

3 In the Source Table list, click the new query.

This query adds the combined fields from 
dbo_tblDts and dbo_tblFixInformation to the 
Source Fields list.

4 Click Auto Map, and then click Start. 

Creating Queries to Merge 
Source Tables
The qryMergeCensusTables query merges two 
source tables named tblDts and tblFixInformation. 
If the source tables you want to merge have 
different names, you need to create a new query 
based on qryMergeCensusTables.

To create a new query for merging source 
tables:

1 Exit HelpDesk Admin and open Program 
Files\HelpDeskTools\Admin.mdb in Microsoft 
Access.

2 In the Objects list, click Queries. Click 
qryMergeCensusTables and click Design.

3 In the View menu, click SQL View.

4 In the SQL statements, replace all occurrences 
of tblDts and tblFixInformation with the names 
of the source tables you want to merge.

5 In the File menu, click Save As and type a 
name for the new query.

6 Close Admin.mdb.

7 Open Program 
Files\HelpDeskTools\Admin.mde.
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8 Open the table tblImport and add a new record. 
In the tName column, type the name of the 
query. In the nID column, type a unique, 
numeric ID for the query (use the next available 
nID).

9 Close Admin.mde.

The new query will now be available in the Source 
Table list of the Import Issues dialog box.

Mapping Fields
After you create a source table, you need to define 
a mapping between the fields in the source table 
and the fields in tblDts and tblFixInformation. 
Enterprise HelpDesk uses this mapping to copy 
the imported data into the new records it creates in 
tblDts and tblFixInformation.

To map a source field to a destination field:

1 Click a field in the Source Fields list. 

2 Click a field in the Destination Fields list. The 
data in the source field is copied to this field 
when you click the Start button. 

3 Click the right arrow button to map the fields. 

To remove a mapping:

1 In the Mapped Fields list, click a mapping.

2 Click the left arrow button.

Mapped Fields

Mapping Text Fields Text fields, such as 
tBriefDescription, have a limit of 255 characters. 
Memo fields store large numbers of characters (in 
Access, up to 64000 characters; in SQL Server, up 
to maximum length of 231-1 (2,147,483,647) 
characters). 

Mapping Memo Fields Import data into the 
mDetailedDescription and Notes$Log fields, not 
into the Description$Input and Notes$Input fields.

Importing Choice Lists Import either the choice 
text or the numeric ID of the choice in the choice 
table.

Importing Users, Submitters, and Contacts
Import either the full name of a user, or the 
numeric ID for that user in the tblUser table (users 
database).
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Chapter 15: Integrating Inventory

About Inventory
Help desk integration with PC-Duo Enterprise 
Inventory makes a wealth of information about a 
user's PC immediately available to help desk staff. 
All a help desk analyst has to do is type the 
computer name, and all the software and 
hardware information stored in the PC-Duo 
Enterprise site database becomes available.

Regularly publish the hardware and software 
inventory data in the offline area to the PC-Duo 
Enterprise site database. This ensures that help 
desk staff always have the latest inventory data. 

Software and Hardware Details In a Web view, 
the Inventory tab displays a summary of the 
inventory information for the user’s computer, and 
includes a set of detailed reports.

Only the computer name is stored in the Enterprise 
HelpDesk database. Web views use the computer 
name to dynamically get the inventory information 
from the PC-Duo Enterprise site database.

INVENTORY TAB The Inventory tab provides a wide range of software and hardware information for a user's 
computer. The tab displays a summary of the user's system, and provides a set of detailed reports that provide 
system configuration details, software and hardware change histories, environment variable settings, and 
much more.
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Site-Wide Inventory Reports In addition to the 
Inventory tab, which provides computer-specific 
information, Web views include a set of general 
software and hardware inventory reports. These 
site-wide reports provide information for all 
computers.

Site-Wide Inventory Reports

Remote Control By default, Enterprise HelpDesk 
adds Remote Control buttons to the fields (such as 
Computer Name) used to query the PC-Duo 
Enterprise site database for Inventory information.

Field with a Remote Control button

The Remote Control button ( ) connects to the 

specified computer and starts a PC-Duo ActiveX 
Remote Control session. The remote control 
session runs in a browser window, and does not 
require the PC-Duo Control to be installed on the 
local computer.

How to Integrate Inventory
To integrate an Enterprise HelpDesk project 
with PC-Duo Enterprise Inventory:

1 Link the project to a PC-Duo Enterprise site 
database. 

2 If necessary, modify the query that retrieves 
software and hardware inventory information 
from the site database. By default, Enterprise 
HelpDesk uses the Computer Name field to 
select inventory information from the site 
database.

3 Add the Inventory tab to Web views.

Linking Projects and Site 
Databases
When you link a project to a site database, 
inventory information from that database will be 
available in all Web views of the project that 
include the Inventory tab. You can link each 
Enterprise HelpDesk project to a different site 
database, or multiple projects to the same site 
database. You cannot link a project to more than 
one site database.

By default, a new project is linked to the same site 
database as its base project.

To link a project to a PC-Duo Enterprise site 
database:

1 Log on to HelpDesk Web Admin.

2 Click the Inventory tab.

3 In the Project list, click the project whose Web 
views will display inventory information.

4 If the project is already linked to a site 
database, click Remove.

5 Click Link to open the Link Site Wizard.

6 Click Next to search the local computer for PC-
Duo Enterprise site databases.
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Enterprise HelpDesk needs to download and 
install an ActiveX control, so you may see a 
Security Warning dialog. If you do, allow 
Enterprise HelpDesk to install the ActiveX 
control (it is used to detect site databases on 
your computer). 

When the wizard finishes searching the 
computer, it displays a list of detected sites.

7 Under Detected Sites, click the site you want to 
link to the project.

If the site you want to link to is not listed under 
Detected Sites, you can manually link to the site 
by clicking Other Sites.

8 Click Next.

9 Click Finish.

Editing Links
After a project is linked to a site database, you can 
edit the link.

• If the database location changes, you can 
update the location used by Enterprise 
HelpDesk.

• If the database logon information changes, you 
can change the name and password used by 
Enterprise HelpDesk to connect to the 
database.

• You can change the name and description of 
the site. This information is displayed on the 
Inventory tab when you select a project.

Each project has a separate copy of the link 
information. For example, if the location of a site 
database changes, you need to edit the link for 
each project linked to that site database.

To edit the link between a project and a site 
database:

1 In the Project list, click a project.

2 Click Edit.

3 Edit the link information.

4 Click Apply, or click Cancel to discard your 
changes.

Removing Links
Removing a link removes the information used by 
the project to connect to the site database. It does 
not remove any data from the issue database 
(because none of the inventory information is 
stored in the issue database).

If a project is no longer linked to a site database, 
you should remove the Inventory tab from the Web 
views of the project. Otherwise users will get an 
error if they try to view one of the Inventory reports.

To remove the link between a project and a site 
database:

1 In the Project list, click a project.

2 Click Remove.

Defining the Query
By default, Enterprise HelpDesk uses the 
Computer Name field to select inventory 
information from the site database. The default 
query looks like this:

Client Name = Computer Name
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Client Name is a field in the site database that 
stores the unique network name of a computer. 
Computer Name is a text field in the Enterprise 
HelpDesk project.

To use a different site database field, such as User 
Name (the user name for a Windows user 
account), you have to:

1 Add a new text field to the Enterprise HelpDesk 
project (such as Windows User Name) so help 
desk staff can enter the value that will be used 
in the query.

2 Change the query. For example:

User Name = Windows User Name

Inventory Fields The list of Inventory fields that 
you can use in a query come from the NODES 
table in the site database.

The Inventory field should be a field that has 
unique values. Otherwise Enterprise HelpDesk 
may retrieve inventory data for more than one 
computer. In this case, Enterprise HelpDesk 
displays the inventory data for the first computer 
found, which may or may not be the right 
computer.

HelpDesk Fields The list of HelpDesk fields 
includes all text and number fields that are not on 
the Contact tab.

Adding the Inventory Tab 
to Web Views

To add the Inventory tab:

1 Log on to the Web View Editor, and in the 

shortcut bar, click  Fields.

2 In the Tab list, click Overview. Add the 
Computer Name field to the Export To View list.

3 In the Tab list, click Inventory. Add all the 
Inventory fields to the Export To View list.

You have to export at least the Client Name 
field. To make sure all the Inventory reports 
work, export all the Inventory fields.

If you don't export all the fields, the System 
Summary report will either be incomplete or display 
the error message "The field name is not known".

Hiding the Software and 
Hardware Report Buttons
Adding the Inventory tab also adds the Software 
and Hardware reports to the Web view. You can 
use group permissions to control access to these 
reports.

To hide the buttons, disable these features:

• Report Viewer - Hardware Inventory

• Report Viewer - Software Inventory
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Manually Linking to Other 
Sites
If Enterprise HelpDesk does not automatically 
detect the site you want to link to, you can 
manually create the link. You will need to know the 
database type, name, and location, and whether 
you need a user account and password to log on 
to the site database. See “Gathering Information 
about the Site Database” on page 129.

To manually link a project to a site database:

1 Log on to HelpDesk Web Admin.

2 Click the Inventory tab.

3 In the Project list, click a project.

4 Click Link to open the Link Site Wizard, and 
then click Next.

5 Click Other Sites and then click Next.

6 In the Site Name box, type a name for the site. 
This name is used only by Enterprise 
HelpDesk, and does not change the name of 
the site in PC-Duo Enterprise.

7 In the Description box, type a short description 
of the site.

8 In the Type list, click the type of database you 
want to link to.

9 Specify the database location and name.

10 If you need to log on to the site database, type 
the user name in the User Name box, and the 
password in the Password and Confirm 
Password boxes.

11 Click Test to verify that Enterprise HelpDesk 
can connect to the database.

Gathering Information 
about the Site Database
Before you can integrate PC-Duo Enterprise 
Inventory with Enterprise HelpDesk, you need to 
know a few things about the PC-Duo Enterprise 
site database:

• What type of database is it? (Access or SQL 
Server?)

• If it is a Microsoft Access database, what are 
the name and location of the Microsoft Access 
.mdb file?

If you are connecting to a Microsoft Access 
database:

• Click Browse and locate the database file 
(an .mdb file). 

Look in the network, not the local computer, 
to locate the database. By default, site 
databases are located in the PC-Duo Enter-
prise Data\Databases folder (for example, 
C:\PC-Duo Enterprise Data\Databases).

If you are connecting to a SQL Server 
database:

a. In the Name box, type the name of the 
SQL Server database.

b. In the SQL Server box, type the name of 
the SQL Server. The name of the SQL 
Server is typically the computer name of 
the server.
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• If it is a SQL Server database, what are the 
names of 1) the SQL Server and 2) the SQL 
Server database?

Typically, the name of the SQL Server is the 
name of the computer on which SQL Server is 
installed.

• Do you need a user account and password to 
log on to the site database?

If you have access to a PC-Duo Enterprise 
console, you can find this information yourself. If 
not, ask the person responsible for administering 
PC-Duo Enterprise.

To use the PC-Duo Enterprise console to check 
the database type, name, and location:

1 In the console tree (the left pane), expand the 
site, and then click Site Management.

2 In the Details area (right pane), click Database 
and Licensing.

The Database Location box specifies the type, 
name, and location of the database. For 
example:

ACCESS MySiteDB \\server\share\MySiteDB.mdb 

-or-

SQL SERVER MySite MySQLServer MySiteDB

To use the PC-Duo Enterprise console to check 
the logon information:

1 In the console tree (the left pane), click 
Enterprise Management.

2 In the Details area (the right pane), click Logon 
Information.
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About Remote Control in 
Enterprise HelpDesk 
From inside a Web view, a help desk analyst can 
take control of a user’s computer to investigate 
problems and provide support. To start a remote 
control session, all the help desk analyst has to do 
is type a computer name in a field and click the 
Remote Control button beside the field.

Field with a Remote Control button

The Remote Control button ( ) connects to the 

specified computer and starts a PC-Duo ActiveX 
Remote Control session. The remote control 
session runs in a browser window, and does not 
require the PC-Duo Control to be installed on the 
local computer.

The requirements for remote control are:

• The Web view must be running in Internet 
Explorer. 

The Remote Control button loads a page the 
contains an ActiveX control. This ActiveX 
control allows the help desk analyst to watch, 
share, or control the remote computer.

• PC-Duo Client must be installed on the remote 
computer, and the Client cannot use its license 
key serial number as a security key.

Setting Up Remote Control
To add remote control to a Web view:

1 Add a text field where users can enter the 
computer name or IP address.

This field is used to identify the PC-Duo Client 
on the user’s computer. The HelpDesk project 
includes a Computer Name field for this 
purpose.

2 Add the Remote Control button to the field.

3 Generate the Web view.

Adding Remote Control 
Buttons
To add the Remote Control button to a field:

1 Log on to the Web View Editor.

2 In the shortcut bar, click  Remote Control.

3 In the Available Fields list, expand the tab that 
contains the field.

If you do not see the field, select the Show All 
check box to show all available fields.

4 Select the Can Connect check box for the field.

5 Generate the Web view.

When you select the Can Connect check box for a 
field, the Web View Editor automatically sets the 
URL and URL Button CSS attributes of the field.

The URL field attribute is set to

../../RC/rcviewer.asp?Client=%fieldvalue%
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The first part of the URL (../../RC/rcviewer.asp) is 
the Remote Control URL, which points to this file:

HelpDeskServer\CensusWeb\Views
\CensusWebVD\RC\rcviewer.asp

The RCviewer.asp file is installed with Enterprise 
HelpDesk. You can customize this file to change 
the default remote control settings. For example, 
you can specify the security key used to access 
clients, and enable encryption or compression.

The second part of the URL is a query string that 
identifies the computer to control. When a user 
clicks the Remote Control button, %fieldvalue% is 
replaced with the current contents of the field.

The URL Button CSS field attribute specifies the 
CSS class used for the button.

Configuring PC-Duo 
ActiveX Remote Control
To configure PC-Duo ActiveX Remote Control, 
you edit the file RCviewer.asp, which is located in 
the folder 

HelpDeskServer\CensusWeb\Views
\CensusWebVD\RC\RCViewer.asp

RCViewer.asp contains a number of variables that 
allow you set options and defaults. 

After you customize RCViewer.asp, copy the file to 

HelpDeskServer\CensusWeb\CUSTOMIZEDFILES
\#Project#HelpDesk\RC

This ensures that the next time you generate a 
Web view, the customized copy of RCViewer.asp 
is copied to the output folder.

DEFAULT_SECURITY_KEY Specifies the 
security key used by PC-Duo ActiveX Remote 
Control when it connects to clients. 

The ActiveX control does not support licensing, so 
you cannot type an asterisk “*” to use the license 
key serial number as the security key.

DEFAULT_COMPRESS Enables (1) and 
disables (0) compression. By default, compression 
is disabled.

DEFAULT_ENCRYPT Enables (1) and disables 
(0) encryption. The encryption type is 56bit DES 
encryption. By default, encryption is disabled.

DEFAULT_SCALE_TO_FIT Specifies whether 
the remote screen is scaled to fit in the browse 
window when the remote control session starts. 
Set to 0 to turn off scaling. 

Users can turn on scaling after the remote control 
session starts (by selecting the Scale to Fit check 
box).

DEFAULT_SCROLL_BARS Specifies whether 
the view window has scroll bars when the remote 
control session starts. Set to 0 to turn off scroll 
bars.

Users can turn on scroll bars after the remote 
control session starts (by selecting the Scroll Bars 
check box).

DEFAULT_VIEW_TYPE Specifies the default 
viewing mode (Watch, Share, or Control). Users 
can change the viewing mode after the remote 
control session starts.

DEFAULT_INIT Specifies the name displayed by 
the PC-Duo Client during a remote control 
session. Allows the remote users to identify who is 
controlling their computer. “*” means use the 
computer name.
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Checking Client Security 
Key Settings
PC-Duo ActiveX Remote Control cannot connect 
to clients that use the licence key serial number as 
a security key.

To check if a client is using the serial number 
as a security key:

1 In the Client Configurator, edit the Master 
Profile.

2 On the Users tab, the Security Key box 
contains the security key.

If the Security Key box contains an asterisk (*), 
then the client is using the serial number, and 
the PC-Duo ActiveX Remote Control will not be 
able to connect to the client.

Removing Remote Control 
Buttons

To remove the Remote Control button from a 
field:

1 Log on to the Web View Editor.

2 In the shortcut bar, click  Remote Control.

3 In the Available Fields list, expand the tab that 
contains the field.

4 Clear the Can Connect check box for the field.

5 Generate the Web view.
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Chapter 17: Customizing Enterprise 
HelpDesk

Power Customizations
This section covers a variety of ways to customize 
Enterprise HelpDesk, all of which are considered 
“power customizations”.

Power customizations involve using the Microsoft 
Access development environment (or the SQL 
Server Query Analyzer), Visual Basic, Javascript, 
and other advanced techniques to customize 
Enterprise HelpDesk. 

About the Databases

Issue database Stores the issues and their 
revision histories.

Project definitions database Stores all project-
related definitions, including fields, queries, sorts, 
layouts, reports, and notifications.

Users database Stores user accounts, contacts, 
and the information entered on the Contact tab.

See Appendix B, “Databases.”, for more 
information on the databases and tables referred to 
in this chapter.

Editing Databases
Some customizations require that you edit tables 
in the Enterprise HelpDesk databases.

To edit a table in an Access database:

1 Start Microsoft Access and open the database.

2 Under Objects, click Tables.

3 Locate the table you want to edit, and double-
click it.

4 Locate the row you want to modify and make 
your changes.

5 Click in another row, or close the table, to save 
your changes.

To edit a table in a SQL Server database:

1 Start the SQL Query Analyzer.

2 In the Object Browser, locate the database and 
table you want to edit.

3 Right-click the table and click Open.

4 Locate the row you want to modify and make 
your changes.

5 Click in another row, or close the table, to save 
your changes.

Database Jet/Access SQL Server

Issue <project>01.dat <project>01_DAT

Project 
definitions

<project>02.def <project>02_DEF

Users users.mdb USERS_MDB
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Creating an Attachments 
Field

Create an attachments field:

1 Open the project definitions database.

2 Open the tblDtsFields table.

3 Copy the record for the Attachments field and 
paste it into a new record.

4 Change the nID, tTableName, tName, tCaption, 
tLabelCaption, and tBoundControlName fields.

5 If you want to put the new attachments field on 
a different tab, change the nDestinationTabID 
field.

Create an attachments table

1 In the issue database, copy tblAttachments. 
Use the tTableName of the new attachments 
field as the name.

2 Change the name of the tAttachments field in 
the new table. Use the tName of the new 
attachments field as the new name.

Create a temporary attachments table

In the users database, copy the 
tblAttachmentsTemporary table. Name the new 
table <tTableName>Temporary.

Add a record to tblDtsTables

In tblDtsTables (project definitions database) copy 
the record for the attachments table. Change 
tTableName and tTableNameTemp to the names 
of the new attachments tables in the issue and 
users databases.

Customizing URL Buttons
URL buttons are implemented as A elements with 
background images. 

Each of the default URL buttons (URLButton , 

MailToButton , RemoteControl ) has four 
CSS classes, along with four associated :hover 
classes. The Web View Editor automatically 
determines which CSS class to use based on the 
field type and the field attribute settings. For 
example, the CSS classes used for URLButton are 
determined as follows:

tblDtsFIelds 
field

Description

nID Unique ID for the field.

tTableName Name of the attachments table in 
the issue database. The 
attachments table stores 
information about attached files.

Also, the name of a table in the 
users database (the table is named 
<tTableName>Temporary).

tName Name of the field in the attachments 
table of the issue database. Stores 
the name of an attached file.

tCaption Label used in choice lists.

tLabelCaption Default label for the field in a Web 
view.

tBound
ControlName

Internal name for the field.

When These CSS classes are used

Column Span=1 URLButtonState1

URLButtonState1:hover
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These CSS classes are defined in the 
CensusMain.css style sheet in 
CensusWeb\Views\CensusWebVD\Theme\css. 

Each different pair of CSS classes positions the 
button differently, by changing the value of the 
CSS left property.

The :hover pseudo classes change the 
background image to give a rollover effect. 

To define your own buttons, copy the URLButton 
classes, change the class names, and point the 
background-image property to your button images. 
For example:

.MyButtonState1
{

background-image:
url(../images/buttons/mybutton_off.gif);

background-repeat:no-repeat;
display:block;
position:absolute;
left:80%;
width:24px;
height:24px;
top:0px;

}

For button rollovers, you’ll need two versions of 
your button image. Your button images should 
have a one or two pixel margin (so there’s some 
space between the field and the button). 
Alternatively, you could adjust the left property.

To use these new classes, just use MyButton as 
the value of the URL Button CSS attribute.

Customizing the Inventory 
Tab
You can easily customize the list of reports that 
appears on the Inventory tab. You can:

• Remove reports.

• Reorder the list.

• Change report names (captions).

• Add separators between reports.

• Change the title of the reports list (by default, 
the title is “Reports”).

To customize the list of reports on the Inventory 
tab, edit the file tmplInventoryTab.rec, which is 
located in the folder

HelpDeskServer\CensusWeb\CUSTOMIZEDFILES
\#Project#HelpDesk\#AllWebViews#\Misc

In templInventoryTab.rec, the reports list is stored 
in an array named arrReports. arrReports is an 
array of arrays, that is, each element in arrReports 
is itself an array. Each of these arrays contains 
information about a different report.

The following code fragment shows how a report is 
added to the list:

// start Reports list
arrReports = [

// array of report information
[ GetOpenReportOnClickFunction(...),
“<caption>”, “<tooltip>”, “<html-markup>” ]

] // end of Reports list

GetOpenReportOnClickFunction(...) returns the 
onClick event handler, which opens the report 
when a user clicks it. Do not edit this function call.

<caption> is the report name displayed in the list. 

<tooltip> is the text displayed when a user points 
to the button beside a report.

Column Span=2

CSS Class =
MemoFieldWidth

URLButtonSpanTwoState1

URLButtonSpanTwoState1:hover

Column Span=2

CSS Class = 
SpanTwoWidthOne

URLButtonTwoWidthOneState1

URLButtonSpanTwoWidthOneState1:
hover

Field already has a 
button (for example, 
a date field).

URLButtonSecondButtonState1

URLButtonSecondButtonState1:hover

When These CSS classes are used
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In tmplInventoryTab.rec, the caption and tooltip are 
specified by text that looks like this:

<Mq:ReportCaption>155.10</Mq:ReportCaption>

When you generate a Web view, this text is 
replaced with the name of the report.

<html-markup> is html markup that is inserted 
into the list after the report. For example, you can 
add separators by adding “<hr />”.

To reorder the list of reports:

1 In tmplInventoryTab.rec, change the order in 
which the reports are added into the arrReports 
array.

2 Some reports add a separator (“<hr/>”), so you 
may have to edit the report arrays to put the 
separators in the right places.

3 Generate the Web views that include the 
Inventory tab.

To remove reports:

1 In tmplInventoryTab.rec, comment out (or 
delete) the reports that you want to remove.

2 Generate the Web views that include the 
Inventory tab.

To change a report name:

1 In tmplInventoryTab.rec, replace the text that 
looks like this:

“<Mq:ReportCaption>155.10</Mq:ReportCaption>”
with the report name you want to see.

Remember, the tooltip is the second element in 
the array, and the caption is the third.

2 Generate the Web view.

To add a separator between two reports:

1 In tmplInventoryTab.rec, find the array for the 
first of the two reports.

2 Change the fourth element of the report array 
from "" to "<hr/>" (or to whatever HTML you 
want to use as a separator).

3 Generate the Web views that include the 
Inventory tab.

To change the title of the reports list:

1 In tmplInventoryTab.rec, find this 
document.write statement (near the end of the 
file):

document.write(
m_objWebPart.GetHTML_ListContainer(

"Reports",
"../../theme/images/images/ListImage.gif",
arrReports

)
);

2 Change the first argument to 
GetHTML_ListContainer() from “Reports” to the 
title you want to see.

3 Generate the Web views that include the 
Inventory tab.

Customizing Reports with 
Crystal Reports

Building Custom Reports

Using Crystal Reports, you can add features such 
as charts, formulas, field highlighting, and running 
totals to a listing report. You can also import 
graphics (such as company logos) and completely 
reformat a listing report.
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To build custom reports, you need Crystal Reports 
v8.5 or v9.0. Crystal Reports must be purchased 
separately from Crystal Decisions or another 
supplier. You also need a Report Creation API 
license.

A Customized Listing Report

Customized listing reports appear on the Custom 
tab of the HelpDesk Web Report Viewer. After you 
customize a listing report, you cannot edit it in the 
Report Editor. You must use Crystal Reports.

Step 1: Creating a Listing Report
A custom report is based on a listing report. The 
listing report defines the data (the issues and 
fields) that will be available in Crystal Reports 
when you customize the report.

To create a new listing report:

1 In HelpDesk Admin, create a new listing report 
in the Report Editor with the desired query and 
sort.

2 Add all the fields you want to use in the 
customized report.

Do not select the Custom check box.

Step 2: Create an .rpt File
Crystal Reports uses the .rpt file format to save 
reports. When you view a report in a Web view, 
HelpDesk Web creates an .rpt file for the report. 
The .rpt file is saved inside the view folder, for 
example, in:

C:\Program Files\PC-Duo Enterprise
\HelpDeskServer\CensusWeb\Views

\CensusWebVD\HelpDesk_HelpDesk\Reports

For each report, Enterprise HelpDesk requires two 
.rpt files: one for the portrait orientation, and one 
for the landscape orientation.

To create an .rpt file:

1 In HelpDesk Admin, set the Standard Report 
Engine option to Crystal Reports 9 or Crystal 
Reports 8.5, so Enterprise HelpDesk uses 
Crystal Reports for listing reports.

2 Log on to a Web view and click Reports to open 
the Report Viewer. 

3 Click the Listing tab, click the new report, and 
then click View. 

4 Save a copy of the report from the Report 
Viewer and use this as your working copy. 
When you save a report from the Report 
Viewer, the .rpt file includes the issue data, so 
you can preview the report in Crystal Reports. 
The .rpt file created by the Web view does not 
include any issue data. 

5 Click Show and then in the Layout list, click 
Landscape. 

6 View the landscape version of the report to 
create the .rpt file for the landscape orientation.

You don't need to save the landscape report 
from the Report Viewer. You can create the 
customized version of the landscape report 
from the customized portrait report. 
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Step 3: Move the Report to the Custom 
Tab

To move a listing report to the Custom tab:

In HelpDesk Admin, open the listing report in the 
Report Editor and select the Custom check box.

Step 4: Customize the Report in Crystal 
Reports

To customize the report in Crystal Reports:

1 Open the .rpt file with Crystal Reports. Use the 
copy of the report you saved from the Report 
Viewer. 

2 Edit the report. For example, you can insert 
graphs, change fonts and colors, insert custom 
headers and footers, group and sort fields, hide 
fields, add summary fields (such as count or 
average), and much more.

3 Save the .rpt file. 

4 Copy the .rpt file to the Reports folder and 
rename the .rpt file so it uses the default report 
name. 

5 Log on to the Web view and open the report.

Step 5: Copy the customized report to the 
CustomizedFiles folder
When you generate a Web view, the contents of 
the Reports folder are deleted. To save your 
customized reports and make sure they are copied 
every time you generate a Web view, you have to 
copy the .rpt files to the CustomizedFiles folder. 

See “Customizing Web View Files” on page 96 for 
more information on the CustomizedFiles folder.

Customizing HTML 
Reports

About HTML Reports

By default, Web views use HTML to display Listing 
reports. You can customize this HTML by editing 
the XML files that define the HTML page template.

• TmplRpt_listing_<type>.xml

HTML template for an HTML report page, 
including the table that contains the report data.

• ValueCell_listing_<type>.xml

HTML template for a table cell that displays a 
field value.

• CaptionCell_listing_<type>.xml

HTML template for a table cell that displays a 
field caption.

<type> is either “tabular” or “multicolumn” (the two 
types of listing reports).

You can find these files in the Reports folder of a 
Web view, for example:

C:\Program Files\PC-Duo Enterprise
\HelpDeskServer\CensusWeb

\Views\CensusWebVD
\HelpDesk_HelpDesk\Reports

These XML files are dynamically created the first 
time you view a report.

Enterprise HelpDesk generates the HTML reports 
by transforming raw XML data into HTML using an 
XSL style sheet. The three .xml files are templates 
for the XSL style sheet.
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Changing the CSS Styles
The CSS styles used by the HTML reports are 
defined in the TmplRpt_listing_<type>.xml file.

Reports are used to format attachments to e-mail 
notifications. Using an embedded style sheet 
ensures that notification attachments are 
formatted. If you want to use an external style 
sheet, you must use an absolute URL to locate the 
style sheet.

PlaceHolders
The empty elements (such as <ReportHeader/> 
and <TableCells/>) in TmpRpt_listing_<type>.xml 
are placeholders. When Enterprise HelpDesk 
generates a report, it replaces these placeholders 
with report-specific data.

• <ColumnHeaders/> is a placeholder for the 
field titles.

The file CaptionCell_listing_<type>.xml 
contains the HTML template for a field title, 
where <CellWidth /> and <CaptionCell /> are 
the width and title from the Report Editor.

• <TableCells/> is a placeholder for the field 
values. 

The file ValueCell_listing_<type>.xml contains 
the HTML template for a field value.

• <ReportCaption /> is the name given to the 
report in the Report Editor.

• <ReportHeader /> is the title text from the Page 
Editor. <ReportHeaderCSS /> is the formatting 
applied to the title text.

• <PageHeader /> is the header text from the 
Page Editor. <PageHeaderCSS /> is the 
formatting applied to the header text.

• <PageFooter /> is the footer text from the Page 
Editor. <PageFooterCSS /> is the formatting 
applied to title text.

To see the generated HTML, open a report in a 
Web view and then view the page source.

Customizing the Report 
Used to Print Issues
The information in this section applies only if you 
use Crystal Reports for listing reports. See 
“Viewing Reports” on page 35 for more information 
on using Crystal Reports for listing reports.

The report used to print issues is named “Current 
Issue - Detailed”. If you edit this report in the 
Report Editor (of HelpDesk Admin), the changes 
apply to all Web views of the project.

Each view has two versions this report:

rptListingGCurrent$Record$-$DetailedPortrait.rpt
rptListingGCurrent$Record$-$DetailedLandscape.rpt

You can find these files in the 

CensusWebVD\<project>_<view>\Reports 

folder, where <project> is the name of the project 
and <view> is the name of the Web view. The 
portrait version of the report is used to print issues.

To customize the report:

1 View the portrait version of the report in a Web 
view. You can either print an issue or view the 
report with the Report Viewer.

Viewing the report creates the .rpt file.

2 In the Report Editor (HelpDesk Admin), mark 
the report as a custom report (select the 
Custom check box).
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This prevents Enterprise HelpDesk from 
overwriting the customized report if the report 
definition changes.

3 Using Crystal Reports, customize the report 
(add graphics, change fonts, rearrange and 
align fields).

4 Put a copy of the customized report in

CUSTOMIZEDFILES
\#Project#<project>

\#WebView#<view>
\Reports

When you regenerate the Web view, the 
customized version of the report is copied to the 
Web view folder.

Deleting Users
You can disable users, but this does not delete the 
user from the database, because existing issues 
may refer to the user (as either the owner, 
submitter, or contact). If you don’t want to see 
disabled users in the Contact, Owner, and 
Submitter fields, you can either:

• Delete the user from the users database.

• Remove disabled users from the Contact, 
Owner, and Submitter choice lists.

However, if an existing issue references the user in 
its Owner, Submitter, or Contact field, the field will 
be empty. In some cases this may cause an 
“invalid use of null” error. 

If existing issues reference disabled users, it may 
not be practical to delete the user accounts for ex-
employees or contractors, because you probably 
want to keep a historical record of who reported, 
submitted, and resolved issues. In that case, you 
may want to add some sort of prefix to the names 
of disabled accounts.

Before you delete a user or remove the user from 
the choice lists, you should check if any existing 
issues reference the user.

To check if a user is referenced by existing 
issues:

1 Open the users database, and open the tblUser 
table.

2 Find the record for the user you want to delete, 
and get the value in the User ID field. 

For example, if you want to delete the demo 
user, the User ID is 2.

3 Open the issue database for the project.

4 Open tblDts and look for the user ID in the 
columns of choice list fields that use tblUser. 
For example, nUserID (Owner), nOriginatorID 
(Contact), and nSubmitterID (Submitter)

To sort the table by user ID, click in the 
nUserID, nOriginatorID, or nSubmitterID 
column. Then in the Record menu, click Sort 
and then click Sort Ascending or Sort 
Descending. Then scroll through the records to 
see if the user owns any records.

Note that the revision history (the tblDts_History 
table in the issue database) also references users. 
And while unlikely, queries, summary reports, time 
reports, and notifications may also reference 
specific users. The definitions of queries, reports, 
and notifications are in the project definitions 
database.

If existing issues do reference the user, you can 
always reassign open issues, but closed issues 
can be a problem. You may want to keep a 
historical record of who reported, submitted, and 
resolved an issue. If so, you have to keep the 
disabled users. 
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Removing Disabled Users 
from Choice Lists
Instead of deleting users from the users database, 
you can prevent the Owner and Contact lists from 
showing disabled users. However, if an existing 
issue references the deleted user in its Owner or 
Contact field, the field will be empty. 

Removing disabled users from choice lists:

1 Open the project definitions database.

2 Open tblDtsFields and find the owner (nID = 11) 
and contact (nID = 13) records.

3 In the tWhere field, add "And fDeleted = 0" to 
the Where clause. For example:

Where (([nID] >= 0 And [tName] <> '') Or [tName] 
= '<User>') And fOriginator = 0 And fDeleted = 0

Adding a Choice List of 
Users or Contacts
To add a choice list of users:

1 In the Field Editor, create a new field.

2 In the Type list, click Multi-Choice List or Single 
Choice List.

3 In the Table Containing Choices list, click 
tblUser.

tblUser cannot be viewed or edited in the 
Choice Editor.

4 Apply the changes (click Apply or Close).

5 Open the project definitions database.

6 Open tblDtsFields and find the record for the 
new field. In the tWhere field, type:

Where (([nID] >= 0 And  [tName]  <> '') Or 
[tName]  = '<User>') And fOriginator = 0

The [nID] >= 0 condition removes the macros 
defined in tblUser (the users database):

The user with nID = 0 is the <None> macro.

The fOriginator = 0 condition removes contacts, so 
that the list contains users only.

To add a choice list of users and contacts:

Use this tWhere clause:

Where (([nID] >= 0 And  [tName]  <> '') Or 
[tName]  = '<User>')

Timestamping

Description
<script type='text/javascript'>
document.write( 

parent.objCustomCode.getCodeAfterField( 
'%fieldname%', 
'mem_29_txtDetailedDescription' )

)
</script>

User ID User Name

-4 <Contact>

-3 <User>

-2 <Previous Owner>

-1 <Owner>
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Description Log
<script type='text/javascript'>
document.write( 

parent.objCustomCode.getCodeAfterField( 
'%fieldname%', 
'' ) 

)
</script>

Notes
<script type='text/javascript'>
document.write( 

parent.objCustomCode.getCodeAfterField( 
'%fieldname%', 
'mem_56_mem_56_Notes' )

) 
</script>

Notes Log
<script type='text/javascript'>
document.write( 

parent.objCustomCode.getCodeAfterField( 
'%fieldname%', 
'' )

)
</script>

Adding TimeStamping
Changes to a memo field can be time-stamped. 
For example, you can time-stamp the changes, 
comments, notes, and follow-ups that are added to 
an issue description over time. 

Timestamping requires two memo fields, one for 
input and one for storing the timestamped log. 
When an issue is saved, the Web view automati-
cally copies the contents of the input field to the log 
field.

Step I: Add two memo fields:

Use the Field Editor to create two memo fields 
(one for input of new data, and one for displaying 
the timestamped log). For the input field, clear the 
Show in Choice Lists and Maintain Revision 
History check boxes.

Step II: Get the name of the timestamp log 
field:

You need to get the internal name of the 
timestamp field. The internal name is a name that 
looks like "mem_58_mem_58_FieldName" (and 
that is not a typo).

If you have Microsoft Access, you can get the 
internal name by opening the project definitions 
database and looking in the tblDtsFields table. The 
field name is composed from the values in the nID 
and tBoundControlName fields:

“mem_<nID>_<tBoundControlName>”

The tBoundControlName field includes a repeat of 
the”mem_<nID>” string. That is why the string 
appears twice in the name.

If you don’t have a copy of Microsoft Access, 
generate a Web view for the project. Then get the 
value of the name attribute of the text area control 
associated with the timestamp log field. You can 
find this in the tmplRecord.html file, which is 
located in the HTML folder of the view: 

CensusWebVD\<project>_<view>\HTML

Step III: Set the HTML code after control 
attributes:

Before you generate a Web view, you must export 
the two fields and set their HTML code after control 
attributes.

1 For the input field, enter this HTML code (as a 
single line of text):

<script type='text/javascript'>
document.write( 

parent.objCustomCode.getCodeAfterField( 
'%fieldname%', 
'<timestamp-log-field-name>' ) ) 

</script>
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<timestamp-log-field-name> is the field name 
you found in the previous step. Note that the 
javascript is case sensitive.

2 For the timestamp log field, enter this HTML 
code (as a single line of text):

<script type='text/javascript'>
document.write(

parent.objCustomCode.getCodeAfterField(
'%fieldname%',
'' ) )

</script>

Customizing Timestamping

By default, each time a new entry is added to the 
timestamp log, a line that looks like this is added:

December 11,2001 4:38 PM analyst   (New)

You can customize the way the timestamp log is 
formatted by editing MoveControlData() in 
Js\CustomCode.js. For example, you could insert 
a line of dashes to separate entries, add tabs (\t), 
or add more line breaks (\r):

objTargetControl.value="--------------------------------\r" + 

getDateTime() + "\r" +

objSourceControl.value + "\r\r"

objTargetControl.value + "\r";

getDateTime() returns a string that includes the 
date, time, name of the current user, and current 
value of the Progress field.

objSourceControl.value is the new input to add to 
the timestamp log, and objTargetControl.value is 
the content of the timestamp log.



CHAPTER 17146
Customizing Enterprise HelpDesk
TIMESTAMPING WITH ONE MEMO FIELD You can implement timestamping with just one memo field. To do 
this, you use the HTML code before control attribute to insert a text area control above the timestamp log field. 
This text area control is not tied to any database field. It exists only to allow input, which is copied into the times-
tamp log field when you save the issue. The advantage to this approach is that you avoid storing an extra 
memo field in the issue database. The disadvantage is that you cannot use HelpDesk Admin or the Web View 
Editor to customize the input text area (for example, to change the caption or position of the control). 

Html code after control:

<script type='text/javascript'>
document.write(parent.objCustomCode.getCodeAfterField('%fieldname%',''));
</script>

Html code before control:

<script type='text/javascript'>
document.write(parent.objCustomCode.getInputMemoField('mem_desc', '%fieldname%'));

</script>

New function in CustomCode.js:

function getInputMemoField( inputFld, logFld )
{

var strOutput;

strOutput="<textarea  class='MemoFieldWidth'  ";
strOutput+="name='" + inputFld + "' ";
strOutput+="wrap=physical  rows=10 cols=73";
strOutput+="onfocus=\"parent.MemoGotFocus('" + inputFld + "')\" ";
strOutput+="onchange=\"parent.OnMemoRecordChanged('" + inputFld + "')\" ";
strOutput+="onkeypress=\"parent.OnMemoRecordChanged('" + inputFld +

"')\"></textarea><br>";

strOutput+="<script type='text/javascript'>";
strOutput+="document.write(parent.objCustomCode.getCodeAfterField('" + inputFld + "','" +

logFld + "'))</script>";
strOutput+="</script>";

return strOutput;
}

New declaration in CustomCode.js:

// Declaration of the public functions
this.getInputMemoField=getInputMemoField;
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Changing the Format of Attachments
One of the choices in the Include list (Notification 
Editor) is Detailed. Detailed attaches a report to 
the notification message. This report includes 
most, if not all, of the fields for an issue.

If you do not use Crystal Reports, attachments can 
be either HTML files or text files. If you do use 
Crystal Reports, attachments are RTF files by 
default. You can change this to be PDF, text, or a 
number of other formats.

See “Viewing Reports” on page 35 for more 
information on using Crystal Reports for listing 
reports.

To change the format of a notification 
attachment:

1 Open the project definitions database.

2 In tblMailContents, change the nFormatType for 
the attachments. (Attachments have nType = 3 
in tblMailContents).

nFormatType constants:

Attaching Information
By default, the Revision Record and Summary are 
included in the body of the e-mail notification 
message. You can include this information as 
separate attachments.

To do this, open the project definitions database 
and in tblMailContents change the nType to 3. 
nType determines where the content is put in the 
e-mail message.

NoFormat 0 Excel40 20

CrystalReport 1 Excel50 21

DataInterchange 2 Excel50Tabular 22

RecordStyle 3 ODBC 23

RichText 4 HTML32Standard 24

Comma Separated
Values

5 Explorer32Extend 25

TabSeparatedValues 6 NetScape20 26

CharSeparated
Values

7 Excel70 27

Text 8 Excel70Tabular 28

TabSeparatedText 9 Excel80 29

PaginatedText 10 Excel80Tabular 30

Lotus123WKS 11 PortableDocForm
at

31

Lotus123WK1 12 HTML40 32

Lotus123WK3 13 CrystalReport70 33

WordForWindows 14 ReportDefinition 34

Excel21 18 ExactRichText 35

Excel30 19 XML 36

nType Description 

1 Subject 

2 Body of e-mail message

3 Attachment 



CHAPTER 17148
Customizing Enterprise HelpDesk
Adding Custom Mail Contents
In the Notification Editor, the Include list specifies 
what to include in an e-mail notification message. 
You can add items to this list. The items can be 
used as the message subject, inserted in the 
message body, or included as attachments to the 
message.

To add an item to the Include list of the 
Notification Editor:

1 Define a function in the macro70.bas file. 

This function should return the content you 
want to include in the e-mail message.

macro70.bas is located in the project sub-folder 
of the HelpDeskServer folder (for example:
HelpDeskServer\HelpDesk\macro70.bas)

2 Open the project definitions database, and in 
the tblMacro table, add a row for the new 
function.

tName is the name of the macro.

tFunctionName is the name of a function 
defined in macro70.bas.

nType specifies what arguments the function 
takes:

1 = No Arguments 
2 = Issue Record 
3 = Revision history 
4 = Expression 

3 In the tblMailContents table, add a row for the 
macro.

Use the same tName as you did in tblMacro.

nType specifies where to include the contents:

1 = subject
2 = body
3 = attachment

nFormatType specifies the format:

4 = rtf
8 = text
14 = word
31 = pdf
32 = html40

When nType = 2, nFormatType must be 8 
(text). Otherwise you'll end up with a plain text 
e-mail message that contains RTF or PDF and 
is never sent. This will hold up all your notifica-
tions. 

Example Macros
This function returns a string:

Public Function 
GetCustomSubject(oCensusApplication, 
lngDtsRecordID, oExpression, recRevisionHistory)

GetCustomSubject = "Your subject goes here."
End Function

This function returns the contents of a text file:

Public Function GetCustomMsgBody( 
oCensusApplication, lngDtsRecordID, oExpression, 
recRevisionHistory )

Dim fsObj
Dim txtStreamObj
Dim emailbody
Dim strFileName

strFileName = "C:\Messages\msg.txt"

Set fsObj = CreateObject(
"Scripting.FileSystemObject")

Set txtStreamObj = fsObj.OpenTextFile(
strFileName, 1, False, False)

emailbody = txtStreamObj.ReadAll

txtStreamObj.Close
GetCustomMsgBody = emailbody

End Function
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This example shows how to write a function that 
takes the revision history as an argument and 
extracts a field value.

Public Function GetSubject(oCensusApplication, 
lngDtsRecordID, oExpression, recRevisionHistory)

Dim lngLastRevisionNumber 
Dim rstValue    
Dim variablename

If oCensusApplication Is Nothing Then
Exit Function

End If

If recRevisionHistory Is Nothing Then
Exit Function

End If

'get the last revision number
GetRevisionNumberRange recRevisionHistory, 0, _

lngLastRevisionNumber

' Get the value for the field from the table
' of the last revision in the given set.

Set rstValue = oCensusApplication.CurrentProject._
DataStores.Item(32). _
GetConnection(1).Execute( _

 "SELECT tBriefDescription FROM tblDts_History_
WHERE nID=" & lngDtsRecordID _
& " AND nRevisionNumber=" _
& lngLastRevisionNumber, , 1)

' Build subject line that looks like:
' HELPDESK [Ticket 37] - Cannot print PDF file
If Not rstValue.EOF Then

If Not IsNull(rstValue.Fields(0).Value) Then
GetSubject =  "HELPDESK [Ticket " &_

lngDtsRecordID & "] - " &_
rstValue.Fields(0).Value

End If
End If 
End Function

In the SELECT statement, tBriefDescription is the 
internal name for the Summary field. You can find 
the internal field names in the tName column of the 
tblDtsFields table in the project definitions 
database.

Adding New Notification Reports
Enterprise HelpDesk can use reports to format 
information included in e-mail notifications. For 
example, the Detailed and Summary items are 
formatted by reports. You can define new reports 
and add them to the list of items that can be 
included in an e-mail notification message.

To add a new report for notifications:

1 In HelpDesk Admin, use the Report Editor to 
define a new listing report.

2 Save and preview the report.

3 Exit HelpDesk Admin.

4 Open the project definitions database.

5 Open the tblSystemCustomReports table, find 
the record for the report you just created, and 
get the nID value.

6 Open the tblMailContents table and create a 
new record.

Field Description

nID Next available ID number for a 
record in the tblMailContents 
table.

tName Name that will appear in the 
Include list in the Notification 
Editor.

nType 2 = include in message body
3 = attachment
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The report should now be available in the Include 
list of the Notifications Editor.

If you’re using Crystal Reports for your listing 
reports, you’ll have to create a Crystal Report 
report file (.rpt) for the new notification report.

To create an .rpt file for your notification 
report:

1 View the report in a Web view.

This creates an .rpt file in the 
CensusWebVD\<project>_<view>\Reports 
folder. For example:

C:\Program Files\PC-Duo Enterprise
\HelpDeskServer\CensusWeb\Views
\CensusWebVD\HelpDesk_HelpDesk\Reports

2 Copy the .rpt file to the 
HelpDeskServer\<project>\Reports folder. For 
example:

C:\Program Files\PC-Duo Enterprise
\HelpDeskServer\HelpDesk\Reports

3 Rename the file by removing “portrait” (or 
“landscape”) from the .rpt file name.

Submit-only Views 
Without Persistent 
Cookies
Submit-only views use persistent cookies to store 
contact information (such as the user's name and 
e-mail address). You can set up submit-only views 
so that submitters do not have to enter their 
contact information. Consequently, the submit-only 
views will use session cookies only.

To do this, you enter the contact information into 
Enterprise HelpDesk yourself, and then provide 
each user with their own specific URL.

To set up submit-only views that do not use 
persistent cookies:

1 Use HelpDesk Web Admin to create contacts if 
the submit-only view is intended for people who 
do not have Enterprise HelpDesk user 
accounts and who you want to allow to submit 
bugs directly into Enterprise HelpDesk. If the 
submit-only view is intended for people who are 
already have Enterprise HelpDesk user 
accounts, the user information already exists in 
Enterprise HelpDesk.

2 Send everybody who will submit issues their 
personal URL for the submit-only view.

tFunction The GenerateReport function 
takes care of generating the 
report for the notification 
message.

tArguments <nID>.10, where <nID> is the ID 
of the report in 
tblSystemCustomReports.

nFormatType 4 = rtf
8 = text
14 = word
31 = pdf
32 = html40

See “Changing the Format of 
Attachments” on page 147 for 
more format type values.

When nType = 2, nFormatType 
must be 8 (text).

Field Description
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The personal URL for a contact will look something 
like this:

http://server/helpdesk/logon.asp
?View=HelpDesk%2FReport%20Issue&CookieInfo
13=14;Emily

The first part of the URL is simply the URL for the 
Enterprise HelpDesk logon page. The second part 
of the URL (in bold) is the query string. The View= 
part of the query string specifies the project and 
view:

View=<project>%2F<view>

%2F is the escape sequence for a forward slash 
(/). 

The CookieInfo13= part of the query string 
specifies the user’s contact information:

CookieInfo13=<User ID>;<Personal Name>

<User ID> is the numeric ID assigned to the 
contact or user. You can find this value in the 
tblUser table of the Users database. <Personal 
Name> is the name of the contact or user.

Spaces in the project, view, and personal name 
must be replaced with the escape sequence %20.

Branding the Web View 

Replacing Logos
To replace the logo, edit the td.Logol and div.Logo 
rules in CensusMain.css. The background-image 
property specifies the logo image.

Note that Enterprise HelpDesk uses two versions 
of the logo, “logol” for light backgrounds (Web view 
page) and “logo” for dark backgrounds (logon 
page).

/* logo on a Web view page */

td.Logol

{

background-image:url(../images/logos/logol.gif);

background-repeat:no-repeat;

display:block;

left:27px;

width:200px;

height:60px;

position:absolute;

}

/* logo on the Enterprise HelpDesk logon page */

div.Logo

{

background-image:url(../images/logos/logo.gif);

background-repeat:no-repeat;

display:block;

left:27px;

width:200px;

height:60px;

position:absolute;

b-order:3 orange solid;

}

About Branding Web Views
You can customize the look of a Web view by 
editing the CensusMain.css style sheet in 
CensusWeb\Views\CensusWebVD\Theme\css. 

Put a copy of your customized style sheet in the 
CUSTOMIZEDFILES folder. For example, in 
#AllProjects#\Theme\css or 
#Project#HelpDesk\Theme\css.
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View Toolbar
The view toolbar is the top part of a Web view, 
where the logo and the Help, Log Off, and other 
buttons are displayed.

body.TopToolbarBody sets the background color.

td.Logol sets the logo image displayed in the 
toolbar.

Summary List Toolbar
The toolbar has three parts: the top (with the 
Query, Sort, and Layout lists), the middle (the Ad-
hoc Query Editor), and the bottom (used for 
bottom rounded corner images).

For the top part:

• body.ToolbarBody sets the background color.

This class is also used by many dialog boxes, 
such as Attach File, History, and Options.

• ToolbarLeft, ToolbarCenter, and ToolbarRight 
set the background images. ToolbarCenter also 
sets the font properties for the captions.

For the middle part:

• body.ToolbarM sets the background color.

• ToolbarMLeft, ToolbarMCenter, and 
ToolbarMRight set the background images. 
ToolbarMCenter also sets the font properties for 
the captions.

For the bottom part:

• body.ToolbarB sets the background color.

• ToolbarBLeft, ToolbarBCenter, and 
ToolbarBRight set the background images.

Summary List Header
The appearance of the heading row for the 
Summary List is controlled by:

• headerSummaryList
• HeaderSummaryListCellCenter
• HeaderSummaryListCellLeft
• HeaderSummaryListCellRight

headerSummaryList sets properties for the entire 
table. The three HeaderListSummaryCell classes 
are used to set background images. If you don’t 
want to use images, you can comment out the 
HeaderListSummaryCell classes and use header-
SummaryList to set the background and text 
colors.

Summary List
body.SummaryListBody formats the page 
background and text.

The appearance of links in the Summary List are 
controlled by body.SummaryListBody a:link and 
body.SummaryListBody a:visited.

To change the shading of the rows in the list, edit 
these CSS classes. The two sets of CSS classes 
allow for rows with alternating shading.

• SummaryList1
• SummaryList1Hover (for Internet Explorer)
• SummaryList1HoverN (for Netscape)
• SummaryList2
• SummaryList2Hover (for Internet Explorer)
• SummaryList2HoverN (for Netscape)

Tabs
The appearance of the selected tab is controlled 
by:

• TabsLeftCornerUp
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• TabsBackgroundUp

• TabsRightCornerUp

The appearance of the unselected tabs is 
controlled by:

• TabsLeftCornerDown

• TabsBackgroundDown

• TabsRightCornerDown

For example, you could replace the background 
images or use solid colors instead of images. 

To customize the font used for the text on the tabs, 
edit TabsBackgroundDown and TabsBack-
roundUp.

The area to the right of tabs (where the 
next/previous page controls are located) can be 
styled with tabsBody (the background color) and 
tabsBorder (the bottom border), and PageNavi-
gation (the “Page X of Y” text).

To put a dividing border between the Summary List 
and the tab area, use border-top with tabsBody.

Form
Each tab in a Web view is a form that contains a 
table. The HTML looks like this:

<body class="RecordBody" >
<form name="Record">

<table class="RecordTab" >

So, for example, to change the background color 
of the tabs, edit the body.RecordBody class in 
CensusMain.css.

To apply styles to the form element, you can use 
this selector in the style sheet:

body.RecordBody form { ... }

Field Captions
Field captions in a Web view are formatted with the 
CSS classes normalfield, requiredfield, and 
disabledfield.

Form Elements
The CSS class applied to a form element is 
specified by the CSS Class field attribute in the 
Web View Editor. You can customize the default 
CSS classes or define your own and apply them to 
fields through the Attribute Editor.

The default CSS classes for form elements are 
TextBoxWidth, ComboBoxWidth, and MemoField-
Width, InputAttachment (for the Attachments box), 
and InputCalendar (for date fields).

Command Bar
The command bar is the bar at the bottom of the 
page that contains the Issue box and the New, 
Save, Cancel, and Print buttons.

body.CommandBarBody sets the background 
color for the command bar. You can set the text 
color here (except for the text in the message 
area).

CommandBarBLeft, CommandBarBCenter, and 
CommandBarBRight specify the background 
images for the command bar.

CommandBarMsgLeft, CommandBarMsgCenter, 
and CommandBarMsgRight specify the 
background images for the message area (e.g.: 
“Ready. Click New to create a new issue.”) of the 
command bar.

ControlsCaptionDark sets the style for the “Current 
Issue” label.
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CurrentRecord and CurrentRecordHover set the 
style for the Current Issue text box.

Branding the Dialogs

About Branding Dialogs
Dialogs are pages that users open by clicking a 
button. This includes the Attachments, Reports, 
Revision History, Password, Options, and 
Contacts dialogs. 

Most of the dialogs use the same style sheet as 
the Web view. However, the Contacts and 
Password dialogs use the CensusMain.css style 
sheet found in CensusWebVD\Admin\THEME\css.

Common Styles for All Dialogs
body.toolbarBody sets the background color for 
the dialog pages (except for the Reports dialog, 
which uses body.ReportsBody).

The box with rounded corners is a set of 
background images specified by these classes:

• BoxTLeft, BoxTCenter, and BoxTRight

• BoxMLeft, BoxMCenter, and BoxMRight

• BoxBLeft, BoxBCenter, and BoxBRight

Attachments Dialog
body.toolbarBody sets the background color for 
the page.

DialogLabel formats the captions.

InputFile and InputFileHover format the text boxes.

The list of attached files is displayed in a table. 
HeaderSummaryListCellCenter formats the 
heading row (where the "File Name" and 
"Remove" captions are displayed).

SummaryList1 and SummaryList2 format the list of 
files. 

DialogLabel formats the file names.

Reports Dialog
body.ReportsBody sets the background color for 
the page.

The appearance of the tabs is controlled by the 
same CSS classes that apply to the tabs in a Web 
view (see “Tabs” on page 152).

The “Report Name” caption uses the normalfield 
class.

The <select> element that lists the available 
reports uses the ReportList class.

The “Layout:” and “Viewer Type:” captions use the 
AdminNormalTextDarkBG class. The 
corresponding <select> elements do not use a 
CSS class, but you can use their IDs (LayoutType 
and ViewerType) with ID selectors in the CSS file.

Revision History Dialog
This dialog uses only the common styles.

Options Dialog
body.toolbarBody sets the background color for 
the page.

Captions use the normalfield class.
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Form elements (such as <input>) are in a <TD> 
that uses the normalfield class, but the form 
elements themselves have no class.

Contacts Dialog

This dialog uses the CensusMain.css style sheet 
in CensusWebVD\Admin\THEME\css.

body.RecordBody sets the background color for 
the page.

The caption for the Display list uses the 
DialogLabel class, and the <select> element uses 
AdminComboBoxWidth.

On the input form for contact information, the 
captions use requiredfield and DialogLabel. The 
form elements all use AdminComboBoxWidth.

Password Dialog

This dialog uses the CensusMain.css style sheet 
in CensusWebVD\Admin\THEME\css.

body.toolbarBody sets the background color for 
the page.

normalfield formats the captions “Old Password”, 
“Password”, and “Confirm Password”.

AdminTextBoxWidth and 
AdminTextBoxWidthHover format the text boxes.

AdminNormalTextDarkBG formats the “Password 
can contain a maximum of 14 characters“ 
message.

Branding the Logon Pages

About Branding the Logon Page
The heights of some of the table cells are hard-
coded in CensusWebVD\logon.asp.

LogonBody sets the background color for the 
page.

The images and background colors for the box 
with rounded corners are set by these classes:

• div.Logon-t-left, td.Logon-t-center, div.Logon-t-
right

• td.Logon-m-left, div.Logon-m-center, td.Logon-
m-right

• div.Logon-b-left, td.Logon-b-center, div.Logon-
b-right

Note the mix of div and td elements. If you want to 
replace the images with colors and borders, set 
the left and right classes to the background color 
and use the center classes to define your border.

div.Logo inserts the Enterprise HelpDesk logo.

div.Logon-decor-img inserts the keyboard image 
with the orange border

LogonForm positions the logon form (the Logon 
Name and Password text boxes).

div.LogonField and div.PwdField position the form 
elements.

div.LogonCaption formats the "Logon Name" and 
"Password" labels.

input.LogonInput and input.LogonInputHover 
format the text boxes.

a.LogonState1 and a.LogonState1:hover set the 
images used for the Logon button.

HelpState1 and HelpState1:hover set the images 
used for the Help button.
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ValidateLogon Page
The ValidateLogon page displays the available 
views. With a few exceptions (documented below), 
this page uses the same styles as the Logon page.

The heights of some of the table cells are hard-
coded in CensusWebVD\validatelogon.asp.

ExitState1 and ExitState1:hover specify the 
images used for the Log Off button.

div.ViewList-m-center is used instead of div.Logon-
m-center.

div.ViewList-decor-img is used instead of 
div.Logon-decor-img to display the keyboard 
image with the orange border

div.ViewLinks positions and sizes the area used to 
display the list of available views. This class also 
adds the vertical orange bar.

div.LogonCaption formats the "Click the view you 
want to open" string.

ViewListCaption formats the DIVs that contain the 
project names.

ViewList-Link, ViewList-Link:link, ViewList-
Link:visited, and ViewList-Link:hover format the 
view names, which are hyperlinks.

Customizing the 
Timesheet

Adding Rows
By default, the timesheet project allows users to 
track weekly time spent for up to four different 
projects. If you need to track time for more than 
four different projects or tasks, you can add more 
rows to the timesheet.

Step 1: Create fields in the Field Editor

1 Create a new choice list for selecting projects. 
Copy the Project1 field and name it Project5.

2 Create the input fields for the days of the week.

a Copy the P1HRsMon field and name it 
P5HrsMon. 

b Copy P5HrsMon and name it P5HrsTue.

c Copy P5HrsTue and name it P5HrsWed.

d Continue until you have input fields for all 
seven days of the week.

3 Create a field to hold the weekly total. Copy 
Proj1TotalWkHrs and name it Proj5TotalWkHrs. 

4 Click Apply to add the fields to the project.

Step 2: Export the new fields to the view

1 In the Web View Editor, click the timesheet view 
in the Project / View list.

2 Under Fields, click the last field (Product4) in 
the Export to View list. Click Attributes, and 
delete the value of the Html code after control 
attribute.

3 Move the new fields from the Available list to 
the Export to View list.

The new fields are added to the end of the 
Export to View list. The order of the fields does 
not matter.

4 Click the last field in the Export to View list. 
Click Attributes, and set the value of the Html 
code after control attribute to “-->”.

Step 3: Edit timesheet.js

1 Open timesheet.js in your favorite text editor. 
You can find this file in the folder:

CensusServer\CensusWeb\CUSTOMIZEDFILES
\#Project#Timesheet\#AllWebViews#\Js
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This is the file to edit if you want to add a row to 
all Web views of your timesheet project. If you 
want to add rows to only certain Web views, 
you’ll need to create a new folder. For example:

CensusServer\CensusWeb\CUSTOMIZEDFILES
\#Project#Timesheet\

#WebViews#Timesheets_MyTimesheets\Js
2 At the top of the file, declare and initialize a 

variable that holds the ID of the new row:

var PROJ_FIVE_ID=4;

3 In the WriteTimesheetGrid() function, create a 
new array that holds the row information, and 
store this new array in m_arrTimesheet:

m_arrTimesheet[PROJ_FIVE_ID]=new Array(
"cbo_97_cbo_97_Project5" 
+ INNER_ARRAY_SPLITTER + 

INNER_ARRAY_SPLITTER
+ strProjComboOptions,

"nbr_98_nbr_98_P5HrsMon",
"nbr_99_nbr_99_P5HrsTue",
"nbr_100_nbr_100_P5HrsWed",
"nbr_101_nbr_101_P5HrsThu",
"nbr_102_nbr_102_P5HrsFri",
"nbr_103_nbr_103_P5HrsSat",
"nbr_104_nbr_104_P5HrsSun",
"nbr_105_nbr_105_Proj5TotalWkHrs" 
+ INNER_ARRAY_SPLITTER + 

CONTROL_TYPE_TOTAL);

Use the ID of the new row (PROJ_FIVE_ID) as 
an index into the m_arrTimesheet array.

In the new array, specify the names assigned to 
form controls in the generated html. These 
names are based on the tBoundControlName, 
which you can find in the tblDtsFields table of 
the project definitions database. For example, if 
the tBoundControlName is cbo_97_Project5, 
then the form control name is 
cbo_97_cbo_97_Project5.

tblDtsFields
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4 Add a call to GetTimesheetProjRow() for the 
new row. Put this call before the call to 
GetTimesheetDayTotalRow().

// Calls to GetTimesheetProjRow() for previous rows

strHTML+=m_oTimesheet.GetTimesheetProjRow(
m_arrTimesheet[PROJ_FIVE_ID]

);

// call to GetTimesheetDayTotalRow()

Step 4: Update layouts, queries, sorts, and 
reports

Any layouts, queries, sorts, or reports that use 
values from the rows in a timesheet must be 
updated.

For example, the Current Issue - Detailed report is 
used to print the current timesheet. If you don’t 
update this report, it won’t show the rows you 
added.

Step 5: Regenerate the Web views

If you get javascript errors when you try to open 
the Web view, log off and fix timesheet.js. You 
don’t have to regenerate the Web view, but you will 
have to copy timesheet.js from the 
CUSTOMIZEDFILES folder to the Web view 
folder.

Changing the Timesheet Starting Day
The weekly timesheets can start on any day of the 
week. By default, the weekly timesheets start on 
Monday.

To change the timesheet starting day

1 In the Web View Editor, click the timesheet view 
in the Project / View list.

2 Under Fields, click the last field before the fields 
that make up the actual timesheet. By default, 
this is the Weekly Total Hours field.

3 Click Attributes and then click the attribute 
value of the Html code after control attribute. 
This should take you to the end of the line of 
text, where you’ll see the START_MONDAY 
constant as the last argument to a function.

4 Change this to the new starting day. Use one of 
these constants:

START_MONDAY

START_TUESDAY

START_WEDNESDAY

START_THURSDAY

START_FRIDAY

START_SATURDAY

START_SUNDAY

Creating a Timesheet
When you create a new project based on the 
Timesheet project, you need to add the timesheet 
to a Web view of the new project. After that, you 
can simply copy the Web view to create more 
views of the new project.

Timesheet

To add a timesheet to a Web view

1 Export the fields displayed above the timesheet 
(by default: Employee, Weekly Start Date, and 
Weekly Total Hours).
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2 Enter the following HTML into the Html code 
after control attribute of the last field currently in 
the Export to View list. 

Instead of typing in this HTML, you can copy 
the HTML code after control value from the 
Weekly Total Hours field in the original 
Timesheet / Timesheet Web view.

<script type="text/javascript" src="../js/Timesheet.js">
</script>
<select name="TS_cbo_vals" class="HiddenObject">
<WC@53></WC@53>
</select>
<script>
WriteTimesheetGrid
(

escape(document.Record.TS_cbo_vals.innerHTML),
START_MONDAY

);
</script>
<!--

3 Export the timesheet fields. The order does not 
matter.

• DailyTotalMon, ..., DailyTotalSun (7 fields)

• P1HrsMon, ..., P1HrsSun (7 fields)

• P2HrsMon, ..., P2HrsSun (7 fields)

• P3HrsMon, ..., P3HrsSun (7 fields)

• P4HrsMon, ..., P4HrsSun (7 fields)

• Proj1TotalWkHrs, ..., Proj4TotalWkHrs (4 
fields)

• Project1, ..., Project4 (4 fields)

4 Enter the string “-->” (without the quotation 
marks) into the Html code after control attribute 
of the last field in the Export to View list. 
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Appendix A: Installing Enterprise 
HelpDesk

Supported Configuration
Enterprise HelpDesk supports two possible 
configurations: Standard and Distributed. In both 
configurations, all Enterprise HelpDesk 
components are installed on the Web server. The 
difference between the two configurations is the 
location of the databases.

Standard Configuration
• All Enterprise HelpDesk components are 

installed on the Web server.

• All databases are located on the Web server. 
By default, the databases are Microsoft Access 
databases, but you can relocate them to SQL 
Server (if you have a license for PC-Duo 
Enterprise HelpDesk SQL Enabled).

If you intend to relocate databases to SQL Server, 
we recommend you use the Distributed 
configuration.

Distributed Configuration
This configuration requires PC-Duo Enterprise 
HelpDesk SQL Enabled.

• All Enterprise HelpDesk components are 
installed on the Web server.

• All databases are in SQL Server, and are 
located on a separate SQL Server computer 
(the database server).

To set up a distributed configuration, you first 
install Enterprise HelpDesk in the standard 
configuration. Then you use HelpDesk Web Admin 
to relocate the databases from the Web server to 
the SQL Server computer.

Configuration Options
Both configurations allow you to install additional 
copies of HelpDesk Admin and the Web View 
Editor on other computers. For example, you may 
want to install a copy of the Web View Editor on 
your computer, so you can edit and regenerate 
existing Web views from your desk.

To create new Web views, you must use the Web 
View Editor installed on the Web server. Copies of 
the Web View Editor installed on other computers 
can edit and regenerate existing Web views, but 
cannot create new Web views.

Installing Enterprise 
HelpDesk
To successfully install and configure Enterprise 
HelpDesk, you must run the Setup program as a 
domain administrator.
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Installing a Distributed Configuration
To set up a distributed configuration, you first 
install Enterprise HelpDesk in the standard 
configuration (everything on the Web server). 
Then you use HelpDesk Web Admin to relocate 
the databases from the Web server to the SQL 
Server computer.

User Accounts and Groups Created by 
Setup
The Enterprise HelpDesk setup program creates a 
domain user account that is used to access the 
Enterprise HelpDesk database, to access the PC-
Duo Enterprise site database, and for anonymous 
access to the Web views. To modify the domain 
account used by Enterprise HelpDesk, start 
HelpDesk Admin and in the Tools menu, click 
Windows Account. 

Setup also creates a domain group named 
CensusAdminsGroup. Members of the 
CensusAdminsGroup group (or of the local 
Administrators group on the HelpDeskServer 
computer) have the required permissions to 
perform any task with HelpDesk Web Admin.

A user who is not a member of either of these 
groups will use the Web anonymous user account 
(by default, CensusUser) to run HelpDesk Web 
Admin tasks, and this account cannot perform IIS-
related tasks such as unloading virtual directories 
(when logging off users), and may not be able to 
relocate databases to other computers.

By default, Setup adds all members of the domain 
Administrators group to the CensusAdminsGroup 
group. You can add new members to the 
CensusAdminsGroup whenever you want to grant 
full access to Web Admin. The 

CensusAdminsGroup is also added to the local 
Administrators group on the HelpDeskServer 
computer.

If Setup cannot create a new domain group, you 
can use an existing domain group. We 
recommend that this group be used exclusively for 
controlling access to Web Admin.

If no domain administrators are added to the group 
that controls access to HelpDesk Web Admin, then 
only local administrators of the HelpDeskServer 
computer have full access to HelpDesk Web 
Admin. 

Selecting Components
If you select the Custom setup type, you can select 
which components to install.

HelpDesk Server Components
HelpDesk Server HelpDesk Server includes the 
project databases that contain the issues and 
definitions (such as queries, reports and layouts) 
for Enterprise HelpDesk projects. 

HelpDesk Web Server HelpDesk Web Server is 
the server component of HelpDesk Web. The 
HelpDesk Web Server installation includes a 
Microsoft Windows service (Mq Issue Agent) that 
takes care of generating and sending e-mail 
notifications. 

HelpDesk Web Server also includes HelpDesk 
Web Admin, a Web-based administration tool. 
HelpDesk Web Admin allows you to administer 
users, choice lists, workflow, tabs, and e-mail 
notifications.
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HelpDesk Admin Components
HelpDesk Admin HelpDesk Admin is a Microsoft 
Windows application for administering Enterprise 
HelpDesk projects. For example, you use 
HelpDesk Admin to create projects, create users 
and user groups, customize fields, and set up e-
mail notifications. 

Web View Editor Web View Editor is a Microsoft 
Windows application that you use to create Web 
views for your Enterprise HelpDesk projects. Web 
views are Web-based applications that provide 
access to Enterprise HelpDesk projects through a 
Web browser.

User Account for 
Notifications
Setup prompts you for a user account that can be 
used to run the notification service on the Web 
server and access the Enterprise HelpDesk 
projects (found on the computer where HelpDesk 
Server was installed).

This Windows user account should be a domain 
user account that has at least Power User-level 
permissions. 

Entering Your License 
Information
During installation, you must enter the PC-Duo 
Enterprise HelpDesk Access Enabled license key. 
The PC-Duo Enterprise HelpDesk Access 
Enabled license key enables PC-Duo Enterprise 
HelpDesk Access Enabled.

License Type Evaluation licenses allow you to 
use Enterprise HelpDesk for a predetermined 
period of time. At the end of that period, you can 
no longer run Enterprise HelpDesk unless you 
provide a valid license key.

Concurrent licenses are permanent licenses that 
allow a specified number of users to use 
Enterprise HelpDesk simultaneously. With 
concurrent licensing you do not need a license for 
every user who will use Enterprise HelpDesk. You 
need licenses only for the maximimum number of 
simultaneous users (users logged on at the same 
time). 

For example, if you have 30 users who need 
access to Enterprise HelpDesk, but you don't 
expect more than 20 to log on at the same time, 
you need only 20 licenses. When all 20 licenses 
are in use, no additional users will be able to log 
on.
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Appendix B: Databases

Overview
PC-Duo Enterprise HelpDesk Access Enabled 
supports Jet/Access databases; PC-Duo 
Enterprise HelpDesk SQL Enabled adds support 
for SQL Server.

By default, all Jet/Access databases are stored in 
the HelpDeskServer folder (for example, 
C:\Program Files\PC-Duo 
Enterprise\HelpDeskServer). SQL Server 
databases are located on the SQL Server 
computer in a folder specified by the Enterprise 
HelpDesk administrator.

Project databases An Enterprise HelpDesk 
project includes two main databases:

• A database of issues (and their revision 
histories). 

• A database of definitions, which contains the 
queries, sorts, layouts, reports, notifications, 
fields, and tabs available in the project.

Users database In addition to the project 
databases, there is a database of users. The users 
database is shared by all projects.

Issue Database

Database

Microsoft Access The issues are stored in the 
file <project>01.dat, where <project> is the name 
of the Enterprise HelpDesk project.

SQL Server The issues are stored in the 
<project>01_Dat database, where <project> is the 
name of the Enterprise HelpDesk project. The 
database consists of these files:

• <project>01_Dat.mdf

The master data file (MDF) of the database.

• <project>01_Dat_log.LDF

Log file that holds the log information used to 
recover the database. There must be at least 
one log file for each database, although there 
can be more than one. 

Tables

tblDts Stores most of the information entered for 
an issue. This includes most of the fields on the 
Overview, Description, and Detail tabs, as well as 
the information entered on any custom tabs added 
to the project.

tblFixInformation In previous releases of 
Enterprise HelpDesk, new fields added to the 
Resolution tab were stored in tblFixInformation. 
The default fields are stored in tblDts.

As of Enterprise HelpDesk 2.2, any new fields 
added to the Resolution tab are stored in tblDts.

tblAttachments Stores any files attached to an 
issue.

tblRevisionHistory Stores the revision history for 
issues.
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Project Definitions 
Database

Database

Microsoft Access The project definitions 
database is named <project>02.def, where 
<project> is the name of the Enterprise HelpDesk 
project.

SQL Server The project definitions database is 
named <project>02_DEF, and consists of these 
files:

• <project>02_DEF.mdf

• <project>02_DEF_log.LDF

Tables

tblDtsFields Defines the fields available in an 
Enterprise HelpDesk project. The Field Editor in 
HelpDesk Admin provides a user interface for 
editing most of the columns in this table. 

In tblDtsFields, the tWhere column specifies a 
Where clause that controls the contents of a 
choice list. The HelpDesk project uses the Where 
clause to build the Contact, Owner, and Submitter 
choice lists.

For example, this Where clause removes macros 
(such as <User>) and contacts from the Owner list:

Where (([nID] >= 0 And  [tName]  <> '')Or
[tName]  = '<User>') And fOriginator = 0

• The [nID] >= 0 condition removes the macros 
defined in tblUser:

The user with nID = 0 is the <None> macro.

• The fOriginator = 0 condition removes contacts, 
so that the list contains users only.

• tName is the name of the user. 

tblState Specifies the list of choices for the State 
field. The State field is a read-only field that is set 
based on the Progress field.

tblSubState Specifies the list of choices for the 
Progress field. Each possible substate 
corresponds to a possible State value (Open or 
Closed).

Choice List Tables A choice table specifies the 
possible values for a choice list field. Each row in a 
choice table includes an nID, a tName (the choice 
text), and optionally, an nChoiceID (for non-
alphabetical choice lists).

In the issue database, multi-choice fields store a 
semi-colon separated list of the tName values (the 
choice text strings), not the nID values.

User ID User Name

-4 <Contact>

-3 <User>

-2 <Previous Owner>

-1 <Owner>
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Users Database

Database
All Enterprise HelpDesk projects share the same 
database of users. The users database also stores 
global choice lists.

Microsoft Access The user database is named 
users.mdb.

SQL Server The user database is named 
USERS_MDB, and consists of these files:

• USERS_MDB.mdf

• USERS_MDB_log.LDF

Tables

tblUser Lists the users and contacts. Users have 
logon names and passwords. Contacts are people 
who report issues, but do not have a logon 
account.

If you add a field to the Origin tab, the field is 
added to tblUser, not tblDts. The Origin tab is a 
read-only tab that displays user and contact 
information. The user and contact information is 
actually entered in HelpDesk Web Admin (Security 
tab). This allows user and contact information to 
be entered once for all issues, instead every time 
for each issue.

Other Project Files
<project>03.Usr is a Microsoft Access database. It 
contains a number of temporary tables used by 
HelpDesk Admin.

<project>.cen controls project initialization and 
versioning.

Other Databases
These databases are shared by all projects:

• censusweb.mdb (CENSUSWEB_MDB in SQL 
Server) stores Web view definitions. Used by 
the Web View Editor.

• Licenses.mdb (LICENSES_MDB in SQL 
Server) stores licensing information.
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Appendix C: Relocating Enterprise 
HelpDesk Installations

About the Relocation 
Wizard
Enterprise HelpDesk includes a Relocation Wizard 
for moving Enterprise HelpDesk installations from 
one computer to another. 

When you relocate Enterprise HelpDesk, the 
Relocation Wizard:

• Logs off all users.

• Unloads the virtual directories used by 
Enterprise HelpDesk.

• Stops the Mq Issue Agent service.

• Detaches local SQL Server databases.

• Backs up the HelpDeskServer and 
HelpDeskTools folders before relocating them.

• Copies Enterprise HelpDesk to another 
computer and disables the original installation.

• Regenerates all your Web views after 
Enterprise HelpDesk is relocated. The Web 
views are all regenerated in the default 
CensusWeb/Views/CensusWebVD folder. 

The Relocation Wizard relocates SQL Server 
databases if:

• The SQL Server databases are local to the 
source computer.

• The version of SQL Server on the target 
computer is greater than or equal to the version 
of SQL Server on the source computer.

Before You Relocate
Check Permissions You must run the Relocation 
Wizard with a user account that has Full Control 
permission for the HelpDeskServer folders on all 
computers (current location and new location).

Close all copies of HelpDesk Admin and the 
Web View Editor This includes all copies of the 
programs, not just those installed on the Web 
server.

Relocate Projects If you have any projects 
located outside of the HelpDeskServer folder, use 
HelpDesk Admin to move the projects into the 
HelpDeskServer folder. After you relocate 
Enterprise HelpDesk, you can use HelpDesk 
Admin to move the projects back outside of the 
HelpDeskServer folder. 

Back Up The Relocation Wizard backs up your 
HelpDeskServer and HelpDeskTools folders, but 
you may want to create your own backups.

Log Off Users The Relocation Wizard logs off 
users, but you may want to inform users ahead of 
time that Enterprise HelpDesk will not be available.
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How to Relocate 
Enterprise HelpDesk
To relocate Enterprise HelpDesk:

1 Log off all Web view users and close all copies 
of HelpDesk Admin, HelpDesk Web Admin, and 
the Web View Editor.

2 Clean install Enterprise HelpDesk components 
on the destination computers (the computers to 
which you want to relocate).

3 Run the Relocation Wizard on the destination 
computer.

4 Update client copies of HelpDesk Admin and 
the Web View Editor.

5 Test the relocated installation. Check that you 
can open the relocated projects and Web 
views, and that you can run HelpDesk Admin, 
HelpDesk Web Admin, and the Web View 
Editor.

The Relocation Wizard regenerates all Web 
views in the default 
HelpDeskWeb/Views/CensusWebVD folder.

6 Remove the old copies of Enterprise HelpDesk.

We strongly recommend that you perform a clean 
installation of Enterprise HelpDesk on the destination 
computer. Otherwise, you may have problems relocating 
to the destination computer.

For example, suppose you perform a clean install of 
HelpDesk Server, create a project, and migrate it to SQL 
Server. If you then try to relocate another HelpDesk 
Server to that computer, the relocation may fail because 
database files are locked on the destination computer. 

SQL Server database files are locked while the SQL 
Server services (mssqlserver and sqlserveragent) are 

running. As a result, the Relocation Wizard may not be 
able to relocate project databases and other databases 
such as USERS_MDB.

Relocating Enterprise 
HelpDesk
In Enterprise HelpDesk 5.0, all Enterprise 
HelpDesk components are installed on one 
computer: the Web server. The Relocation Wizard 
allows you to move Enterprise HelpDesk to a 
different computer.

To relocate Enterprise HelpDesk:

1 On the target computer, perform a clean install 
of Enterprise HelpDesk 5.0.

2 On the target computer, run the Relocation 
Wizard program MqRelocateTool.exe. The 
program is located in the 
HelpDeskTools\Support\Relocation folder.

3 In the Logon Name and Password boxes, type 
the name and password of an Enterprise 
HelpDesk user. The user must be a member of 
the Admins group, or of a group with the same 
permissions.

4 Under Relocate From, enter the location of the 
current HelpDesk Server. Use a UNC path (for 
example, "\\NANP\HelpDeskServer"). 

5 If the Computer Name or Local Path boxes are 
not filled in automatically, type in the missing 
information.

Computer Name is the name of the computer 
where the current HelpDesk Server is located.

Local Path is the location of the current 
HelpDesk Server relative to a root directory (for 
example, “C:\Program Files\HelpDeskServer”).
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6 Under Relocate To, HelpDesk Server is the 
location where you installed HelpDesk Server 
on the target computer. By default, HelpDesk 
Server is installed in the Program 
Files\HelpDeskServer folder.

HelpDesk Tools is the location of HelpDesk 
Admin and the Web View Editor on the new 
computer. The default location is the 
Program Files\HelpDeskTools folder.

7 Select the Show Advanced Options check box 
to show the computer name of the target 
computer. If for some reason the computer 
name is incorrect or missing, you can type in 
the name.

8 Click OK to start the relocation.

If Something Goes Wrong
If something goes wrong when you relocate 
Enterprise HelpDesk:

• Check the error log. The Relocation Wizard 
creates an error log in the 
HelpDeskServer\Relocation folder of the 
computer where you run the wizard.

The folder name includes the date and time, so 
the path to the error log looks something like 
this:

HelpDeskServer
\Relocation_02-20-2003_10.44.50

\RelocationErrorLog.txt 

• Check that there is enough free disk space on 
the new server. Typically, the amount of disk 
space required is at least twice the size of the 
current HelpDeskServer folder.

• If you are relocating SQL projects, you’ll have to 
reattach the databases to the SQL server 
before you can try again. 

Updating Client Programs
After you relocate Enterprise HelpDesk, you must 
update any client programs. Client programs are 
copies of HelpDesk Admin and the Web View 
Editor installed on computers other than the Web 
server. 

To update the client programs on a computer, you 
run the MqRelocateClients.exe program on that 
computer. 

When the Relocation Wizard finishes, it puts a 
copy of the MqRelocateClients.exe program in the 
HelpDeskServer\Relocation_<timestamp> folder.

If you send the MqRelocateClients.exe program to 
users to run, you must also send the INI file 
located in the same folder as 
MqRelocateClients.exe.

Enabling Enterprise 
HelpDesk after Relocation
The Relocation Wizard copies a Enterprise 
HelpDesk installation to a different computer and 
disables the original installation. Sometimes you 
may want to continue using the original 
installation. For example, you may want to copy 
Enterprise HelpDesk so you can test an upgrade, 
but continue using the original installation.

To enable  after a relocation:

Apply the following steps to the original Enterprise 
HelpDesk installation.

1 Reattach all SQL Server databases.

To prevent users from using old databases, the 
Relocation Wizard detaches all Enterprise 
HelpDesk databases that are in SQL Server.
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Reattach the <project>_DAT databases and the 
USERS_MDB database using the .mdf or .ldf 
files in your HelpDeskServer folder.

2 Rename licenses.mdb.

Locate a file in the HelpDeskServer folder with 
a name that looks like Licenses.mdb_2004-06-
18_20.23.21.bak. If there are several files like 
this, use the one with the most recent date in 
the name.

3 Allow users to log on.

• In the HelpDeskServer folder, open the file 
census.ini. Find the [SessionControl] 
section, and if Enabled=0, change it to 
Enabled=1.

• Start HelpDesk Admin and click Tools > 
Integrity. Select the Remove Locks check 
box and click Start.

• In the CensusWebVD folder (by default, 
HelpDeskServer\CensusWeb\Views\Censu
sWebVD), locate a file with a name like 
Logon.asp_bck_logoff. If this file exists, 
delete the Logon.asp file and rename 
Logon.asp_bck_logoff to Logon.asp.

• In the CensusWebAdmin folder (by default, 
HelpDeskServer\CensusWeb\Views\Censu
sWebAdmin), locate a file with a namelike 
Logon.htm_bck_logoff. If this file exists, 
delete the Logon.htm file and rename 
Logon.htm_bck_logoff to Logon.htm.

4 Restart the notification Service.

If you use notifications, open Services and start 
the Mq Issue Agent service.

To open Services, click Start, click Control 
Panel, double-click Administrative Tools, and 
then double-click Services. 
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Symbols
< less than operator 29
<= less than equal operator 29
> greater than operator 29
>= greater than equal operator 
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Numerics
1-tier configuration 161
2-tier configuration 161
404 errors 117

A
ActiveX 131
Ad-hoc Query Editor 54, 84, 88
admin user account 12
Admins group 7, 10, 11
Alignment attribute 89
Always verify locked databases 

option 112
analyst user account 12
anonymous user account 94
<Any> macro 64
Assigned Work Team field 49
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moving 106
relocating 106

Attachments command (Tools 
menu) 106
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B
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C
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.cen file 167
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of users and contacts 143
Progress field 10, 25

searching 29
showing selected items 92
sorting 26, 32
tooltips 93
updating in Web views 13, 90

choice order sort 30
client programs 171
Closed Date field 27
Closed Time field 27
Column Span attribute 14, 90
ComboBoxWidth CSS class 90
compression 132
Computer Name field 126
Contact field 12, 13
Contact tab 23, 43
Contacts 43
contacts

adding choice lists of 143
assigning to work teams 48
defined 2
importing 120, 121
submit-only views 12, 86

Contains operator 30
cookies 150
copying HelpDesk 171
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156
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Custom Report Engine option 

35
custom reports

choice list changes 10
creating 138–140
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deleted fields 10
fields not exported 13
for specific Web views 142
multi-choice lists 9

CustomCode.js 91, 145, 146
CustomizedFiles folder 13

backing up 116
custom reports 140, 142
explained 96
new projects 13

D
data corruption 109
databases

backing up 112–117
compacting 109
DAT 114, 165
described 108
editing tables 135
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inventory 125, 126
issue 1, 114
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removing locks 110
repairing 109
site 129
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project definitions 111
users 167
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date formats 98
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default values 47, 95
definitions database See 
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distributed configuration 161
DNS Error 117
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E
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Enable Auto Repair command 
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Enable Backups option 117
encryption 132
error log 171
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404 File not Found 117
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escalation rules 69
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Exchange Server Integration 

wizard 101

F
features

described 11
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Field Editor
overview 21
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attributes 89–93
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changing type 9
choice lists
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Computer Name 126
CSS Class attribute 90
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default values 95
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Destination Tab 21, 23
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editing 8–10
Editor attribute 89
exporting to Web views 13, 

14, 87
form elements 90
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Layouts 88
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security 21, 22
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size 23
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175
tblDtsFields 115
text 23, 91, 92
time 23
timestamping 144–145
types of 23
updating styles 9
URL Button CSS attribute 92
URL buttons 92
Visible attribute 24, 93
Width attribute 91
yes/no 23

%fieldvalue% variable 89, 92, 
132

file uploads 117
form elements
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G
global choice lists 48, 167
global databases 105
group leader user account 12
groups

adding users 52
Admin 11
creating 51
defined 43
deleting 51
feature permissions 53–55
Guests 11
project access permissions 
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removing users 52
setting permissions 10–11
Users 10
Web view access 
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menu) 51
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HelpDesk
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171
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HelpDesk project 8
HelpDesk Server 162
HelpDesk Web Admin 3, 25, 99
HelpDesk Web Server 162
HelpDeskServer folder 115
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defined 91
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I
Import Issues 119
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issue database
backing up 115
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J
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L
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licenses database 116
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locks 110, 172
locks, database 112
logging off users 107, 169
logon accounts 11, 43
logon sessions 20
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Logons Editor 110
Logons Editor command (Tools 
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logos 151, 152, 155
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M
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<New Issue> 63
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relationship with State 26
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tables 166
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project folder 115
projects

access permissions 7, 11
administering 1
base projects 7
BugTrk 8
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creating 7, 13, 17
current users 20
customized files 13
database engine 19
databases 105
defined 17
definitions database 1, 19
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deleting 19
deleting issues 107
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HelpDesk 8
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Show Selected Items In Tooltip 
attribute 93

Shutdown Process 112
single choice lists 23
single field size 24
site databases 129
SMTP Server option 80
sorts

choice order 26, 32
defining 31–32
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SQL Server
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Timeout attribute 87
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77
<User> macro 29, 77
users
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adding to groups 52
admin account 12
analyst account 12
anonymous access account 
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assigning to work teams 48
authentication 47, 51
backing up database 115
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CensusUser account 95
database 167
default values 47
defined 43
deleting 142
disabling 12, 50
editing user information 50
employee account 12
group leader account 12
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hiding in projects 50
importing 44, 120, 121
issueagent 80
logging off 107, 112, 169
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logon accounts 11
MDB database 116
notifications account 163
passwords 50, 80
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143
removing from database 142
removing from groups 52
removing locks 110
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submit-only Web views 86
Web view permissions 87
windows account 94
work teams 48
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description 87
disabling features 54
Display All Read-Only Fields 

As Text attribute 91
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printing issues 13
queries 13
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styling form elements 90
submit-only 12, 86
Summary List 87
time formats 98
timeouts 87
URLs 93

user interface elements 84
virtual directories 93

web views
work teams 49

When 43
when conditions 77
Width attribute 91
wildcards, in queries 31
windows account 94
Windows Account command 

(Tools menu) 162
Windows NT domains 44
Windows Server 2003 117
work teams

assigning users 48
defining 48
overview 48
queries 49
web views 49

workflow
applying changes to web 

views 65
automating 57
conditions 59
dependent values rules 58
disabling 65
macros 64
<New Issue> macro 63
notifications 78
performance costs 59
planning 5
possible values rule 58
projects 59
related fields 58
rules

default names 64
defining 63, 64
deleting 63
described 60
disabling 65
editing 62
evaluating 65
examples 57–58
format of 59
renaming 64

Submitter field 64
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templates
creating 60
described 60
editing 61
properties 64, 65

test operators 59
user groups 63
work teams 48

Y
yes/no fields 23


	Administering Enterprise HelpDesk
	Creating Projects and Generating Web Views
	Managing Users, Contacts, and Groups
	Tools for Enterprise HelpDesk Administrators
	Troubleshooting HelpDesk Web Admin

	Planning and Deploying a Help Desk System
	Planning
	Implementation Roadmap
	Creating a New Project
	Customizing Fields
	Creating Groups and Granting Permissions
	Creating User Accounts
	Generating Web Views
	Setting Up Notifications

	Projects
	What is a Project?
	Creating New Projects
	Copying and Sharing Definitions
	Building a Project Template
	Deleting Projects
	Editing Project Properties

	Editing Fields
	About the Field Editor
	Adding Fields
	Removing Fields
	Working with Choice Lists
	Working with Tabs

	Finding and Listing Issues
	Building Queries
	Defining Sorts
	Defining Layouts

	Reporting
	About Reports
	Viewing Reports
	Changing Report Viewers
	Selecting Which Issues to Include in a Report
	Defining Summary Reports
	Defining Listing Reports
	Defining Time Reports
	Defining Report Pages

	Managing Contacts, Users, and Groups
	About Users and Contacts
	About Security
	About Groups
	Importing User Accounts from Windows
	Creating User Accounts
	Setting Default Values for New Users
	Managing Work Teams
	Organizing Users by Projects
	Disabling User Accounts
	Editing User Information
	Changing Passwords
	Changing the Authentication Method
	Defining User Groups
	Groups: Adding and Removing Users
	Users: Changing Group Membership
	Companies
	Departments
	Enabling and Disabling Features
	Enabling and Disabling Projects

	Defining Workflow Rules
	About Workflow Rules
	What Can You Do with Workflow Rules?
	What You Should Know about Workflow Rules
	What is a Workflow Rule?
	Creating Rule Templates
	Defining Conditions
	Defining Rules
	Deleting Rules
	Renaming Rules
	Using Macros in Rules
	Setting Possible Values
	Changing When Rules Are Evaluated
	Changing the Order of Evaluation
	Applying Workflow Rules
	Disabling Workflow Rules

	Defining Service Level Agreements
	About Service Level Agreements
	Setting Up Service Agreements
	Target Times
	Escalation Levels
	Defining Escalation Rules
	Specifying Operational Hours
	Defining Service Levels
	Service Agreements
	Service Level Reporting
	Service Types

	E-mail Notifications
	About Notifications
	What Can You Do With Notifications?
	Editing Notifications
	Specifying Notification Recipients
	Defining When Conditions
	Specifying Notification Contents
	Managing Workflow with Notifications
	Setting Up Notifications
	Handling Notification Failures

	Generating Web Views
	What is a Web View?
	Editing Web Views
	Configuring Web Views
	Exporting Fields and Queries
	Adding the Child Issues Tab
	Working with Fields
	Web View URLs
	Customizing Web Views
	Changing the Date and Time Formats for Web Views
	Administering Enterprise HelpDesk on the Web

	Setting Up E-mail Submission
	About Submitting Issues by E-mail
	Defining Integration Rules
	Configuring the Servers
	Mapping Fields
	Assigning Default Values

	Maintaining Your Help Desk System
	Relocating Databases
	Relocating Attachments
	Deleting Issues
	Managing Logon Sessions
	Setting the Monitor Interval
	Repairing and Compacting
	Running Security Repair
	Checking Integrity
	Enabling Auto Repair
	Entering License Keys
	Releasing Databases
	Backing Up
	Troubleshooting Problems with Attachment Fields

	Importing Issues
	About Importing Issues
	What Can You Import?
	How New Records are Created
	Before You Import
	Importing Issues into a Source Table
	Combining Multiple Source Tables
	Importing Issues from Enterprise HelpDesk Projects
	Creating Queries to Merge Source Tables
	Mapping Fields

	Integrating Inventory
	About Inventory
	How to Integrate Inventory
	Linking Projects and Site Databases
	Editing Links
	Removing Links
	Defining the Query
	Adding the Inventory Tab to Web Views
	Hiding the Software and Hardware Report Buttons
	Manually Linking to Other Sites
	Gathering Information about the Site Database

	Integrating Remote Control
	About Remote Control in Enterprise HelpDesk
	Setting Up Remote Control
	Adding Remote Control Buttons
	Configuring PC-Duo ActiveX Remote Control
	Checking Client Security Key Settings
	Removing Remote Control Buttons

	Customizing Enterprise HelpDesk
	Power Customizations
	About the Databases
	Editing Databases
	Creating an Attachments Field
	Customizing URL Buttons
	Customizing the Inventory Tab
	Customizing Reports with Crystal Reports
	Customizing HTML Reports
	Customizing the Report Used to Print Issues
	Deleting Users
	Removing Disabled Users from Choice Lists
	Adding a Choice List of Users or Contacts
	Timestamping
	Customizing Notifications
	Submit-only Views Without Persistent Cookies
	Branding the Web View
	Branding the Dialogs
	Branding the Logon Pages
	Customizing the Timesheet

	Installing Enterprise HelpDesk
	Supported Configuration
	Installing Enterprise HelpDesk
	Selecting Components
	User Account for Notifications
	Entering Your License Information

	Databases
	Overview
	Issue Database
	Project Definitions Database
	Users Database
	Other Project Files
	Other Databases

	Relocating Enterprise HelpDesk Installations
	About the Relocation Wizard
	Before You Relocate
	How to Relocate Enterprise HelpDesk
	Relocating Enterprise HelpDesk
	If Something Goes Wrong
	Updating Client Programs
	Enabling Enterprise HelpDesk after Relocation

	Index

